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Quick Start Guide 

  

1. Install and register your new software... 

Installation and Setup of GemStone 

Registering your new software 

  

2. Take a quick look at the user interface and terminology... 

GemStone User Interface 

The GemStone Workspace 

What is a Project? 

The Project Library 

What is a Template Document? 

Saving and Opening 

Users and Groups 

  

3. Try out a tutorial or two... 

Analyzing Files with an Existing Project 

  

The Develop tutorials for creating your own projects: 

Starting a New Project from Scratch 

Adding Cell Types to the Project 

Analyzing Subsets 

Exploring with Cen-se' 

Additional Exercises 
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Finishing the Project 

Stain Assessment 

  

Further reading 

When you have a chance, review the Reference sections. 

Reference 
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License and Warranty 

  

License Agreement 

Copyright laws of the United States and international treaty protect this software. Verity 
Software House provides this software (the "Software") under the following conditions: 

Software is intended to be installed and used on one computer. An additional computer 
license is required for each additional installation. 

Network versions of software require one serial number for each simultaneous use. Network 
versions are intended for installation and use on a local area network; other uses are not 
supported. 

Backups of the software must be used only for archival purposes. 

Duplication of the manual is strictly prohibited without the expressed written permission of 
the copyright holder. 

If you transfer the use of this software to another party, that party must accept the terms of 
this agreement, and you must transfer all copies of the software or destroy them. 

Your license to use this software will terminate if you are found to be in violation of this 
agreement. 

The laws of the State of Maine and the United States of America govern this license. 

  

Limited Warranty 

Verity Software House (VSH) warrants the physical media and the physical documentation, if 
included, to be free of defects in materials and workmanship for a period of 30 days from 
date of purchase. If VSH receives notice of defects in materials or workmanship within the 
warranty period, VSH will replace the defective media or documentation. 

VSH makes no other warranties, either expressed or implied, with respect to this manual or 
with respect to the software described in this manual, its quality, performance, 
merchantability, or fitness for any particular purpose. VSH software is licensed "as is". The 
entire risk as to its quality and performance is with the buyer. Should the software prove 
defective following their purchase, the buyer (and not VSH, its distributor, or its retailer) 
assumes the entire cost of all necessary servicing, repair, or correction and any incidental or 
consequential damages. In no event will VSH be liable for direct, indirect, incidental, or 
consequential damages resulting from any defect in the software, even if VSH has been 
advised of the possibility of such damages. Some states do not allow the exclusion or 
limitation of implied warranties or liability for incidental or consequential damages, so some 
of the above limitations or exclusions may not apply to you. 
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Latest Versions 

  

To find the latest versions for GemStone and the documentation, visit the Verity Software 
House web site at www.vsh.com. This site provides a complete version of the latest revision 
of the online documentation, patches, and technical support information for the program. 

You can also email us at verity@vsh.com to determine whether or not you have the latest 
version. Please include the version that appears on the start-up dialog box, and the file date 
for the program with your email. 

The software also has a Check for Updates command in the Help menu. Use this command 
periodically to see if there are updates for your software. The command can download and 
install updates that are available, if you have administrative rights to your computer. 

https://www.vsh.com/
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New Features in GemStone 

  

GemStone 2.0 is a totally redesigned application. While it is based on the same Probability 
State Modeling engine introduced with GemStone 1.0, the user interface and workflows are 
entirely different. 

And you will love the changes! 
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System Requirements 

  

NOTE: Your software will only run on the operating system you select at the time of 
purchase. 

  

Minimum System Configurations 

If you purchased a Windows version:  
Windows 7, Windows 10 or greater, 3.40GHz CPU or better, 8GB RAM or greater, 8 or more 
logical processors, with 750MB free disk space for program files.   

  

If you purchased a Mac version:  
macOS 10.12 or greater, 3.40GHz CPU or better, 8GB RAM or greater, with 750MB free disk 
space for program files.   

  

Optimal Configurations 

Faster CPUs with more cores, high-speed SSD drives, and greater RAM will improve 
performance. 
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Installation and Setup of GemStone 

  

IMPORTANT NOTES:  

• Your software will only run on the operating system you select at the time of 
purchase. 

• Stand-alone versions of the program are designed to be installed and 
registered on a single computer. 

• You must have administrative rights to the computer during installation and 
registration of the software. After registration, the program can be run by users with 
restricted access to the computer, as long as the program is installed in a location 
where users have read/write permissions. 

• You will need to register the software with Verity Software House in order to unlock 
the program on the computer. This can be done using the online registration process 
or by contacting technical support. 

• If your program is an update version, you will need the serial number for the previous 
version to register and unlock the software. 

• If your program is an additional computer license, you will need the serial number for 
the primary license to register and unlock the software. 

  

Windows Version 

Installation 

• Log on to your computer with an account that has Administrator privileges. You must 
have administrative rights during installation. 

• If you downloaded the software, extract the installation files from the download into a 
temporary folder. If you have an installation CD, insert the program CD into the CD-ROM 
drive. 

• Run the program named GemStoneSetup.exe. Follow the directions on the screen to 
complete the installation. 

• See the section on registering your software for information on how to register your 
software. 

Using the software 

• Log on to your computer with your own user account. This should be the account that 
you normally use on the computer. 

• Open the Start menu and navigate to the Verity folder. Choose GemStone 2.0. 

  

Mac OS Version 
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Installation 

• Log on to your computer with an account that has Administrator privileges. You must 
have administrative rights during installation. 

• The installer is distributed as a disk image, or "DMG" file. Double-click the DMG file to 
mount and open the disk. 

• A Finder window will display program icons and instructions for how to install the 
program. Follow those directions to complete the installation. 

• See the section on registering your software for information on how to register your 
software. 

Using the software 

• Log on to your computer with your own user account. This should be the account that 
you normally use on the computer. 

• In Finder, navigate to the Applications folder. 
• If there is a GemStone shortcut in the Applications folder, double-click it to start the 

program. 
• If there is no GemStone shortcut, open the GemStone 2.0 folder, and then the 

Application subfolder. Double-click the GemStone 2.0 application icon. 
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Registering your new software 

  

Why You Should Register 

Registration is a key step in setting up the software to run on your computer. In fact, your 
software will not be fully functional until you register. Here's why. 

This version of the program uses software security, which requires you to register your 
software in order to receive an Unlock Code to make the program fully functional. An 
unregistered installation will be fully functional for 30-days, and then become a "trial version" 
with limited functionality until it is registered. 

Of course, registration is useful for other reasons, too. We can inform you of bug fixes and 
updates, and provide you with better technical support. 
  

How to Register 

When you start the program for the first time, it will automatically start the Registration 
Wizard. You can access this dialog at any time by clicking the Registration button on the 
dialog box that is displayed when the program starts up. 
  

 
  
Click the Next button to begin the registration process. 
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The wizard will ask how you want to register the program. Select the appropriate option and 
click Next. 
  

 
  
Then next step in the wizard shows some information about the program. There are 3 fields 
that you need to fill in for this step: Serial #, CD Key, and Your Email. You can also enter or 
edit the Computer Name field to identify your computer. 
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The Serial number and CD Key can be found on the outside of the program box or in email if 
the program was provided to you by download. Enter these exactly as they appear; they are 
case-sensitive. If you have lost or misplaced the Serial number or CD Key, contact Verity 
technical support at tech@vsh.com or (207) 729 6767. 
For the Email field, make sure to enter your valid email address. Otherwise, you may not 
receive the Unlock Code and the program will not be fully functional. 
Click Next to continue the registration process. 
  
If you have not yet created a user account on vsh.com, a user account wizard is displayed. 
This step only appears if you have not yet created a user account. 
Fill in all fields on the form and click Next. 

 
  
If you have more than one user account at vsh.com, you will be presented with another step. 
This step only appears if you have more than one account. 
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Choose the web account that you want to use for registration, and then click Next. 
  
At this point, the program will request an unlock code from the registration server at 
vsh.com. If successful, you will see the confirmation step and the Unlock Code for your 
computer. 
  

 
  



GemStone User Guide 

19 

You can print the registration information by clicking the Print button. Click Finish to close 
the wizard and continue working with the program 
  
If there was a problem with the registration, an informative message will explain the problem 
and steps to take to correct it. 
  
Once you have completed the registration successfully, the program will be fully functional. 
  
  

If the registration wizard cannot connect to vsh.com 

Sometimes firewalls can prevent the registration wizard from connecting to vsh.com. In this 
case, you can try registering with your browser. Choose the second option in the list and click 
Next to launch your browser with the correct registration information. 
  

 
  
Follow instructions on screen to complete the process. 
  

To register your software using email 

The registration wizard can help you send email to Verity Software House with your 
registration information. Choose the third option in the list and click Next to create an email 
message. 
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Follow instructions on screen to complete the process. 
  

To register your software using another computer... 

When the installation computer does not have internet access but another computer does, 
you can use the fourth option in the list and click Next to begin the process. 
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On the installation computer, write down the Computer ID displayed in the 
Register Software dialog. 

Next, go to the computer that has Internet access, launch a browser, and navigate to 
www.vsh.com. 

Click the Register Software link. 

If you already have a web account, login with your user name and password.  If you do not 
have a web account, create a new account that will be associated with this registration. 

After you login, the Software Registration page will be displayed on the web site.  Fill in 
the information in the form on this page to register the product. If you are registering an 
update version, you will need the serial number of the previous version to complete the 
registration. If you are registering an additional user license, you will need the serial number 
of another copy of the program that is registered to your institution. 

Getting an Unlock Code is a two-step process. First, you fill in and submit the registration 
form on the web site. This sends a registration request is sent to Verity. Your Unlock Code is 
then emailed to you, so make sure you provide a valid email address. 

When you receive your Unlock Code via email, paste or type it into the Unlock Code field in 
the Registration dialog box on the installation computer. When possible, use Copy and Paste 
to do this, to ensure that the characters are correct. Then click the OK button. 

Your program will become fully functional once the Unlock Code is entered correctly. 

  

If you do not have Internet access 

If you do not have access to the Internet, you can send the registration information below to 
Verity Software House by fax, mail, or telephone. Our technical support staff can register the 
software for you with the information you provide, and supply you with the Unlock Code to 
enter into the Registration Wizard. 

Here is the information we need. You can print this page and fill it in. 

These fields are found in the Registration dialog box. 

Program Name: 
Program Version: 
Computer ID: 
Serial number: 
CD Key: 

User Information 

Name: 
Institution: 
Address: 
City: 
State/Province: 
Zip/Postal Code: 
Country: 
Phone: 

https://www.vsh.com/
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Fax: 
Email: 

Our technicians will use the information below to create a web user account for you on our 
web site. 

Name to use on VSH web: 
Password to use on VSH web: 
A question we can ask to verify who you are: 
The answer to the question to verify who you are: 

If you are updating from a previous version, you will need to supply the serial number of the 
previous version. 

Serial Number of previous version: 
  

Contact Verity Software House 

Verity Software House 
PO Box 247, Topsham, ME 04086 
USA 
 
Email: verity@vsh.com 
Web: www.vsh.com 
Phone:  (207) 729 6767 
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GemStone Terminology 

GemStone User Interface 

  

When GemStone starts-up, the main window is comprised of a ribbon bar at the top, a batch 
list on the left, and a report tab that contains tabs for each page in a report. 

 

  

The ribbon bar contains most of the commands that you will use.  The commands are divided 
into a series of ribbon tabs: File tab, Home tab, Insert tab, Options tab, Develop tab, and the 
Help tab.  Some tabs are only visible when the Develop option is enabled. 

  

Develop Mode 
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In Develop mode, additional elements are displayed: 

 

  

Additional ribbon tabs are displayed in Develop mode.  Batch commands determine what 
actions are performed on files in the batch.  Additional tabs appear at the bottom of the 
window to select FCS File, Cell Types, and Maps view.  With the Cell types view selected, a 
tab is shown for each cell type defined in the model template. 
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GemStone User Interface 

  

When GemStone starts-up, the main window is comprised of a ribbon bar at the top, a batch 
list on the left, and a report tab that contains tabs for each page in a report. 

 

  

The ribbon bar contains most of the commands that you will use.  The commands are divided 
into a series of ribbon tabs: File tab, Home tab, Insert tab, Options tab, Develop tab, and the 
Help tab.  Some tabs are only visible when the Develop option is enabled. 

  

Develop Mode 

In Develop mode, additional elements are displayed: 
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Additional ribbon tabs are displayed in Develop mode.  Batch commands determine what 
actions are performed on files in the batch.  Additional tabs appear at the bottom of the 
window to select FCS File, Cell Types, and Maps view.  With the Cell types view selected, a 
tab is shown for each cell type defined in the model template. 
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The GemStone Workspace 

  

The GemStone workspace is a folder on disk where the software is installed.  The folder 
contains key components of the program in sub-folders that store the program itself, the user 
guide, the Project library, and other important parts of the software. 
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What is a Project? 

  

The term "Project" in GemStone refers to collection of files that determine an analysis 
approach. A Project includes one or more model templates that are used to analyze FCS 
files.  It includes one or more batch scripts that determine how to load FCS files and model 
templates, what operations to perform on the FCS files, and the outputs of the analysis such 
as PDF files and databases.  A Project contains the FCS files added to it, and the output files 
it generates. 

Projects provide a simple way to design an analysis strategy and to manage the related 
files.  On disk, a Project is organized as a set of folders and files. 
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Project  

The Project Library 

  

The Project Library is part of the GemStone Workspace that contains the Projects that can be 
used for analysis, including those that you create.  Each Project is a folder which contains 
additional folders of information. 

The example below shows Projects that have been created: 16 Color Demo, Exp 1 10-Jan-
2018, and Exp 2 17-Jan-2018.  The folder structure of one of the Projects is also shown. 
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What is a Template Document? 

  

A template document contains the cell type definitions, expression profiles, report design, 
and objects on the cell type canvas. It is the underpinning of the analysis system - the 
Probability State Model.  This component of the software is only accessible in Develop mode. 

  

A template document defines a set of cell types.  Each cell type is defined by a set of 
expression profiles for the key markers of the cell type.  For example, a CD8 cell type is 
typically defined with expression profiles for CD3, CD66b, CD19, CD8, CD4, and other 
markers.  The cell types can include staging related to the cell type, as well as graphical 
elements like 1P and 2P plots, overlays, and more. 
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Saving and Opening 

  

GemStone has many different types of items that can be saved and opened.  Here's an 
explanation of the primary open and save operations that you will encounter in the software. 

  

The Home tab, Develop tab, and File tab of the ribbon are used for saving and opening: 

 

  

 

  

Projects 

When you open or save a Project, the program opens or saves the batch commands and 
database fields for the method. The batch commands determine what template documents 
are used, what kinds of output to save (PDF, analysis documents, etc.), and what to print.  

  

Command 
Where 
Is It? 

Function 

 

  

File 
menu,  
Develop 
tab 

Save the current method in the 
Project Library folder.  In 
Develop mode, it will also prompt 
you to save the template 
document. 

 

  

Home 
tab 

This dropdown list displays all of 
the methods in the Project 
Library.  It opens the selected 
method. 
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File 
menu 

The Open Project command 
allows a method to be opened 
from outside of the Project 
Library.  

  

Analysis Documents 

An Analysis document stores the analysis of an FCS file with a template document. Typically, 
this is saved automatically in the Fitted Models folder by the batch commands.  The user can 
also manually save and open analysis documents for review. 

  

Command 
Where Is 
It? 

Function 

 
  

Home tab 
Saves the current analyzed document to the current 
method's Fitted Models folder. 

 
  

Home tab 
Opens an analysis document from the Fitted Models 
folder or other location. 

  

Template documents 

A Template document stores the probability model definition. These files are only accessible 
in Develop mode.  Templates are stored in the Model templates folder of the method.  The 
Develop mode user can also manually save and open template documents. 

  

Command 
Where Is 
It? 

Function 

 
  

Develop tab 
Saves a template document to the current method's Model 
Templates folder. 
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Develop tab 
Opens a template document from the Model Templates 
folder or other location. 
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Phenotype Naming 

  

Each marker for each cell type has a Phenotype field.  The field shows up in the Cell Type 
Wizard and on the Expression Profile properties.  Use this field to describe the marker 
expression for the cell type. 

The recommended syntax for this field is to use the short name of the marker (e.g. CD8), 
with one of the following appended: 

Symbol   Meaning 

+ plus symbol Positive expression of the marker 

-  minus symbol Negative expression of the marker 

dim text Dim expression of the marker 

+>- 
plus, greater 
than, minus 

Transition of positive to negative expression of the 
marker 

->+ 
minus, greater 
than, plus 

Transition of negative to positive expression of the 
marker 

  

The values in the Phenotype field are used on report pages to show the full phenotype of a 
cell type.  For example, the CD4 phenotype is shown as "CD4: CD66b-CD3+Cd8-CD4+CD14-
TCRgd-CCR7+>-CD27+>-CD45RA+>-" 
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What is a Probability State Model? 

  

Flow cytometry data analysis focuses on identification of populations in a sample and 
providing statistical results about those populations. Typically, regions drawn on plots are 
used to create a hierarchy of subsets by "gating" the events. The subsets are analyzed for 
frequency, intensity, and other common statistics to characterize the cells that were 
analyzed. 

GemStone approaches data analysis quite differently by using a Probability State Model 
(PSM) to identify and quantify subsets. So what is a Probability State Model, and why is it a 
better approach? 

Let's examine the words that make up the name to get an idea of what a PSM is: 
  

Probability: the statistical likelihood of a particular event occurring. A PSM classifies events 
using probabilities rather than gates. Gating is subjective, and relatively small errors made in 
drawing gates are compounded with each subsequent gate in the hierarchy. By using 
probability, a PSM actually reduces the error with each additional measurement that is added 
to the model. The likelihood that you are actually identifying the cells you are interested in 
increases as you build a PSM. 
  

State: a set of conditions that discretely characterize something. A PSM classifies events into 
a set of states, based on the characteristics defined for each measurement. GemStone uses 
the state as the common, X-axis for its expression plots. This allows all measurements to be 
compared on a common axis, making it possible to correlate all measurements in a single 
plot. 
  

Model: a mathematical representation of a process. A PSM uses fitting routines to classify 
cells into the most probable states and cell types. Using this approach, GemStone can 
provide objective assessment of how well the model represents the data. There are no hard-
edges in a PSM. The modeling process allows populations to overlap based on probabilities. 
  
A PSM allows us to classify events into populations based on a model that we define. The 
model is made up of one or more cell types, where each cell type defines a subset that we 
want to analyze. We use what we know about the markers in our experiments to create a set 
of expression profiles for each subset. An expression profile uses a set of control points to 
define how the subset transitions over the state axis. The state axis is typically labeled 
"Progression", but it does not have to be a progress at all. In fact, simple models can be 
designed to identify and quantify cell populations where the parameter profiles are simply set 
for constant intensities. 
  
With the PSM approach, we can measure and report confidence limits. We can evaluate the 
goodness-of-fit with reduced chi-square (rcs). And we can co-plot our parameters in a single 
graphic that allows us to examine the coordinated transitions of markers in the cells we 
analyze. 
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Tutorials 

Analyzing Files with an Existing Project 

Overview 

In this tutorial, you will use a previously-created GemStone Project to analyze FCS files from 
a 16-color immune profiling panel. The Project was designed to identify seven cell types and 
to present a report with a summary table and details for each cell type. 

You will add files to this project and analyze them with just a few clicks. The results that you 
see can be reproduced if you or someone else runs the analysis again. The approach is 
simple, fast, and reproducible. 

Let's give it a try! 

  

Start GemStone 

Start Gemstone by following the instructions in the Installation and Setup of GemStone 
section. 

  

Create a New Project 

On the Home tab, click the New Project button to create a new Project. 

 

  

In the New Project dialog, select Example 16 Color in the Based on field. This will create a 
new project based on the selected project. 

For Project Name you can leave the suggested name or type your own. 

Click OK. 

 

  

Add FCS Files 
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Next, you will add files to analyze. Click the Add FCS Files button on the Home tab. 

 

  

In the Select FCS Files dialog, navigate to the Tutorials folder of the GemStone 
workspace.  Select the three files 16-color_1.fcs, 16-color_2.fcs, and 16-color_3.fcs. Click 
Open. 

 

  

The files are added to the batch list in the left panel of the program. 

At this point, you are ready to analyze these files automatically with the example 16-Color 
immune panel project. 

  

Analyze the Files 

The First File 

Let's analyze the first FCS file. 

Click the Run button in the Processing group on the Home tab. This tells GemStone to follow 
the steps in the batch script to read and analyze the selected file. 
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The software first opens a template document, which defines the analysis for seven cell 
types, along with the plots and report pages. Once the template is opened, the FCS file is 
read into the template.  

The auto-analysis step is next. In this step, each of the defined cell types is adjusted to the 
data in the FCS file. The status pane at the bottom of the main window indicates which step 
of the analysis is being performed. 

 

  

When the process is complete, the summary page of the report presents a table of the key 
results of the analysis.  

 

  

At the bottom of the main window, there are tabs for each page in the analysis report. To 
review a page, click the tab.  

 

  

For example, click the CD4 T tab to review the analysis of CD4 T cells. 

The report shows the name of the cell type and its phenotype at the top. The Selection 
Markers section shows several plots for the measurements that were used to identify CD4 T 
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cells, along with a table of intensity values. The Staging Markers section includes plots of 
markers that are used to identify the stages of CD4 T cell development and a table of 
frequencies for each stage. 

 

  

The Rest of the Files 

If you want to analyze and review each file one-by-one, you would use the Next button to 
read and analyze the next file. However, in this tutorial we want to analyze all of the files 
without intervention. 

Click Auto Advance to process all of the files in the batch. 

 

  

Review the Analysis 
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After analyzing each FCS file, GemStone saves the finished analysis so that it can be 
reviewed later. A PDF of the report is also generated for your records. You can easily re-open 
a saved analysis for the files in the project. 

Double-click the second file in the batch list, 16-color_2.fcs. A prompt dialog will appear 
offering several choices of actions. 

 

  

Choose Open PDF to review the PDF report of the analysis. Open GS will open the analysis 
document associated with the FCS file. Choose Analyze to re-analyze the file, or Cancel to 
close the dialog. 

  

Summary 

In this tutorial, you created a new Project based on an existing one designed to analyze the 
16-color tutorial files. You added files to the new project and initiated the analysis of the files 
using the Add, Run, and Auto-Advance buttons on the Home tab of the ribbon. 

GemStone automatically adjusted the template document to each of the FCS files, fitting the 
model to the peaks in each file. The analysis included a summary table of key results, along 
with a more detailed page for each of the seven cell types defined in the template document. 
A PDF and an analysis document was saved for each file. 

You were able to analyze these files with just a few clicks. The approach is simple, fast, and 
reproducible. 
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Analyzing Files with an Existing Project 

Overview 

In this tutorial, you will use a previously-created GemStone Project to analyze FCS files from 
a 16-color immune profiling panel. The Project was designed to identify seven cell types and 
to present a report with a summary table and details for each cell type. 

You will add files to this project and analyze them with just a few clicks. The results that you 
see can be reproduced if you or someone else runs the analysis again. The approach is 
simple, fast, and reproducible. 

Let's give it a try! 

  

Start GemStone 

Start Gemstone by following the instructions in the Installation and Setup of GemStone 
section. 

  

Create a New Project 

On the Home tab, click the New Project button to create a new Project. 

 

  

In the New Project dialog, select Example 16 Color in the Based on field. This will create a 
new project based on the selected project. 

For Project Name you can leave the suggested name or type your own. 

Click OK. 

 

  

Add FCS Files 

Next, you will add files to analyze. Click the Add FCS Files button on the Home tab. 



GemStone User Guide 

43 

 

  

In the Select FCS Files dialog, navigate to the Tutorials folder of the GemStone 
workspace.  Select the three files 16-color_1.fcs, 16-color_2.fcs, and 16-color_3.fcs. Click 
Open. 

 

  

The files are added to the batch list in the left panel of the program. 

At this point, you are ready to analyze these files automatically with the example 16-Color 
immune panel project. 

  

Analyze the Files 

The First File 

Let's analyze the first FCS file. 

Click the Run button in the Processing group on the Home tab. This tells GemStone to follow 
the steps in the batch script to read and analyze the selected file. 
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The software first opens a template document, which defines the analysis for seven cell 
types, along with the plots and report pages. Once the template is opened, the FCS file is 
read into the template.  

The auto-analysis step is next. In this step, each of the defined cell types is adjusted to the 
data in the FCS file. The status pane at the bottom of the main window indicates which step 
of the analysis is being performed. 

 

  

When the process is complete, the summary page of the report presents a table of the key 
results of the analysis.  

 

  

At the bottom of the main window, there are tabs for each page in the analysis report. To 
review a page, click the tab.  

 

  

For example, click the CD4 T tab to review the analysis of CD4 T cells. 

The report shows the name of the cell type and its phenotype at the top. The Selection 
Markers section shows several plots for the measurements that were used to identify CD4 T 
cells, along with a table of intensity values. The Staging Markers section includes plots of 
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markers that are used to identify the stages of CD4 T cell development and a table of 
frequencies for each stage. 

 

  

The Rest of the Files 

If you want to analyze and review each file one-by-one, you would use the Next button to 
read and analyze the next file. However, in this tutorial we want to analyze all of the files 
without intervention. 

Click Auto Advance to process all of the files in the batch. 

 

  

Review the Analysis 
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After analyzing each FCS file, GemStone saves the finished analysis so that it can be 
reviewed later. A PDF of the report is also generated for your records. You can easily re-open 
a saved analysis for the files in the project. 

Double-click the second file in the batch list, 16-color_2.fcs. A prompt dialog will appear 
offering several choices of actions. 

 

  

Choose Open PDF to review the PDF report of the analysis. Open GS will open the analysis 
document associated with the FCS file. Choose Analyze to re-analyze the file, or Cancel to 
close the dialog. 

  

Summary 

In this tutorial, you created a new Project based on an existing one designed to analyze the 
16-color tutorial files. You added files to the new project and initiated the analysis of the files 
using the Add, Run, and Auto-Advance buttons on the Home tab of the ribbon. 

GemStone automatically adjusted the template document to each of the FCS files, fitting the 
model to the peaks in each file. The analysis included a summary table of key results, along 
with a more detailed page for each of the seven cell types defined in the template document. 
A PDF and an analysis document was saved for each file. 

You were able to analyze these files with just a few clicks. The approach is simple, fast, and 
reproducible. 
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Develop: Starting a New Project from Scratch 

  

Overview 

Any time you have a new panel to analyze with GemStone, you will create a new Project to 
setup the analysis for the panel. This tutorial shows how to create a new Project from scratch 
with a model template, a report, and a database of results. You will also set up batch options 
that define how each FCS file is read and analyzed. 

That sounds like a lot of work, but you will leverage wizards and a streamlined interface to 
make quick work of it. 

  

Start GemStone 

Start Gemstone by following the instructions in the Installation and Setup of GemStone 
section. 

  

Create a New Project 

On the Home tab, click the New Project button to create a new Project. 

 

  

In the New Project dialog, type "New Project Tutorial" for the name, and then click OK. 

 

  

  

Add FCS Files 
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Next, you will add files to analyze. Click the Add FCS Files button on the Home tab. 

 

  

In the Select FCS Files dialog, navigate to the Tutorials folder of the GemStone 
workspace.  Select the three files 16-color_1.fcs, 16-color_2.fcs, and 16-color_3.fcs. Click 
Open. 

 

  

The files are added to the batch list in the left panel of the program. 

  

Using the Measurement Wizard 

When you read files that are new to the program, it's a good idea to read one in and review 
the measurement names and transforms. You can edit the names and transforms with the 
Measurement Wizard. 

Click the Develop checkbox to enable "Develop mode". This mode exposes additional tools 
that are used to build the Project. 
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On the Develop tab, select the first file in the list and click the Read File button.  This 
command will read the selected FCS file without performing any analysis. 

 

  

Now click the Measurement Wizard button.  This wizard is used to set up the names and 
transformations for the measurements in the FCS files. 

 

  

Click the All button to select all of the measurements in the FCS file.   
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Click Next. 

  

The properties for CCR7 are listed, and a histogram of the measurement provides a preview 
of the measurement with the properties applied to it. 

In this dialog, you can edit the measurement name and abbreviation. By default, these will 
display the long name from the FCS file's keywords. You can also edit the transform and its 
properties. 

No changes are needed for CCR7. 
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Click the Next Measurement button. 

 

  

Review each of the remaining measurements in the same manner. There is only one change 
you will need to make. 

When you reach the Time measurement, set the Transform to Linear. 
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After setting the Time measurement, click Next and the Summary page is displayed. 

Enable the Launch Cell Type Wizard checkbox and then click Finish. 
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Using the Cell Type Wizard 

Now that the program knows about the measurements and transforms, let's start building the 
analysis using the Cell Type Wizard. This wizard creates or edits the analysis of one cell type 
at a time, one measurement at a time. You will use it to create just about everything for 
analyzing this 16-color example. 

If the wizard is not already showing, click the Cell Type Wizard button on the Develop tab. 

 

  

On the Welcome page, choose Create a new cell type and click Next. 

 

  

On this page, you will give the cell type a name. 

Type "CD4 T" for the Cell Type Name. 

This page also lets us enable the cell type, pick a color for it, and determine the classification 
type.  For this tutorial, leave these options as they appear and click Next. 



Tutorials 

54 

 

  

Next choose the measurements that are used to identify the CD4 T cells. These are called 
Selection Markers.  These can be "positive" markers, as well as markers that are "negative" 
for the cell type.  In this tutorial, you'll just choose several markers that are positive for CD4 
T cells. 

In the Available Markers list, click each of these markers in this order: SSC-A, CD3, CD4, 
and CD8 

The markers will be removed from the Available Markers list and added to the Selection 
Markers list. 

If the markers are not in the correct order, you can drag the markers in the Selection 
Markers list to reorder them. 
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Click Next. 

On the next page of the wizard, choose the Staging Markers for the CD4 T cells. These are 
markers that change expression levels within the cell type.  They are used to identify 
different stages of CD4 T cells. 

In the Available Markers list, click each of these markers in this order: CCR7, CD45RA, and 
CD27 
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Click Next. 

Next is the Functional and Other Markers page of the wizard. This is where you can pick 
other markers that you want to see in the CD4 T cell type, even if they are not used for 
selection or staging of the cells. Activation markers are a good example of what you would 
pick on this page. 

In the Available Markers list, click each of these markers in this order: CD25, CD127, and 
HLA DR 
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Click Next. 

Now that you have identified the markers to use for the CD4 T cells, the next task is to set 
up expression profiles for them.  

GemStone uses expression profiles (EPs) instead of gates used in most cytometry analysis 
software. EPs come in different shapes, like constant, step-up, and step-down. They define a 
probability envelope, which does not have hard edges.  

The wizard is showing the first Selection marker, SSC-A, with several properties and an 
unusual dot plot that may not make immediate sense to you. 
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Here's how to interpret the plot. Think of a typical histogram of SSC, as in panel A below. 
Now rotate that histogram 90 degrees (panel B). Now notice that the density of dots in panel 
C matches the peaks in panel B. The Y-axis of the dot plot is SSC-A, and the X-axis (at this 
point) is the order of the events in the FCS file. There are black triangles on the right edge to 
indicate locations where the program found a peak in the data. 

  

 

  

The CD4 T cells have low SSC-A, and you can see a black triangle that identifies the dimmest 
peak of the SSC-A distribution.  That's the one you want to capture with this expression 
profile. 

Choose Dimmest Peak for Which Peak. 
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There are several options for the Distribution.  Leave the Distribution set to Normal. 

The Phenotype is automatically updated as you make choices. It should show "SSC-A-" at 
this point. 

The Initial Intensity is currently set to the location of the peak that you linked the profile 
to. You do not need to change that. 

The Initial Width is set to the width (SD) of the peak that was found. You don't want this 
expression profile to be quite that restrictive, so you'll make two changes. 

Set Initial Width to 5 and uncheck Width from Peak.  This will leave the width at an SD 
of 5 and maintain a generous width for SSC-A. 

 

  

Click the Preview checkbox on the right of the dialog to see what cells will be selected by 
this profile. 



Tutorials 

60 

 

  

Click Next Profile. 

CD3 is next. We want the program to find the brightest CD3 peak, and it is already setup that 
way. 

 

  

Click the Preview checkbox on the right of the dialog to see what cells will be selected by 
this profile. 
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Click Next Profile. 

CD4 is set up in the same way, tracking the brightest peak.  You don't have to make any 
changes to this profile. 

 

  

Click Next Profile. 

For CD8, choose Dimmest Peak. 

For the Distribution, select Low Pass. A low pass distribution includes the events below the 
top of the expression profile.  This will capture all of the CD8 negative events. 
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Click Preview to see the events that are selected. 

 

  

Click Next Profile. 

Now that you have set up the expression profiles for the selection markers, you are ready for 
the staging markers. For these, you will use profiles that have two or more levels of 
expression. 

CCR7 is expressed on naive CD4 T cells, and it is down-regulated as the cells mature.  The 
StepDown profile is designed for this type of expression. 

NOTE: Depending on your monitor, you may need to resize this dialog to see the options in 
the property list. 

For Expression Profile Shape, choose StepDown. 

The other settings will update so that the First Level of the profile tracks the Brightest Peak 
and the Second Level tracks the Dimmest Peak. 
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Enable the Preview checkbox to see the StepDown profile results. Note that the dots 
representing the cells have been reordered so that the brighter CCR7 events are first and the 
dimmer ones are at the end. As soon as you enable a staging profile like this, the X-axis is no 
longer showing the order of events in the FCS file. Now, the X-axis is showing the 
progression of events, and this order is also enforced in the selection marker plots that you 
setup previously. 
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Click Next Profile. 

You will setup CD45RA in a similar way with a StepDown profile. 

Select StepDown for the Expression Profile Shape. 

Because there is so much variability in the brighter level of CD45RA, you will set the Initial 
Width to 10 and uncheck the Width from Peak setting. 

 

  

Enable the Preview checkbox to see the StepDown profile results. 
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Click Next Profile. 

The program thinks there are three levels of expression for CD27, and this may in fact be the 
case. However, unless the levels are very clearly shown, it generally works better to use two 
levels for these distributions with wide variation. 

 

  

Select StepDown for the Expression Profile Shape. 

Set the Initial Width to 10 and uncheck the Width from Peak setting. 
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Enable the Preview checkbox to see the StepDown profile results. 

 

  

Click Next Profile. 

Next come the functional makers. For now, skip over these without setting up a profile. 
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Click Next Profile for CD25. 

The CD127 profile is shown. 

 

  

Click Next Profile for CD127. 

The HLA DR profile is shown. 
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Click the Summary Page button. 

A Summary page is shown, allowing you to review the choices made in the wizard. 

Make sure all the checkboxes are enabled, except for Do another cell type. 

 

  

Click Finish. 

Congratulations! You've just created the CD4 T cell type analysis, complete with a report 
page. Your work was saved as a "template model" which can be applied to any FCS files that 
have the same markers and marker names. 
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Review the Cell Type Report 

The wizard created a report page based on the choices you made for each marker.  The page 
includes the current date, the name of the FCS file, and the cell type name and phenotype at 
the top.   

Next, there is a section for the selection markers.  Each marker is included in at least one dot 
plot. These plots can be changed to show different marker combinations, and you can add 
other plots as well with the tools on the Insert tab. 

On the right is a table listing all of the markers you included in the cell type. For each 
marker, the table shows the median intensity for the whole cell type as well as for each 
stage. You would need to resize the table to see all of the columns, but leave that for later. 

  

 

  

The next section in the report shows the staging markers. A table summarizing the 
percentages and number of events in each stage appears on the right. The wizard 
automatically determined the four stages of CD4 T cells based on when markers changed 
expression levels. 
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Finally, the other markers are shown, each with an expression profile plot. The footer of the 
report page shows the name of the Project, the page number, and the template model that 
was used for the analysis. 

 

  

The report is well organized and shows the important information from the 
analysis.  However, it is not showing the expression profiles that were set up in the Cell Type 
wizard. For that you need to switch to a different tab. 

  

Review the CD4 Cell Type 

At the bottom of the program window, click the Cell Types tab. The program switches from 
showing the report pages to showing the cell type definitions. 

 

  

On the left of the CD4 T cell type tab is a stack of expression profiles. These are the same 
profile plots that were created in the wizard. There is also an Overlay Plot, which shows all of 
the markers and stages on a single plot. This is a great plot for seeing how markers up- and 
down-regulate in a coordinated manner. 
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The icon next to the title of each expression profile is used to expand or collapse the profile. 

 

  

If you scroll down in the cell type window, you'll find the three staging markers that were set 
up with StepDown profiles. You can see that the first stage (green dots) ends when CD45RA 
has down-regulated. Stage two (orange) ends after CCR7 down-regulates. Stage three (red) 
ends after CD27 down-regulates, and stage four (purple) contains the events that have 
down-regulated for all three markers. 
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Setup the Batch Options 

Now that you have the beginnings of an analysis approach, let's see how to set it up for 
automation.   

You may need to resize the section to see the properties listed. You can also change the 
width of the batch list by adjusting the right edge as shown below. 
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The lower left portion of the screen contains the settings that control batch processing.  

 

  

The first thing the batch should do when analyzing a file is to open the template model that 
you just created with the wizard. 

Choose Open for the Template property. 

 

  

Next click the Edit... button for Open Template Options. 

In the dialog that appears, make sure that Target File is set to TemplateModel.gs. If not, 
click the folder icon and select the template model to use. 

Click OK. 
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In the Analysis section, enable Auto Analyze Data. This tells the program to auto analyze 
the FCS file with the template model. 

 

  

Once the analysis is complete, the Finish Up section determines what kinds of output to 
generate. 

Enable the Save Document and Save PDFs properties. 

 

  

Now you're ready to save these changes.  Before you do, let's make sure that the template 
model is showing the Report tab and the CD4 T report page. This will be the view you see 
when the analysis completes.  
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Click the Save Project button in the upper left of the Develop tab of the ribbon bar. 

 

  

When prompted to save the model template, click Yes. 

 

  

You now have created the model and defined the batch process. 

  

Try it out! 

Let's see if everything works as expected. 

Right-click the first file in the batch list and choose Start Here from the context menu. 

 

  

On the Home tab, click the Auto Advance button. This tells the program to analyze all of the 
files in the batch without intervention. 
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Our template model is pretty simple at this point, so the analysis will be quick.  Once it has 
completed, you can review the results by scrolling horizontally in the batch list.  

 

  

If you want to review one of the analyzed files, double-click the file in the list. The program 
will ask what you want to do: open the PDF, open the saved analysis (Open GS), redo the 
analysis (Analyze), or cancel the dialog. 

Choose Open PDF to view the report in PDF format. Note, at this point the first page in the 
report will be blank. We will use this blank page as a summary page in later tutorials. 

  

 

  

Double-click the file again, and this time choose Open GS. This will open the finished 
analysis of the file. With this, you can make manual changes and review the details of each 
cell type. This is especially useful when creating new template models or trying to determine 
the cause of a problem. 
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Summary 

In this tutorial you started a new project from scratch. You gave friendly names to the 
measurements and used the Cell Type wizard to create one cell type for CD4 T cells. In the 
process, you looked at the different ways to setup expression profiles and a few caveats. The 
wizard created a template model from our choices and a report page with plots and tables of 
statistics.  

You learned how to set up the batch options to process a set of files through the template 
model, and then you tested it out by analyzing all of the files added to the project. 

One thing to keep in mind is that you will not always have to start from scratch. You can 
reuse the template model for other files that were acquired with the same panel. If you 
extend that panel with additional markers, you can create a new Project based on this one so 
that you only need to define the new portions of the analysis. 

The tutorials that follow will build upon what you have created in this one. 
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Develop: Adding Cell Types to the Project 

  

Overview 

In the previous tutorial, Starting a New Project from Scratch, you set up the analysis of CD4 
T cells and ended up with a nice report and database of results. 

In this tutorial, you will add two more cell types to the analysis: CD8 T and NK cell types. You 
will use the Cell Type Wizard to add a cell type and test each cell type before moving on to 
the next one. This iterative process is the recommended approach, as it tests each 
enhancement incrementally. 

  

Prerequisites 

This tutorial continues to build the Project that was started in the following tutorial: 

Develop: Starting a New Project from Scratch 

  

Start GemStone 

Start Gemstone by following the instructions in the Installation and Setup of GemStone 
section. 

  

Open the Project 

Open the "New Project Tutorial" Project that you created in the previous tutorial by selecting 
it in the Project dropdown list. 

 

  

Click the Develop checkbox to enable develop mode. 

 

  

Open the Template 
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On the Develop tab, click the Open Template button. 

 

  

Select "TemplateModel.gs" in the Open GemStone Document dialog and click Open. 

 

  

Click the first file in the list, and then read the FCS file by clicking the Read File button. This 
will read the file into the template without auto-analyzing it. 

 

  

Cell Type Wizard for CD8 Cell Type 

Click the Cell Type Wizard button to start the wizard. 
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In the Cell Type Wizard dialog, select Create a new cell type and click Next. 

 

  

For the Cell Type Name enter "CD8 T" and click Next. 
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Selection Markers 

In the Available Markers list, click each of these markers in order: SSC-A, CD3, CD4, and 
CD8. The markers will be added to the Selection Markers list. 
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Click Next. 

  

Staging Markers 

In the Available Markers list, click each of these markers in order: CCR7 and CD27. The 
markers will be added to the Staging Markers list. 



GemStone User Guide 

83 

 

  

Click Next. 

  

Functional and Other Markers 

In the Available Markers list, click each of these markers in order: CD38 and HLA DR. The 
markers will be added to the Functional Markers list. 



Tutorials 

84 

 

  

Click Next. 

  

Selection Marker Expression Profiles for CD8 

SSC-A is the first selection marker, and you will use a new technique to set up its expression 
profile. When you setup the CD4 T cell type, you tracked the dimmest peak of SSC-A. That's 
what we want to do for the CD8 T cell type, too. When two cell types set up a marker in the 
same way, you can "link" them together. Linking expression profiles speeds up the analysis 
and ensures consistency in how the profiles are set up. 

Click the Links button. 
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In the menu of choices, choose CD4 T: SSC-A.  

 

  

When the link is made, the properties for the CD8 T SSC-A measurement are set by the CD4 
marker in the CD4 cell type. The profile switches into Preview mode automatically. 
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Click Next Profile. 

Use the same technique for CD3.   

Click the Links button and select the "CD4 T: CD3" profile. 

 

  

Again, after the link is made the profile switches to Preview mode. 
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Click Next Profile. 

For the CD4 marker in the CD8 T cell type, select Dimmest Peak and Low Pass. As we saw 
earlier, the Low Pass profile captures events that are below the top of the expression profile.. 

 

  

Click Next Profile. 

For CD8 we are interested in the dim to bright CD8 events. Let's learn another trick to 
capture these events. 

Click the Links button. 
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In the menu, select "CD4 T: CD8". 

 

  

This may seem like a mistake at first, because the CD8 expression in the CD4 T cell type is 
not the expression level for the CD8 T cell type. In fact, it is the opposite. For the CD8 T cell 
type the cells of interest have dim to bright expression of CD8. 

Change the Distribution to Inverse Low Pass. The Inverse Low Pass distribution selects the 
events above the top of the profile, which are the dim to bright events. 

 

  

Click Next Profile. 
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Staging Marker Expression Profiles for CD8 

Moving on to the staging markers for the CD8 T cell type, the first is CCR7. This marker is 
abundant on early CD8 T cells, and is lost as they mature. 

Select StepDown for the Expression Profile Shape. 

 

  

Enable the Preview checkbox to see how the StepDown profile fits the two levels of 
expression for CCR7. 
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Click Next Profile. 

The program suggests a ThreeLevels profile shape for CD27 because it detects three levels of 
expression. There may indeed be three levels of expression, but they are not clearly 
distinguishable in this data. We will choose a simpler profile shape. 
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Select StepDown for the Expression Profile Shape. For the Initial Width type 10.00 and 
uncheck Width from Peak. Using a larger, fixed width for the bright peak will allow the 
program to capture the two apparent levels of bright expression. 

 

  

Enable the Preview checkbox. Notice that even with the StepDown profile, we can 
appreciate three levels of expression in CD27. 

 

  

Click Next Profile. 

  

Functional Marker Expression Profiles for CD8 
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Next come the functional makers. For now, skip over these without setting up a profile. 

 

  

Click Next Profile to skip CD38. 

The HLA DR profile is shown. 
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Click Summary Page to skip HLA DR. 

On the Summary page, review the summary information for the cell type. Make sure that 
Save template model, Update summary map, Add to Cen-se', and Add database 
fields checkboxes are enabled. 

 

  

Click Finish. 

After the wizard closes, the changes you made to the model template will be saved and the 
wizard-created report page for CD8 will be displayed. 

  

Review the CD8 Report 

As we saw previously, the report page is divided into sections for Selection Markers, Staging 
Markers, and Other Markers. Plots in each section display the measurements that we added 
to the cell type. Tables are included to show median intensities for the markers and 
frequency information for the stages. 
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Test the Analysis with CD8 T and CD4 T 

Each time a cell type is added or revised you should check how the new cell type affects 
other cell types in the model template.   
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The idea is to review each of the other cell types to make sure that nothing has changed 
dramatically. 

Click the Run button at the bottom of the batch list. This has the same function as the Run 
button on the Home tab, running the batch commands to process the selected FCS file. 

  

 

  

When prompted, choose Analyze to re-run the analysis of this FCS file with the modified 
template. 

 

  

When the analysis is complete, select the CD4 T cell type page of the report by clicking the 
CD4 T tab at the bottom of the report pages. The distributions in the CD4 T cell type are 
almost identical to what they were with the original model template. This suggests that 
adding the CD8 T cell type did not adversely affect the CD4 T cell type. 
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Excellent.  Let's move on to the next cell type. 

  

Cell Type Wizard for NK Cell Type 

The NK cell type is a very simple one, so let's add that one now. 

Click the Cell Type Wizard button. 
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Choose Create a new cell type and click Next. 

 

  

Type "NK" for the Cell Type Name and click Next.  
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Add three selection markers in order: CD3, CD56, and CD14. 
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Click Next. 

This cell type will not have any staging or functional markers. 

Skip Staging and Functional by clicking Next for each of these pages. 

  

NK Selection Marker Expression Profiles 

For CD3, choose Dimmest Peak and Low Pass. 
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Click Next Profile.  

For CD56 we want the dim to bright events. The best way to capture them is with an Inverse 
Low Pass profile. 

Choose Dimmest Peak and Inverse Low Pass. 

Since the dim peak has a very small width, let's manually adjust the width so that we don't 
include the dimmest CD56 events. 

Set the Initial Width to 5.0 and uncheck Width from Peak. 
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Enable the Preview checkbox to verify that the dim to bright events are selected. 

 

  

Click Next Profile. 

For CD14, choose Dimmest Peak and Low Pass.ac 
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Enable the Preview checkbox to verify the selection. 

 

  

Click Summary Page.  

Review the cell type wizard summary and click Finish. 
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The report page for the NK cell type is very simple, with just the three selection markers. 
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Test the Training Set with the Three Cell Type Model Template 

The model template now has three cell types: CD4 T, CD8 T, and NK.  Let's test it out by 
running the batch of FCS files in our training set.  We'll review the reports for each of these 
to verify that all cell types are working properly. 

Right-click the first file in the batch list and choose Start Here. 

 

  

Click the Auto Advance button to automatically process all three files in the batch. 

 

  

When the batch is finished, you can review the results by scrolling horizontally in the batch 
list, the part of the window where the files are listed.  You can change the width of the batch 
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list by adjusting the right edge as shown below. Result for all three cell types will appear in 
the database. 

 

  

If you want to perform additional statistical analysis on the results in another program, you 
would right-click on the batch list and choose Export Database. This option displays a file 
save dialog and allows you to save the database in tab-delimited format, which can be 
imported into spreadsheets, word processors, and lab information systems. 

 

  

You can compare the report PDFs for each of the files. Double-click the file in the list. The 
program will ask what you want to do: open the PDF, open the saved analysis (Open GS), 
redo the analysis (Analyze), or cancel the dialog. 

Choose Open PDF to view the report in PDF format. Note, at this point the first page in the 
report will be blank. 

Repeat this for each of the files in the batch list. 
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Summary 

In this tutorial you extended the model template by adding two more cell types: CD8 T and 
NK. You learned how to link expression profiles from one cell type to another. Linking profiles 
helps to speed up the processing and makes the model template more consistent and robust. 

We introduced the use of Inverse Low Pass distributions for capturing the dim to bright 
distribution of the CD8 marker.  

In the next tutorial you will learn how to analyze subsets in a cell type. 
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Develop: Analyzing Subsets 

  

Overview 

In this tutorial, you will learn how to extract information about subsets within a cell type. We 
use the term "subset" to refer to a group of cells within a cell type that have some common 
attributes, but they do not necessarily fall into a particular stage of development.  

A good example of a subset is the Treg subset of CD4 T cells. These cells are positive for 
CD25, negative for CD127, and they can occur in any stage of CD4 T cells. 

In this tutorial you will add to the Project we developed in the previous tutorials, Starting a 
New Project from Scratch and Adding Cell Types to the Project. You will add a TriCOM object 
to quantify cells that are CD25+CD127- and add a table to the report to show Treg statistics. 

  

Prerequisites 

This tutorial continues to build the Project that was started in the following tutorials: 

Develop: Starting a New Project from Scratch 

Develop: Adding Cell Types to the Project 

  

Start GemStone 

Start Gemstone by following the instructions in the Installation and Setup of GemStone 
section. 

  

Open the Project 

Open the "New Project Tutorial" Project that you created in the previous tutorials by selecting 
it in the Project dropdown list. 

 

  

Click the Develop checkbox to enable develop mode. 
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Open a Saved Analysis Document 

Double-click the first file in the batch list.  A dialog of choices will be displayed. 

Click Open GS to open the saved analysis for the file. 

 

  

  

  

Edit the Cell Type with the Cell Type Wizard 

Next we need to make several edits with the Cell Type wizard. These edits will allow us to 
define the Treg subset of CD4 T cells. 

Click the Cell Type Wizard button to initiate the wizard. 

 

  

This time you will use the wizard to edit the CD4 T cell type. 
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Click the Edit the selected cell type option and select CD4 T from the list of choices and 
click Next. 

 

  

We only need to edit the Functional markers, so we can skip past a number of pages in the 
wizard: 

Click Next on the Cell Type Properties page. 

Click Next on the Selection Markers page. 

Click Next on the Staging Markers page. 

Click Next on the Functional Markers page. 

  

Most of the expression profiles do not need any edits: 

Click Next Profile on the Profiles pages for SSC-A, CD3, CD4, CD8, CCR7, CD45RA, and 
CD27. 

  

Set up the Functional Profiles 
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For CD25, set up the expression profile with the following: 

Choose Constant for the shape and Dimmest Peak for the peak. 

 

  

Enable the Preview checkbox to try out these settings. 

Note the heavy black line above the expression profile.  These identify the 95% confidence 
limits of the profile. Events that are above the top line have a low probability of being 
included in the profile. They are the events that will be considered "high" for CD25 as we 
define the Treg events. 

If you wanted to include fewer events in the profile, you would make the Initial Width smaller 
and uncheck Width from Peak.  Similarly, to include more events, you would make the Initial 
Width larger.  
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Click Next Profile. 

For CD127, set up the expression profile with the following: 

Choose Constant for the shape and Brightest Peak for the peak. 

Set the Initial Width to 8.0 and uncheck the Width from Peak option. 

  

 

  

Enable the Preview checkbox. 

The Initial Width of 8 puts the lower side of the 95% confidence limit in a good position to 
separate positives and negatives. Events within the confidence boundaries will be considered 
"positive" for CD127, and those that fall below the lower boundary will be considered 
"negative" for CD127. 
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Click Next Profile. 

Skip over the HLA DR profile for the time being. Click Summary Page. 

Review the summary information.  Make sure that Save template model and Update 
summary map options are checked. 

Click Finish to close the wizard and save your changes. 

 

  

  

What is a TriCOM? 
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TriCOM is the tool that can identify subsets within a cell type. As its name implies, TriCOM 
can compute three states for the combination of measurements that we add to it. The three 
stats identify whether an event is within the 95% confidence limits of the expression profile 
(normal), below the lower confidence limit (low), or above the upper confidence limit (high).  

 

  

In some cases, you may only be interested in whether the expression is high, as with CD25 in 
this tutorial. In other cases, only the low expression is of interest.  TriCOMs can be set up for 
High-Only and Low-Only to accommodate these cases. 

  

Here is an example that uses a High-Only TriCOM to quantify activated CD4 T cells. In the 
illustration, there are two expression profiles on the left, one for HLA DR and the other for 
CD38. These are activation markers for CD4 T cells. The plots show the high (H) and normal 
(N) expression levels. Also note that there are two stages: naive CD4 T cells are dark blue 
dots and memory cells are orange dots. A cartoon of a TriCOM is shown on the right.  The 
bottom row of the TriCOM would show events that are in the normal 95% confidence limits, 
however this TriCOM is set up to show high events only. The next row up from the bottom 
quantifies events that are high for either HLA DR or CD38, but not both. For example, there 
are 2200 events that are high for HLA DR in the naive stage and 7000 events high for HLA 
DR in the memory stage. The top row contains events that are high for both HLA DR and 
CD38.  
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Let's create a TriCOM to see how it works. 

  

Create a TriCOM 

On the Insert tab of the ribbon, click the TriCOM button. There is also a TriCOM button on 
the cell type toolbar on the left edge of the Cell Type window. 

 

  

Scroll to find an empty place on the CD4 cell type, then click and drag to define the 
TriCOM location. A TriCOM with default measurements is created. 
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Right-click in the TriCOM and choose Edit Graphics from the context menu. 

 

  

Find the Measurements section of the dialog and click the Choose button. 
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Uncheck the SSC-A, CD3, and CD4 measurements Include property. 

Check the CD25 and CD127 Include property. 

Select High Only for CD25 and select Low Only for CD127.   

 

  

Click OK. 
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Click OK to close the Edit Graphic Options dialog. 

The TriCOM for CD25 and CD127 is displayed. 

 

The TriCOM is divided into four vertical sections, one for each of the stages.  The Y-axis 
shows the number of measurements that are outside the expression profiles.  Each element 
in row one has one measurement outside the expected expression level, while row two has 
two measurements outside the expression profile. The key at the bottom indicates that A is 
CD25 and B is CD127.  An uppercase letter indicates elevated expression, and a lowercase 
letter indicates low expression.   

Notice the largest pie on the bottom row. All of the cells in this pie are in the Stg2 stage of 
the progression.  The A wedge represents cells that have elevated CD25 and normal, positive 
expression of CD127. The b wedge represents cells that have low expression of CD127 and 
normal, low expression of CD25.  

Pies on the second row have the phenotype Ab, which corresponds to CD25+ CD127-. This 
is Treg phenotype. The size of the pies is proportional to percentage, so Stg2 contains the 
largest fraction of the Tregs. 

  

Naming Stages 

Even though we will not rename the stages in this tutorial, it is useful to know that 
GemStone allows you to rename stages from the default stage names of Stg1, Stg2, etc. The 
Stages command on the Develop tab is used for this purpose. Some of the elements on 
reports need to be updated after stages are renamed, and the easiest way to update them is 
to use the Cell Type Wizard to edit the cell type and create a new report page. 

We will leave that for another tutorial.   
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Verify a TriCOM with Animation 

We can use animation to verify the Treg events. Animation will blink events in all of the plots 
for the pie segment that we select. 

Right-click the pie for Ab events in the Stg1 stage and choose Edit Segment. 

Note: your statistics may differ from those shown in the images below. 

 

  

In the Animation section, choose a bright color like pink and enable the Animate checkbox. 
Scroll the cell type window with this dialog open. Open the CD25 and CD127 profiles. Note 
the events blinking in the expression profile plots are CD25+ CD127- in Stg1.  

 

  

Uncheck the Animate checkbox and click OK to close the dialog. 

Right-click the large Ab pie on the upper row in Stg2 and choose Edit Segment. 

Choose a bright color and enable the Animate checkbox. 

Again the CD25+ CD127- events are blinking, this time in Stg2. 
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Animation makes it easy to verify the TriCOM segments. 

Uncheck the Animate checkbox and click OK to close the dialog. 

  

Create a Table 

Let's create a table under the TriCOM to show the percentages for the Tregs in each stage, 
as well as the total percentage of Tregs. 

Click the Table tool on the Cell Type toolbar or on the Insert tab of the ribbon. 

 

  

Below the TriCOM you just created, click and drag to define space for a table. 
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Right-click just above the table's grid and choose Edit Frame in the menu. 

 

  

Edit the Rows to 5 and Columns to 2.   

Click OK. 
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In the first column, type the following text labels: 

Naive Tregs, CM Tregs, EM Tregs, TE Tregs, and Total Tregs. 

 

  

Next you will add information fields that contain the percentages for the Treg subset. 

Left-click the cell next to Naive Tregs, then right-click that cell. 
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The Edit Selected Information Units dialog is displayed. This dialog contains all of the 
information that GemStone has computed for this model template and FCS file, including the 
TriCOM information. 

Note, you may need to resize this dialog and adjust column widths on some monitors to see 
the information presented below. 

Scroll to the section labelled CellType1_TriCOMGraph and click the arrow next to the label 
to open the section. 

 

  

Select the item named CellType1_TriCOMGraph_Stg1_A+b-_PercentCellType and 
click the Add button. The statistic is added to the list on the left of the dialog. 
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Scroll down in the list and select CellType1_TriCOMGraph_Stg2_A+b-
_PercentCellType. Click Add to add it to the list on the left. 

 

  

Next select CellType1_TriCOMGraph_Stg3_A+b-_PercentCellType and click Add. 
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Select CellType1_TriCOMGraph_Stg4_A+b-_PercentCellType and click Add. 

 

  

Scroll back up to the CT total section and add the 
CellType1_TriCOMGraph_CTTotal_A+b-_PercentCellType. 



GemStone User Guide 

125 

 

  

With these five statistics added to the list on the left, click OK. 

The fields we picked fill down from the selected cell, and the five results are added to the 
table. You may need to tab out of the first cell to see the value. 

 

You can create tables on a report page using the same technique. 

  

Save your Work 

At this point you have a TriCOM for Tregs in the CD4 T cell type and a table to display the 
results. This is the approach used to quantify subsets within a cell type. 

  

Before saving, switch back to the Report tab, display the CD4 T report page, and scroll it to 
the position you want to appear when this template is used.  The template will remember 
this view when it is saved.  Click Save in the Template section of the ribbon.   
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Summary 

This tutorial introduced the TriCOM object, which you used to identify the Tregs subset of 
CD4 T cells. TriCOMs are associated with functional markers and identify elevated and 
diminished levels of expression. The Tregs TriCOM quantified high CD25 and low CD127 
expression. 

You animated segments of the TriCOM to see where the associated events appear in other 
plots. This technique was used to verify that the TriCOM was working correctly. 

Once the TriCOM was created you created a table, added some text labels to it, and then 
selected the results to display in the table. 

The next tutorial introduces the Cen-se' plot and how it is used to explore your data. 
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Develop: Exploring with Cen-se' 

  

Overview 

GemStone has two independent analysis systems. In the previous tutorials, you have worked 
with the Probability State Modeling (PSM) system to analyze the FCS files. Cen-se' is the 
second system, which can make use of PSM information to color and label cell type 
information. 

Cen-se' is a fantastic tool for exploring your data. It statistically determines related events 
based on the measurements we select, and presents them in a bivariate plot. With Cen-se', 
we can assess how well our model is identifying cells in our cell types. We can also explore 
cells that do not yet belong to a cell type to find out what measurements identify them. 

In this tutorial we extend the Project developed in the previous tutorials, Starting a New 
Project from Scratch, Adding Cell Types to the Project, and Analyzing Subsets. We add a 
Cen-se' plot to a report page and used to explore our data. 

  

Prerequisites 

This tutorial continues to build the Project that was started in the following tutorials: 

Develop: Starting a New Project from Scratch 

Develop: Adding Cell Types to the Project 

Develop: Analyzing Subsets 

  

Start GemStone 

Start Gemstone by following the instructions in the Installation and Setup of GemStone 
section. 

  

Open the Project 

Open the "New Project Tutorial" Project that you created in the previous tutorials by selecting 
it in the Project dropdown list. 
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Click the Develop checkbox to enable develop mode. 

 

  

Analyze a File 

Double-click the first file in the batch list.  A dialog of choices will be displayed. 

Click Analyze to reanalyze the file with the latest model template revisions. 

 

  

  

Adding a Cen-se' Page and Plot 

Click the Add Page button on the Report tab next to the NK cell type. This will create a new 
page for the report. 

 

  

Right-click the new page and choose Rename.  
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Edit the name to Cen-se and press Enter. 

 

  

Select the Cen-se' tool on the report toolbar or from the Insert tab of the ribbon. 

 

  

Click and drag to define space for a Cen-se' plot on the report page. 
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Double-click in the new Cen-se plot to display the Edit Graphics Options dialog. 

Click the Choose button for Measurements. 
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In the Choose Measurements dialog, enable all of the measurements except for FSC-H, 
SSC-H, and Time. We exclude these because FSC-A and SSC-A provide more information for 
the Cen-se, and Time does not help the Cen-se differentiate cell types. 

Click OK. 
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Click the Choose button for Cell Types. 
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Make sure that all cell types are selected except for Other Events. 

Click OK. 



Tutorials 

134 

 

  

Click OK to close the Edit Graphic Options dialog. 

Move the mouse over the Cen-se plot to show its toolbar, then click the Build Cen-se' tool. 
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After a few moments, the Cen-se' plot will be displayed. The plot is a two-dimensional 
representation of the 21 measurements we selected in previous steps. Based on the popular 
t-SNE embedding algorithm (t-SNE © 2014 Laurens van der Maaten, Delft University of 
Technology), Cen-se' provides better separation of populations and computes much faster 
than t-SNE. 

Notice that some of the populations are labeled with the cell type and stages created with 
the Cell Type wizard. This labeling is applied automatically for any of the cell types that we 
include in the Cen-se'. The coloring of the populations comes from the stage colors in this 
initial view of the plot. The gray dots represent populations that have not been defined in the 
template model yet. 

Note, your graphics and statistics may differ from those shown below. 

 

  

Using the Intensity Heatmap 

The CD4 T, CD8 T, and NK cell types are labeled, and the coloring from the cell types is 
applied to the events in the Cen-se' plot. There are also several populations of gray-colored 
events. 

  

Double-click the plot to display the Edit Graphic Options dialog again. Move and size the 
dialog so that you can see the Cen-se' plot. Click the Cen-se' tab of the dialog. 
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In the Coloring section, change Color Scheme to Intensity Heatmap.  

Select CCR7 for the Heatmap Measurement.  The Naive (Stg1) CD4 T and CD8 T cells are 
brightest for CCR7, as shown with red dots. Events that do not express CCR7 are shown as 
dark blue dots. The intensity color scale is shown on the right-hand side of the Cen-se' plot. 

 

  

Change the Heatmap Measurement to CD3. 

With CD3 selected, the CD4 T and CD8 T cell type show bright red dots. 
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Select CD14 for the Heatmap Measurement. 

One population is red, probably the monocytes. 

 

  

Select CD16 for the Heatmap Measurement. 

The CD16 events are likely neutrophils, which would explain the large fraction of events in 
this population. 

 

  

Select CD19 for the Heatmap Measurement. 

One of the CD19 positive populations is probably B cells. 
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The Intensity Heatmap is a great way to explore and verify populations in the Cen-se plot. 

Set Color Scheme back to Summary Map Colors, and click OK. 

  

Exploring Unknowns with Cen-se' 

We have seen how colors and labels from the template model can enhance the Cen-se' plot. 
We can also use the Cen-se' plot to explore populations in the template model. This tight 
integration of Cen-se' and the Probability State Model is unique to GemStone and may be one 
of its most powerful features. Let's try it out. 

Select the Ellipse Region tool in the Cen-se toolbar on the right side of the Cen-se plot. 

 

  

Draw an elliptical region around the population we identified as CD14+. 
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Right-click inside the region and choose Show Region Animation. 

  

 

  

Click the Cell Types tab and select the Other Events cell type. 
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The Other Events cell type displays events that are not included in any of the other cell types 
defined in the model template. 

You may need to scroll the cell type window so that you can see the upper left corner. 

Right-click the first plot and choose Expand This Plot. 

 

  

The dots that are blinking are the ones you surrounded on the Cen-se plot with the region. 
You can see that CCR7 is negative to dim for those events. 

Use the Page Down key (PgDn) on the keyboard to view the next measurement, 
CD3.  Most of the blinking events are negative for CD3. 
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Page down until you find CD14. Note that most of the blinking events are positive for CD14. 
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Page down until you come to CD38.  Notice that it is also positive. 
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Page down to HLA DR. Note that this marker is positive for the animating events. 
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The phenotype of these blinking events, CD3- CD14+ CD38+ HLA DR+, points to this 
population being the monocytes. Using this information, you could use the Cell Type Wizard 
to create a new cell type for monocytes. 

Return to the Cen-se' plot by selecting the Reports tab and choosing the Cen-se page. 

Move the region to the smaller population near the monocytes. This was CD19+ in the 
Intensity Heatmap, so it may be the B cell population. 
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Return to the Other Events cell type by selecting the Cell Types tab and choosing Other 
Events. 

Find CD38 and use the Expand This Plot command. 

Note that all intensities of CD38 are blinking. Naive B cells express CD38, and CD38 is down-
regulated as B cells mature. 
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Expand the CD19 expression profile.  

Consistent with B cells, the bright CD19 events are blinking, along with some dim CD19 
events.   
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Finally, expand the HLA DR plot and notice the bright HLA DR events are animating.  This 
confirms that this is the B cell population. 

 

  

Back on the Cen-se plot, right-click the R1 region and choose Show Region Animation 
again to toggle the animation off. 

 

  

Using region animation, you can identify the key markers for unknown events that cluster 
together in Cen-se'.  Often the markers will point to a known cell type that has not yet been 
created in the template model. 

  

Save your Work 

It is time to save the enhancements to our model template. Before saving, switch back to the 
Report tab, display the CD4 T report page, and scroll it to the position you want to appear 
when this template is used.  The template will remember this view when it is saved.   

Click Save in the Template section of the Develop tab on the ribbon.   



Tutorials 

148 

  

Summary 

In this tutorial, you create a Cen-se' plot on a report page. You selected the measurements 
and cell types that would be displayed in the Cen-se' and edited the graphic options.  

The Intensity Heatmap display provided a tool for reviewing locations on the Cen-se' plot that 
expressed each of the markers, one at a time. It gave us clues about the phenotype of the 
events and where cell types were located on the Cen-se'. 

You drew a region on the Cen-se' plot to animate events in clusters that were not identified 
by the model template. With the events animating, you reviewed the Other Events cell type 
to see which markers were positive and which were negative for the animating dots. 

The next tutorial contains additional exercises to continue building this model. 
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Develop: Additional Exercises 

  

In the previous tutorials, you  created a template document  that identifies three cell types:  CD4 T 
cells, CD8 T, and NK cells.   You added a TriCOM to identify the Treg subset of CD4 T, and  then added 
a Cen-se' plot  to the report.  

There are several additional cell types that can be defined by the markers in the 16-color 
example file. These are left to the reader to add to the template model as additional 
exercises. Guidance on how to define these cell types is provided below. 

Use the techniques illustrated in the previous tutorials to define each cell type. 

  

Prerequisites 

These exercises continues to build the Project that was started in the following tutorials: 

Develop: Starting a New Project from Scratch 

Develop: Adding Cell Types to the Project 

Develop: Analyzing Subsets 

Develop: Exploring with Cen-se' 

  

Start GemStone 

Start Gemstone by following the instructions in the Installation and Setup of GemStone 
section. 

  

Open the Project and Analyze a File 

Open the "New Project Tutorial" Project that you created in the previous tutorials by selecting 
it in the Project dropdown list. 

Click the Develop checkbox to enable develop mode. 

Double-click the first file in the batch list.  A dialog of choices will be displayed. 

Click Analyze to reanalyze the file with the latest model template revisions. 

  

B Cells 

B cell phenotype: SSC-A- CD3- CD14- CD56- CD19+ HLADR+ CD27->+ 
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Use the Cell Type Wizard to create a new cell type named B.  

Selection markers: SSC-A- CD3- CD14- CD56- CD19+ HLADR+  

Hint: For the negative markers, use Dimmest Peak and Low Pass. For positive markers, use 
Brightest Peak and Normal. 

  

Staging markers: CD27 StepUp 

  

Functional markers: CD38 

  

The B cell report created by the wizard will look similar to the graphic below.  Your results 
may differ. If you make a mistake or want to change the cell type, use the Cell Type Wizard 
to edit the cell type. 

 

  

Monocytes 

Monocyte phenotype: CD3- CD19- CD56- HLADR+ SSC-A CD14+>- 

  

Use the Cell Type Wizard to create a new cell type named Mono.  

Selection markers: CD3- CD19- CD56- HLADR+ SSC-A.  

Hints: For the negative markers, use Dimmest Peak and Low Pass. For most of the positive 
markers, use Brightest Peak and Normal. Use Inverse Low Pass on Dimmest Peak for 
HLA DR. For SSC-A use Closest Peak, position the profile over the middle peak in SSC-A, and 
set the Initial Width to 5.  

  

Staging markers: CD14 StepDown 
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Hint: Set the Initial Width for both levels to 8.0 and uncheck Width from Peak. This will help 
capture the transitional events between the bright and dim. 

  

Functional markers: CD16, CD38 

  

The Mono report created by the wizard will look similar to this. Your results may differ. 

 

  

Gamma-Delta T 

gd T phenotype: CD3+ CD4- CD14- CD8+ TCRgd+ 

  

Use the Cell Type Wizard to create a new cell type named gd T.  

Selection markers: CD3+ CD4- CD14- CD8+ TCRgd+.  

Hint: For CD3+, use Brightest Peak and Normal. For the negative markers, use Dimmest 
Peak and Low Pass. Use an Inverse Low Pass on the Dimmest Peak for CD8 and 
TCRgd.  

  

Staging markers: none 

  

Functional markers: none 

  

The gd T report created by the wizard will look similar to this. Your results may differ. 
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Granulocytes 

Granulocyte phenotype: CD3- CD14- CD56- CD16+ 

  

Use the Cell Type Wizard to create a new cell type named Grans.  

Selection markers: CD3- CD14- CD56- CD16+.   

Hint: For the negative markers, use Dimmest Peak and Low Pass. For CD16+, use Brightest 
Peak and Normal. 

  

Staging markers: none 

  

Functional markers: none 

  

The Grans report created by the wizard will look similar to this. Your results may differ. 

 

  

  

Summary 
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The Cell Type Wizard is designed to make it quick and easy to define additional cell types. 
There are several strategies that we have used in these tutorials that are good to keep in 
mind. 

• For negative selection markers, use a Low Pass profile on the Dimmest Peak.  
• Positive selection markers are most often modeled with a Normal profile on the Brightest 

Peak. 
• When positive peaks are not present, use Inverse Low Pass profiles on the Dimmest 

Peak.  
• When peaks are highly variable in width, it can be helpful to manually set the Initial 

Width and uncheck Width from Peak. 
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Develop: Finishing the Project 

  

Overview 

This series of Develop tutorials introduced the key concepts needed to develop a new 
analysis project.  

The Measurement wizard was used to review the names and transforms for the 
measurements in a file. The Cell Type wizard was used to define each cell type's selection 
markers, staging markers, and functional markers.  The wizard also created a basic report 
page with graphics and statistic tables. 

To identify additional subsets within a cell type, we created a TriCOM and set it up to 
quantify Tregs in the CD4 T cell type. We create a table to display the results Treg results 
from the TriCOM. 

We added a Cen-se' plot to a report page and explored its display options. The Summary 
Map Coloring showed our cell type and staging colors on the Cen-se'. The Intensity Heatmap 
highlighted the portions of the Cen-se' plot that are hot spots for each marker we selected. 
We also used animated regions on the Cen-se' plot to explore unclassified events in the Other 
Events cell type. This allows us to locate the Monocytes and B cell populations. 

In this last part of the tutorial, we'll add a summary page to the report and spruce up the 
other report pages. 

  

Prerequisites 

This tutorial continues to build the Project that was started in the following tutorials: 

Develop: Starting a New Project from Scratch 

Develop: Adding Cell Types to the Project 

Develop: Analyzing Subsets 

Develop: Exploring with Cen-se' 

Develop: Additional Exercises 

  

Start GemStone 

Start Gemstone by following the instructions in the Installation and Setup of GemStone 
section. 
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Open the Project 

Open the "New Project Tutorial" Project that you created in the previous tutorials by selecting 
it in the Project dropdown list. 

 

  

Click the Develop checkbox to enable develop mode. 

 

  

Analyze a File 

Double-click the first file in the batch list.  A dialog of choices will be displayed. 

Click Analyze to reanalyze the file with the latest model template revisions. 

 

  

Reorder the Report Pages 

The report pages appear in the order in which they were created, putting the Cen-se' report 
page right in the middle of the pages. Let's change that so that Cen-se' comes at the end the 
cell type pages are in a better order, too. 
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Right-click one of the report page tabs and choose Reorder from the menu. 

 

  

In the dialog, select the Cen-se page and use the Down button to move the pages into the 
order shown below. 

Click OK. 

 

  

Graphic Improvements 

The report pages created by the Cell Type wizard provide a good starting place, but the 
wizard doesn't know what combinations of measurements are most important. Let's review 
several cell type report pages to add and modify some of the plots. 

CD4 T Report Revisions 

Select the CD4 T report page. 

In the Staging Markers section, click the Y-axis CCR7 label for the second plot and choose 
CD45RA instead. 
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Next, right-click the CD27 vs CD45RA plot and choose Copy from the menu.  

Right-click in the empty space next to the plot and choose Paste.  

Move the new plot next to the one you just edited.   

Select CD25 and CD127 for the X and Y axes. 

 

You can make other additions and edits if you choose. 

  

CD8 T Report Revisions 

Select the CD8 T report page. 

On this page let's revise the report to have three plots for the Staging Markers section: CCR7 
vs CD27, CCR7 vs CD38, and CCR7 vs CD45RA. We'll use Copy and Paste to do this. 

Right-click near the left corner of the CCR7 vs CD27 plot and choose Copy. 
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Right-click in the blank space next to the plot and choose Paste. 

 

  

Drag the pasted plot next to the first plot. 

Click the Y-axis label and choose CD38. 

  

Add Missing Markers to Display 

Right-click and choose Paste again to paste another copy of the plot. 

Drag to position the third plot next to the second. 

We want to display CCR7 vs CD45RA, but CD45RA is not in the list of choices.  
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When selecting measurements to display in plots, only measurements that have been added 
to the cell type are shown. So when you want to display a marker in a plot, it must first be 
added to the cell type. This can be done with  the Cell Type Wizard, adding the measurement 
as a Functional Marker. It can also be done with a tool on the Cell Type tab. 

  

Click the Cell Types tab and select the CD8 T cell type. 

 

  

Click the Add Measurement tool in the cell type toolbar. 

 

  

In the dialog that appears, select CD45RA in the list on the left and click Add to add it to 
the list on the right. CD45RA is added to the other measurements included in the cell type.  

Click OK. 
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Note: You can use this technique to add other markers after defining the cell type with the 
Cell Type Wizard. It is not recommended to use this to add selection or staging markers, as it 
can make the cell type incompatible with the Cell Type Wizard. 

  

Now that you have added CD45RA to the cell type, navigate back to the Report tab and 
select the CD8 T report.  

Change the Y-axis of the third staging markers plot to CD45RA. 

 

  

Mono Report Revisions 

Select the Mono report page. 

Change the Y-axis for the Staging Marker plot from SSC-A to CD38. 

Add dot plots for CD14 vs CD16 and CD38 vs CD16. Use the same copy-paste approach 
described for the CD8 revisions to create the plots. 

 

  

Feel free to make additional changes to any of the report pages. 

  

Create a Summary Table 

Right-click the Page1 report tab. 

Rename Page1 to Summary. 
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Select the Table tool on the report toolbar. 

 

  

Click and drag to define space for the table on the report page. 

 

Right-click near the top of the table and choose Edit Frame. 

Uncheck Show Title. 

Set Rows to 33 and Columns to 4. 

Click Font and set the font size to 12 and click OK to close the Font dialog. 

Click OK. 
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This table will contain a summary of population results for all cell types. You will start by 
adding labels in the top row and left column. 

At the top of column two, three, and four, type Count, % Cell Type, and % Total. 

 

  

In the left column, enter the labels as shown. Indent the labels with spaces to show the 
relationship of the populations. 

You may need to adjust the size of the table object to see all of the rows. 
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Copy and Paste Results 

Most of the information for this table already appears in tables on the population report 
pages, so you can copy and paste results to fill in this table more quickly. 

  

CD4 T results 

Select the CD4 T page of the report. 

Right-click the top of the population stage table and choose Copy. 
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Select the Summary page of the report. 

Right-click the page and choose Paste. Move the pasted table next to the summary table. 

 

  

Next, you copy each statistic from the CD4 T table and paste it into the appropriate column 
of the summary table.  

Click the first number in the Events column and press Ctrl-C on the keyboard to copy the 
content. 

Click the Count column next to CD4 T and press Ctrl-V to paste into the cell. 

In our summary table, we have given the CD4 T stages their common names. The results for 
Stg1 will be copied into the table row for Naive. Similarly, Stg2 is copied to CM, Stg3 is 
copied into EM, and Stg4 is copied into TE. 

Repeat this process for each of the numbers in the CD4 T table, pasting them into the 
appropriate cell in the summary table. 
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Delete the CD4 T table that you pasted to this page; it is not needed. 

  

You may have noticed that you did not actually copy numbers. Instead, the content you have 
copied is a kind of formula that identifies each statistic for the CD4 T cells. This formula will 
allow the program to update the values when you change the analysis or read a new FCS file 
into this template. 

  

To fill-in the results for the CD4 Tregs, let's find them in the information dialog. 

Click the cell next to Tregs to activate it, then right-click in the cell. 

In the Edit Selected Information Units dialog, select the CellType1_TriCOMGraph 
section and click the arrow to open it up. 

Select CellType1_TriCOMGraph_CT Total_A+b-_Events, click Add and click OK. 

 

  

Click the Tregs cell for %Cell Type to activate it, then right-click in the cell. 
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In the Edit Selected Information Units dialog, select the CellType1_TriCOMGraph 
section and click the arrow to open it up. 

Select CellType1_TriCOMGraph_CT Total_A+b-_PercentCellType, click Add and click 
OK. 

Note, your results may differ from the ones shown below. 

 

  

Results from the other cell types 

Let's repeat this pattern with the remaining cell types to populate the summary table with 
information. 

For each population: 

Select the page for the next cell type of the report. 

Right-click the top of the population stage table and choose Copy. 

Select the Summary page of the report. 

Right-click the page and choose Paste. Move the pasted table next to the summary table. 

Copy and paste each result from the pasted table into the appropriate cell of the summary 
table.  

Note that for cell types with staging, the order of stages in the summary table matches the 
order of stages in the cell type. 

Delete the pasted table when you have finished copying results from it. 

  

Add results for Intact Cells and Other 

Move to the row for Other at the bottom of the table. 

Click the cell for Count to select it, then right-click the cell. 

In the Waste section, select Waste_Unclassified_Events, click Add and click OK. 
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In the next column, type N/A. 

Click the cell for % Total to select it, then right-click the cell. 

In the General Analysis section, select General Analysis_Percent Unclassified, click 
Add and click OK. 

 

  

The summary table is now filled-in with most of the information we want to display. 
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Create Equations for the Summary Table 

The last statistics that we want to add do not exist yet. We did not create a cell type named 
"CD3 T" or "Lymphocytes", so there are not statistics for them. We need to create equations 
to compute the these based on other statistics. GemStone has a tool for this purpose, which 
is discussed in detail in the Equations section. For this tutorial, we will only use the most 
common equation types: sums and percentages. 

  

Click the Equations button on the Develop tab. 
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In the dialog that appears, click the first entry in the list on the left, Sum, and click the Add 
button. 

 

  

This adds an example Sum equation to the list. You will edit this equation so that it adds up 
the CD3 cell types. 

Click the Sum text in the Description field and edit it to CD3Events. 

 

  

This equation is set up to add three numbers with the Format of %1+%2+%3. The parts 
of the equation that have % and a number are placeholders for some statistics that we want 
to substitute.  In this case, we will substitute the CD4 T, CD8 T, and gd T events. 

  

Double-click the Eq1 name of the equation to edit what will be substituted for the 
placeholders. 
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We'll start with the CD4 T events. 

Right-click the Information field next to %1 to choose an information unit. 

In the Edit Selected Information Units dialog, open the CellType1 section, select 
CellType1_Cell Type_Events, click Add, and click OK. 
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Next, let's add the CD8 T events. 

Right-click the Information field next to %2 to choose an information unit. 

In the Edit Selected Information Units dialog, open the CellType2 section, select 
CellType2_Cell Type_Events, click Add, and click OK. 

 

  

Finally, we add the gd T events.  CellType6 is the gd T cell type. 

Right-click the Information field next to %3 to choose an information unit. 

In the Edit Selected Information Units dialog, open the CellType6 section, select 
CellType6_Cell Type_Events, click Add, and click OK. 
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Click OK to close the Edit Eq1 dialog. 

This equation now sums up the CD4 T, CD8 T, and gd T events so that we have a total of 
CD3 T events. 

  

Let's do the same thing for the Lymphocytes.  This will be another Sum type equation that 
will add CD3 T, B cells, and NK cells. 

Select the Sum example equation in the left listbox and click Add.  

Edit the Description to Lymphocytes. 

Double-click the Eq2 label to edit the placeholders. 

  

Right-click the %1 Information field. 

Open the Equations section and select Eq1:CD3Events. Click Add and click OK to use our 
equation for CD3 events for the %1 placeholder. 

 

  

Right-click the %2 Information field. 

Select CellType4_Cell Type_Events, click Add, and click OK to use B cell events for %2. 
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Right-click the %3 Information field. 

Select CellType3_Cell Type_Events, click Add, and click OK to use NK cell events for %3. 

Click OK to close the Edit Eq2 dialog. 
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There are three more equations to create: percentages for CD3 T, Lymphocytes, and Intact 
cells. 

Select the %Ratio example equation from the list on the left and click Add. 

Edit the Description to be CD3Percent. 

 

  

This equation's format is designed to compute a percentage of the first argument to the 
second. We will choose Eq1:CD3Events as the first argument and the total cells analyzed for 
the second. 

  

Double-click Eq3 to edit its placeholders. 

Right-click the %1 Information field. 
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Open the Equations section and select Eq1:CD3Events. Click Add and click OK to use our 
equation for CD3 events for the %1 placeholder. 

 

  

Right-click the %2 Information field. 

In the General Analysis section select General Analysis_Total Analyzed Events, click 
Add, and click OK. 

Click OK to close the Edit Eq3 dialog. 
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Since the next equation is so similar to the one we just finished, we'll duplicate it as a 
starting point. 

Select Eq3 in the list and click Duplicate. 
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Edit the Description to LymphocytePercent, and double click Eq4 to edit its placeholders. 

We can directly edit the text of the Information column for %1 placeholder.  

Click the Information column for %1. 

Edit the text to read [Eq2]. This is the Lymphocyte event count equation. 

Click OK. 
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Now for the last equation. 

Select Eq3 in the list and click Duplicate. 

Edit the Description to IntactPercent, and double click Eq5 to edit its placeholders. 

  

We need to edit the first placeholder; the second one is correct. 

Right-click the %1 Information field. 

In the General Analysis section select General Analysis_Total Cell Type Events, click 
Add, and click OK. 

 

Click OK to close the Edit Eq5 dialog. 

Click OK to close the Edit Information Equation dialog. 

  

Yay! The equations we need are ready to go. 

  

Finish the Summary Table 
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Let's finish the table with six more statistics. 

Right-click the Count cell next to Intact Cells. 

In the General Analysis section select General Analysis_Total Cell Type Events. 

 

Click Add and click OK. 

  

For the next two Count cells, we will use equations Eq2:Lymphocytes and Eq1:CD3Events. 
Since these two values will be in the next two rows, we can add them both at the same time. 

Right-click the Count cell next to Lymphocytes. 

In the Equations section select Eq2:Lymphocytes and click Add. 

Select Eq1:CD3Events and click Add. Click OK. 

 

  

In the % Cell Type column for the first three rows, type N/A.  

  

The last three additions to the table are so simple you can just type them in! 

In the %Total column for Intact Cells, type [Eq5]. This is the equation for Intact cells as 
a percent of total. 

In the %Total column for Lymphocytes, type [Eq4]. This is the equation for Lymphocytes 
as a percent of total. 

In the %Total column for CD3 T, type [Eq3]. This is the equation for CD3 T cells as a 
percent of total. 

Again note, your results may differ from those shown. 
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Well done, that's a lot of information! 

  

Adjust the size and position of the table to be centered in the page.  You can also adjust the 
width of the columns. 

Use the Text tool to add a text object above the table, and edit it to Summary. Edit its 
properties to use an 18pt font and centered alignment. 

Here's the finished summary page. 

 

  

Save your Work 
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Click the Save button in the Template section of the Develop tab. 

 

  

Summary 

In this last tutorial of the Develop series, you polished up the report with additional graphics 
and a summary page.  

On the summary page you created a large table and typed in labels for the columns and 
rows. For each cell type, you copied a table from the cell type report page to the summary 
page, and then copied cells from that table into the summary table. You added a few other 
statistics by right-clicking a cell and picking the item from the Information tree. 

In order to complete the table, you learned how to create equations. The equations added up 
several numbers to give us the totals for CD3 T events, Lymphocytes, and Intact cells. Next, 
you added equations that computed percentages for the newly-added summation equations.  

Once the equations were created, you added them to the appropriate locations on the 
summary table. 

This is now a well-developed Project template to analyze files like the ones you added to it. 
You can create new Projects based on this one so that you can leverage the work you have 
done building this. 

You are now ready to start building for your own panels. Happy developing! 
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Stain Assessment 

  

Overview 

When you add a new measurement to your model, it is a good idea to evaluate how well the 
staining of the new marker is working. GemStone has a stain assessment tool to help assess 
the quality of a measurement, based on a cell type that is positive for the measurement and 
another cell type that is negative for the measurement. 

In this tutorial, you will extend the project created in the Develop series of tutorials to include 
stain assessment for several measurements. 

  

Prerequisites 

This tutorial continues to build the Project that was started in the following tutorials: 

Develop: Starting a New Project from Scratch 

Develop: Adding Cell Types to the Project 

Develop: Analyzing Subsets 

Develop: Exploring with Cen-se' 

Develop: Additional Exercises 

Develop: Finishing the Project 

  

Start GemStone 

Start Gemstone by following the instructions in the Installation and Setup of GemStone 
section. 

  

Open the Project 

Open the "New Project Tutorial" Project that you created in the previous tutorials by selecting 
it in the Project dropdown list. 
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Click the Develop checkbox to enable develop mode. 

 

  

Analyze a File 

Double-click the first file in the batch list.  A dialog of choices will be displayed. 

Click Analyze to reanalyze the file with the latest model template revisions. 

 

  

Create a Stain Assessment report page 

Click the Add Page button next to the last page tab. 

 

  

Right-click the new page and choose Rename. Type Stain Assessment for the page name. 

 



Tutorials 

184 

  

Adding a histogram 

Let's add a 1P plot to the stain assessment page that will compare the CD3 staining between 
the CD4 T and B cell types. 

Click the Histogram report tool button. 

 

  

Click and drag on the report to define the histogram size and location.  Alternatively, you can 
press Shift and click the mouse where you want to add the graphic on the report.  

A menu of cell types will be displayed. Choose CD4 T for the cell type. 

 

  

If you need to adjust the size or position of the histogram, click the white space of the axis 
area and use the handles to make adjustments. 

Click the X-axis label and choose CD3. 
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Overlaying Populations in the Histogram 

We want to compare CD3 between the CD4 T and B cell type.  The B cells should not express 
CD3, so it will serve as a good, negative control.  The histogram can overlay populations 
from different cell types, so it will serve the purpose nicely. 

  

Double-click in the histogram plot area.  The Edit Graphic Options dialog is displayed. 

Enable the Scale Plots and the Staining Assessment options. 
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Click the Choose button for Choose Population in the Selection section of the dialog. 

 

  

Check CT Total and B cell type, and make sure all others are unchecked as shown below. CT 
Total in this case means the all events in the CD4 T cell type. 
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Click OK. 

Click OK again to close the Edit Graphic Options dialog. 

On the Develop tab, click Classify to reanalyze the data and perform the stain assessment. 

 

  

At this point, the new histogram shows an overlay of CD4 T and B cells for the CD3 
measurement. 
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In the plot we can see that there is excellent separation between the positive and negative 
distributions. The text indicates "Extremely Good (ß=6.3)". Your result may be slightly 
different. Let's take a look at what this assessment means. 

  

Stain Assessment 

When a histogram overlays a measurement from different cell types and you check the Stain 
Assessment option, GemStone performs additional calculations on the populations in the 
histogram. This system is based on a statistical approach to computing the difference 
between two populations, called Strictly Standardized Mean Difference (SSMD). The 
SSMD can be estimated as 

  

 

  

where  are the medians and median absolute deviations in the positive 
and negative controls, respectively. These are indicated in the graphical display. 
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The result of the equation is a unit-less number that expresses degree of difference. A look-
up table is used to map the number to explanatory text, such as "Extremely Good". Values 
greater than 2.0 are strong, values between 2.0 and 1.0 are moderate, and values less than 
1.0 are weak. With the CD3 measurement in this example, the staining is working very well 
to separate the positive and negative populations. 

For more information on SSMD, review this Wikipedia article: 
https://en.wikipedia.org/wiki/Strictly_standardized_mean_difference 

  

You can add as many stain assessment histograms as you need to your reports. For each 
measurement, choose a cell type that is the best "positive" and another cell type that should 
be "negative" for the measurement.  In the absence of a negative cell type, you can use the 
Unclassified events as the negative population. 

  

Save your Work 

Click the Save button in the Template section of the Develop tab. 

 

  

Summary 

https://en.wikipedia.org/wiki/Strictly_standardized_mean_difference
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In this tutorial, you evaluated the quality of the CD3 staining using the histogram to overlay 
CD4 T and B cells.  You enabled the stain assessment and selected a positive and negative 
population for the measurement. 

For quality control purposes, you can create a stain assessment plot for each stain in your 
panels to verify that the stains are working correctly. The key for this approach is to identify 
one cell type that should be strongly positive for the stain and another that should be 
negative for the stain. Unclassified events can also be used in some cases as the negative 
population. 

The stain assessment information can also be added to the database of results. 
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Reference 

Reference 

  

File tab 

Home tab 

Insert tab 

Options tab 

Develop tab 

Help tab 

Batch 
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File tab 

File Tab 

  
File tab in Run mode File tab in Develop mode 

 

 

  

New Project 

Open Project 

Save Project 

Save Project As 

Clean Project 

  

Delete Project 

Archive Project 

Search Archives 

  

Save PDF Report 

Print Report 
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Open Report Template 

Save Report Template 

  

Printer Setup 

Preferences 

  

Exit (Quit) 
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New Project 

  

 

This command creates a new Project.  The command appears in the File menu and on the 
Home tab. 

The New Project dialog is displayed. 

 

  

The new Project can be based on any existing Project in the Project Library, or it can be a 
completely new Project, not based on any Project.  When you select a Based on Project, the 
suggested Project Name for the new Project will update. 

The location for the Project can be changed with the Browse button.  However, it is 
recommended to create methods in the Project Library folder, which is the default location. 

  

See also: 

What is a Project? 
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Open Project 

  

 

  

This command opens a Project from disk. The command appears in the File menu. 

The standard file open dialog is displayed to choose a Project. Navigate to the Project folder 
with the dialog and select it.  The Project will be opened. 

  

See also: 

What is a Project? 

Project List 
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Save Project 

  

 

  

The Save Project command re-saves the current Project.  The command appears in the File 
menu and on the Develop tab. 

Use this command when you have changed the batch scripts, database format, or model 
template used in the Project. 

  

The Save Project As command (Develop mode) displays a dialog that allows you to type a 
new name and location for the Project. All content from the original Project is copied to the 
new Project name and location.   

  

See also: 

What is a Project? 
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Clean Project 

  

 

  

This command cleans output files from the Project folders. The command appears in the File 
menu 

The Clean Project dialog is displayed. 

 

  

This command acts on files in the current Project, which is displayed in the title bar. Select 
the files that you want to remove from the Project using the check boxes in the list: 

  

Checkbox 
Option 

Description Location 

Original FCS 
files 

FCS files that were added to the Project for 
analysis. 

FCS Files/Original folder 

Exported FCS 
files 

FCS files that created by a process in the Project 
(e.g. clean-up files). 

FCS Files/Exported folder 

Synthesized 
FCS files 

FCS files that created by synthesized data in the 
Project. 

FCS Files/Synthesized folder 
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Fitted Models 
A fitted model can be saved for each FCS file 
analyzed.  

Fitted Models folder 

Graphics Graphics can be saved for each FCS file analyzed. Graphics folder 

PDF Reports 
PDF reports can be saved for each FCS file 
analyzed. 

PDF Reports folder 

Batch List 
The entries in the batch file list on the left side of 
the main window. 

Entries are removed from 
the list. 

  

After selecting the items you want to clean (remove), click the OK button to perform the 
operation.   
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Delete Project 

  

 

  

The Delete Project command is only available in Develop mode. This command displays a 
confirmation dialog. 

 

  

Choose Yes to confirm that you want to delete the Project and all of its content.  Choose No 
to cancel the action. 
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Archive Project 

  

 

  

This command allows you to archive a Project to a zip file on disk. The command appears in 
the File menu. 

It displays the Archive Project dialog. 

 

  

An archive is a Zip file that contains the entire Project folder and file structure.  It is useful 
for storing an experiment prior to deleting it from the Project Library.  

Select the Project you want to archive from the Project to Archive drop-down.  The current 
Project is selected by default.  When you select a Project, the suggested Archive Name will 
update. 

The location for the Project can be changed with the Browse button.  Be sure to choose a 
location that has enough disk space to store the archive. 

Tags are words that you can enter to describe the experiment, the archive, or other 
elements you want to search for. Tags can be used in the Search Archives dialog to find a 
particular experiment that has been archived. 

After filling in the information fields, click the Save button to initiate the archive operation. 
Depending on the size and number of files in the Project, it may take some time to complete. 

  

See also: 

What is a Project? 

Search Archives 
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Search Archives 

  

 

  

This command allows you to search for an archived Project based on file names and tags. 
The command appears in the File menu. 

The Search Archives dialog is displayed. 

 

  

This dialog allows you to search for archived Projects that match the criteria you enter.  

Tags are words that you entered in the Archive Project dialog when the archive was created. 
You can also enter FCS file names as tags. 

If you know the name of the Project that was archived, you can enter that in the Project 
name field. Similarly, you can enter the Archive name if you want to filter results on that. 

After filling in the fields at the top of the dialog, click the Search button.  The database of 
archived Projects will be search for matches, and matching results will be shown in the table. 

Select an archive from the list of results and click Extract to extract the archive back into 
your Project Library folder.  This will make the Project and all of its files available to the 
program again. 

Click Cancel to close the dialog. 

  

See also: 



Reference 

202 

What is a Project? 

Archive Project 
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Save PDF Report 

  

 

  

This command allows you to save a PDF version of the report. The command appears in the 
File menu. 

  

The command displays the standard file save dialog.  Navigate to the location where you 
want to save the report, enter a name, and click the Save button to complete the command. 
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Print Report 

  

 

  

This command allows you to print the report. The command appears in the File menu. 

The Print dialog is displayed.  Select appropriate options for your printer, and click Print to 
complete the command. 
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Open Report Template 

  

 

  

This command allows you to open a report template with a different report layout. The 
command appears in the File menu. 

The command displays the standard file open dialog.  Navigate to the location of the report 
template, select it, and click the Open button to complete the command. 

  

Note, the report will become the current report until a new model template is opened, a new 
Project is selected, or the program is closed.  To make the report template part of an analysis 
method, the model template must be resaved after opening the report template.  This will 
make the report template part of the model template. 
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Save Report Template 

  

 

  

This command saves the current report as a report template so that it can be used with a 
different model. The command appears in the File menu. 

The command displays the standard file save dialog.  Navigate to the location where you 
want to save the report template, enter a name, and click the Save button to complete the 
command. 
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Printer Setup 

  

 

  

This command allows you to set up the printer that GemStone will use. The command 
appears in the File menu. 

The command displays the standard printing dialog, which may vary in features and 
appearance depending on the operating system. 
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Exit (Quit) 

  

This command closes the program. It is Exit on Windows versions, and Quit on the Mac.  It 
appears in the File menu. 
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Home tab 

Home Tab 

  

 

  

Clipboard Project FCS Files Processing 
Analysis 
Document 

Paste New Project  Add FCS Files Run Open 

Cut Project List 

Remove FCS 
Files 

Next Save 

Copy 

Develop 
Checkbox 

Start At Auto   

      Stop   

  

* Some commands may be hidden when the software is running in Compliance mode. 
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Paste 

  

 

  

The command pastes text or graphics onto the current page of the report or cell type.  It 
appears on the Home Tab. 
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Cut 

  

 

  

The command cuts the currently selected text or graphics from the report or cell type.  It 
appears on the Home Tab. 
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Copy 

  

 

  

The command copies the currently selected text or graphics from the report or cell type to 
the clipboard.  It appears on the Home Tab. 
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New Project 

  

 

This command creates a new Project.  The command appears in the File menu and on the 
Home tab. 

The New Project dialog is displayed. 

 

  

The new Project can be based on any existing Project in the Project Library, or it can be a 
completely new Project, not based on any Project.  When you select a Based on Project, the 
suggested Project Name for the new Project will update. 

The location for the Project can be changed with the Browse button.  However, it is 
recommended to create methods in the Project Library folder, which is the default location. 

  

See also: 

What is a Project? 
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Project List 

  

This control is used to select and open a Project from the Project Library. It appears on the 
Home tab. 

  

 

  

This is the quick and easy way to select a Project for analysis - simply open the list by 
clicking the down arrow and select the method you want.  The Projects that are shown in the 
list are the ones that exist in your Project Library folder.  If you need to open a Project that is 
not in the Project Library, use the Open Project command. 
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Develop Check box 

  

 

This control is used to enable development tools for Projects. The checkbox appears on the 
Home tab. 

*Note, this option may not be available, depending on the user rights for your account and 
the version of the software that you have. 

In Develop mode, GemStone displays additional ribbon tabs Options and Develop that are 
used for model design and developing new Projects. 
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Add FCS Files 

  

 

  

This control is used to add FCS files to the batch to be analyzed by the current Project. The 
command appears on the Home tab. 

The Select FCS Files dialog is displayed, which is a standard file open dialog.  You can choose 
one or more files in the dialog, and then click Open to complete the command.  The files will 
be validated as FCS files, and then added to the batch list. 
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Remove FCS Files 

  

 

  

This control is used to remove files from the batch. The command appears on the Home tab. 

If files are selected in the batch list, those files will be removed from the batch.  They will not 
be deleted from disk. 

 

  

If no files are selected in the batch list, all files will be removed from the batch.  Files will not 
be deleted from disk. 
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Start At 

  

 

  

This control is used to set the first file to be analyzed by the current Project. The command 
appears on the Home tab. 

This is a convenience command that allows you to choose any file in the batch list as the 
starting point for processing.  Any files before that item in the list will be ignored.  Select the 
file you want to start with in the batch list, then click the Start At button to set it as the 
starting file. 
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Run 

  

 

  

This control is used to run the analysis on the current file in the batch list. The command 
appears on the Home tab. 

The command initiates the batch script associated with the current file in the file 
list.  Typically, this involves opening a model template, opening the FCS file, and analyzing 
the file with the template.  It may also include generating output, such as graphics and print 
outs. 
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Next 

  

 

This control is used to move to the next file in the batch list and analyze it. The command 
appears on the Home tab. 
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Auto Advance 

  

 

  

This control is used initiate auto-advancing through the batch list. The command appears on 
the Home tab. 

This command is designed for unattended, unsupervised analysis of a batch of files.  When 
auto-advancing, the program analyzes a file in the batch list according to its associated 
script, and then moves to the next file.  It repeats this process until it reaches the end of the 
batch list, or the user clicks the Stop button. 

  

See also: 

Stop 
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Stop 

  

 

  

This control is used stop auto-advancing.  It can also cancel any current analysis process. 
The command appears on the Home tab. 

With this command it triggered, the program will stop its current analysis process as quickly 
as possible.  This includes auto-advancing, analyzing a file, computing a Cen-se plot, and 
many other operations. 
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Open Analysis Document 

  

 

  

This control is used to open a previous analysis that was saved as an analysis 
document.  The command appears on the Home tab. 

This command displays the file open dialog to select an analysis document to open. 
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Save Analysis Document 

  

 

  

This control is used to Save an analysis document.  The command appears on the Home tab. 

  

Click the button to trigger the default action, or click the down arrow to see a list of Save 
actions. 

Save Document Saves the analysis document with the same name. 

Save Document 
As 

Displays the file save dialog to save the document with a new name. 

  

When you select a command from the down arrow menu, that command becomes the new 
default action for the button. 
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Insert tab 

Insert Tab 

  

 

  

  
Select Text Shapes Plots Tables Statistics* 
Selection 
tool 

Insert 
Text 

Insert Line Insert 1P Graph Insert Table 

Insert 
TriCOM 

    Insert Arrow Insert 2P Graph 

Insert EP 
Legend 

Insert 
Design 

    
Insert 
Rectangle 

Insert Expression 
Profile Plot 

Insert Cell 
Type Legend 

Insert Cen-
se 

    
Insert 
Ellipse 

Insert Overlay 
Plot 

Insert Stage 
Table 

  

  

* Note, the Statistics panel is only displayed when the program is in Develop mode.  Develop 
mode is enabled from the Home tab. 
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Text 

  

 

  

This tool allows you to create text objects on the report or cell types.  It is found on the 
Insert tab of the ribbon, as well as the toolbar for the report and cell type. 

Once the tool is selected, click and drag on the report or cell type to create a text 
object.  Then edit the text on the object.  Double-click the object to edit its properties. 

  

Text Properties 

  

 

  

Label Text 

Text to be displayed by the label  

Text Color  
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Color of the label's text  

Label Font  

Font of the label's text  

Alignment  

Alignment of the label's text (top left or centered)  

Word Wrap  

Check to perform word wrapping.  

Text Margin  

Space between the edge of the object and the text. (0 to 10)  

Rectangle Fill color  

Color of the fill  

Fill style  

Style of the fill  

Transparency  

Amount of transparency (0 to 100)  

Pen color  

Color of the outline  

Pen style  

Style of the outline  

Pen width  

Width of the outline in pixels  

Rotation Angle  

Rotation angle, from -360.0 to 360.0 degrees  
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Line 

  

 

  

This tool allows you to create line objects on the report or cell types.  It is found on the 
Insert tab of the ribbon, as well as the toolbar for the report and cell type. 

Once the tool is selected, click and drag on the report or cell type to create a line 
object.  Double-click the object to edit its properties. 

  

Line and Arrow Properties 

  

 

Arrows 

Number of arrow heads: none, one, or two 

Arrow head size 

Size of the arrow heads. (0 to 100) 

Line width 

Width of the line in pixels. (0 to 100) 
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Fill color 

Color of the fill 

Fill style 

Style of the fill 

Transparency 

Amount of transparency (0 to 100) 

Pen color 

Color of the outline 

Pen style 

Style of the outline 

Pen width 

Width of the outline in pixels 

Rotation Angle 

Rotation angle (-360.0 to 360.0 degrees) 
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Arrow 

  

 

  

This tool allows you to create arrows on the report or cell types.  It is found on the Insert tab 
of the ribbon, as well as the toolbar for the report and cell type. 

Once the tool is selected, click and drag on the report or cell type to create an arrow 
object.  Double-click the object to edit its properties. 

Arrow properties are the same as Line properties. 
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Rectangle 

  

 

  

This tool allows you to create rectangles on the report or cell types.  It is found on the Insert 
tab of the ribbon, as well as the toolbar for the report and cell type. 

Once the tool is selected, click and drag on the report or cell type to create a rectangle 
object.  Double-click the object to edit its properties. 

  

Rectangle and Ellipse Properties 

  

 

  

Shape 

Type of shape: Rectangle or Ellipse 

Fill color 

Color of the fill 

Fill style 

Style of the fill 
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Transparency 

Amount of transparency (0 to 100) 

Pen color 

Color of the outline 

Pen style 

Style of the outline 

Pen width 

Width of the outline in pixels 

Rotation Angle 

Rotation angle (-360.0 to 360.0 degrees) 
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Ellipse 

  

 

  

This tool allows you to create ellipse on the report or cell types.  It is found on the Insert tab 
of the ribbon, as well as the toolbar for the report and cell type. 

Once the tool is selected, click and drag on the report or cell type to create an ellipse 
object.  Double-click the object to edit its properties. 

The properties for the ellipse are the same as the Rectangle properties. 
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1P Graph 

1P Graph 

  

 

  

This tool allows you to create a 1P graph on the report or cell types.  It is found on the Insert 
tab of the ribbon, as well as the toolbar for the report and cell type. 

Once the tool is selected, click and drag on the report or cell type to create the 
object.  Double-click the object to edit its properties. 

The 1P graph displays a histogram for a selected measurement.  
  

 
  

The name of the cell type is displayed at the top of the plot.  

Click the X-axis label to select a different measurement; a menu of choices will be displayed. 

Tools to manipulate the plot appear on the right edge of the plot window when the mouse is 
over the plot. See 1P Graphics toolbar for a description of each tool. 

  

Context menu 

The context menu can be displayed by right-clicking on the object. 

  

Edit Graphics 
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Displays the Graphic Options for 1P Graphs dialog. 

  

Edit Frame 

Displays the Edit Frame dialog. 

  

Show Unclassified 

Toggles showing/not showing the unclassified events in the plot 

  

Copy 

Copies the object to the clipboard. 

  

Save 

Displays the standard Save dialog to save the graphic object to disk. 
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1P Graph 

  

 

  

This tool allows you to create a 1P graph on the report or cell types.  It is found on the Insert 
tab of the ribbon, as well as the toolbar for the report and cell type. 

Once the tool is selected, click and drag on the report or cell type to create the 
object.  Double-click the object to edit its properties. 

The 1P graph displays a histogram for a selected measurement.  
  

 
  

The name of the cell type is displayed at the top of the plot.  

Click the X-axis label to select a different measurement; a menu of choices will be displayed. 

Tools to manipulate the plot appear on the right edge of the plot window when the mouse is 
over the plot. See 1P Graphics toolbar for a description of each tool. 

  

Context menu 

The context menu can be displayed by right-clicking on the object. 

  

Edit Graphics 

Displays the Graphic Options for 1P Graphs dialog. 
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Edit Frame 

Displays the Edit Frame dialog. 

  

Show Unclassified 

Toggles showing/not showing the unclassified events in the plot 

  

Copy 

Copies the object to the clipboard. 

  

Save 

Displays the standard Save dialog to save the graphic object to disk. 
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Graphic Options for 1P Graphs 

  

General Options tab 

Background, Grids, and Colors 

Background Color 

Choose a color for the background of the plot. 

X Grid Lines 

Enable this option to show grids for the X-axis. Grid lines will appear for each major tic on 
the axis. 

Y Grid Lines 

Enable this option to show grids for the Y-axis. Grid lines will appear for each major tic on 
the axis. 

Grid Line Width 

Enter a value for the width of the grid lines. The default, 0, creates the narrowest possible 
line that the screen (or printer) can draw. 

Grid Line Style 

Choose a line style for grid lines. 

Grid Color 

Choose a color for grid lines. 

Grids On Top 

Enable this option to draw grids on top of the other graphics in the plot. When the option is 
unchecked, grids are drawn behind the other graphics. 

  

Selection 

Choose Populations 
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This option provides a quick way to select other cell types to overlay on this 1P graph.  A 
dialog is displayed with a list of cell types, which can be enabled and disabled for the graph. 

  

Graphics 

Resolution 

Enter the resolution for this histogram. 

X Auto Zoom 

When enabled, the x axis is zoomed to eliminate empty channels on the low and high ends of 
the plot. 

Fill Style 

Choose a fill style for the plot. 

Transparency 

Enter a transparency setting for the plot, where 0.00 is opaque and 100.00 is completely 
transparent. 

Scale Plots 

When enabled, all plots are scaled so that their highest values are full scale. 

Smooth Plots 

When enabled, all plots are smoothed. 

  

Staining Assessment 

Staining Assessment 

When enabled, staining assessment information is displayed on the 1P graph, comparing the 
measurement in the selected cell type with the first overlaid cell type. 

Positive Color 

Select a color for the positive population in the stain assessment plot. 

Negative Color 

Select a color for the negative population in the stain assessment plot. 



Reference 

240 

  

Peaks and Projections 

Peak Triangles 

Enable to show peak locations on the plot. 

Peak Polygons 

Enable to show peak polygons on the plot. 

Model Projections 

Enable to show model projections on the plot. 

Smoothed Data Projections 

Enable to show data projections on the plot. 

  

Other Tabs 

A tab is show for each Stage defined in the current cell type, as well as for each of the other 
cell types.  These can be co-plotted on the plot. 

  

Enable 

Check this box to include the population on the plot. 

Customize Properties 

Customize 

Enable this to customize fill and transparency for the object 

Fill Style 

Choose a fill for the population 

Transparency 

Choose a transparency for the population.   
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Animation 

Enable 

When this option is enabled and the Animate property is enabled for the cell type, this 1P 
graph will display animation cursors. 

Animation Source 

When Animation is enabled, it can position its cursors based on either Mean Data or Model 
Data. Mean Data uses the mean for the classified events at each state index. Model Data 
uses the model position based on Control Points at each state index. 

Color 

Choose a color for the animation cursors. 

Line Width 

Choose a line width for the animation cursors. 
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Edit Frame 

  

This command edits properties of the object's frame. 

  

 

  

Save Image  

Flag to Save 

Check to flag this object for saving its image when the file is analyzed.  

Subfolder 

Type in the subfolder name to store its image. Must be created in the canvas image folder. 

  

Position and Size  

X Position 

Enter the x position in inches. 
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Y Position 

Enter the y position in inches. 

X Size 

Enter the x size in inches. 

Y Size 

Enter the y size in inches.  

  

Other 

Show Title 

Show the title of the object. 

Title Font 

Font of the title 

Outline Color 

Color of the object's border 

Outline Width 

Line with of the object's border(-1 to 20). A value of -1 turns off the border. 

Cell Type 

For objects that are associated with a specific cell type, this property shows the cell type. 

Name 

This is the internal name of the object that cannot be edited.  It is used to uniquely identify 
the object. 

  

Actions 

OK 

Click this button to accept the changes and close the dialog box. 
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Cancel 

Click this button to discard any changes and close the dialog box. 

Reset 

Click this button to reset the object's properties to default values. 
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1P Graphics toolbar 

  

The 1P Graphics toolbar is located on the right side of each 1P histogram object and is 
displayed when the mouse moves over the object. It provides tools useful for working with 
the object. 
  

 

Selection Use this tool to select, move, and size objects in the object. 

 

Zoom Use this tool to define the portion of the object to zoom-in on. 
Click and drag to surround the area that you want to zoom. 

 

Cancel 
zoom 

Click this tool to cancel out of zoom and return to normal viewing. 

 

Edit 
Graphics 

Edits the graphics settings for this object. 

 

Create 1p 
Region 

Use this tool to define a 1P region on the histogram. The region 
can be used for gating or to color unclassified events. 
After selecting this tool, click and drag on the histogram to define 
the region. 

 

Rectangle Use this tool to create a rectangle object on the histogram. 

 

Label Use this tool to create text on the histogram. 

 

 

Flag to 
Save 
Graphic 

Check this option to save the graphic after analysis. 

 

View in 
dialog 

Click this tool to view the object in a dialog window.  
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2P Graph 

2P Graph 

  

 

  

This tool allows you to create a 2P graph on the report or cell types.  It is found on the Insert 
tab of the ribbon, as well as the toolbar for the report and cell type. 

Once the tool is selected, click and drag on the report or cell type to create the 
object.  Double-click the object to edit its properties. 

  

The 2P Graph displays a correlated plot for two parameters.  
  

 
  

The X-axis of the plot shows intensity of a selected measurement, and the Y-axis shows the 
intensity of another.  

Click the axis label to select a different measurement; a menu of choices will be displayed. 

Tools to manipulate the plot appear on the right edge of the plot window when the mouse is 
over the plot. See 2P Graphics toolbar for a description of each tool. 

  

Context menu 

The context menu can be displayed by right-clicking on the object. 
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Edit Graphics 

Displays the Graphic Options for 2P Graphs dialog. 

  

Edit Frame 

Displays the Edit Frame dialog. 

  

Auto Zoom 

When enabled, the plot is zoomed to exclude empty channels. 

  

Show Unclassified 

Toggles showing/not showing the unclassified events in the plot. 

  

Show State Vectors 

Toggles showing/not showing the state vectors in the plot. 

  

Show Surface 

Toggles showing/not showing a surface plot. 

  

Copy 

Copies the object to the clipboard. 

  

Save 

Displays the standard Save dialog to save the graphic object to disk. 
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2P Graph 

  

 

  

This tool allows you to create a 2P graph on the report or cell types.  It is found on the Insert 
tab of the ribbon, as well as the toolbar for the report and cell type. 

Once the tool is selected, click and drag on the report or cell type to create the 
object.  Double-click the object to edit its properties. 

  

The 2P Graph displays a correlated plot for two parameters.  
  

 
  

The X-axis of the plot shows intensity of a selected measurement, and the Y-axis shows the 
intensity of another.  

Click the axis label to select a different measurement; a menu of choices will be displayed. 

Tools to manipulate the plot appear on the right edge of the plot window when the mouse is 
over the plot. See 2P Graphics toolbar for a description of each tool. 

  

Context menu 

The context menu can be displayed by right-clicking on the object. 

  

Edit Graphics 
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Displays the Graphic Options for 2P Graphs dialog. 

  

Edit Frame 

Displays the Edit Frame dialog. 

  

Auto Zoom 

When enabled, the plot is zoomed to exclude empty channels. 

  

Show Unclassified 

Toggles showing/not showing the unclassified events in the plot. 

  

Show State Vectors 

Toggles showing/not showing the state vectors in the plot. 

  

Show Surface 

Toggles showing/not showing a surface plot. 

  

Copy 

Copies the object to the clipboard. 

  

Save 

Displays the standard Save dialog to save the graphic object to disk. 
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Other Options for 2P Graphs 

  

General Options tab 

Background, Grids, and Colors 

Background Color 

Choose a color for the background of the plot. 

X Grid Lines 

Enable this option to show grids for the X-axis. Grid lines will appear for each major tic on 
the axis. 

Y Grid Lines 

Enable this option to show grids for the Y-axis. Grid lines will appear for each major tic on 
the axis. 

Grid Line Width 

Enter a value for the width of the grid lines. The default, 0, creates the narrowest possible 
line that the screen (or printer) can draw. 

Grid Line Style 

Choose a line style for grid lines. 

Grid Color 

Choose a color for grid lines. 

Grids On Top 

Enable this option to draw grids on top of the other graphics in the plot. When the option is 
unchecked, grids are drawn behind the other graphics. 
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Graphic Options for 2P Surface 

  

This set of properties appears on the Surface tab in the dialog used for editing a 2P graph. 
You can view and edit these properties by double-clicking a plot or by right-clicking and 
choosing Edit Graphics. 

Surface graphics offer a smooth, color transition that helps visualize the density of events, 
similar to color density or color gradient plots. 
  

Enable 

Check to enable surface graphics. 

Mixing Color 

Choose the color to mix with the stage color to show cumulative probability. 
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Graphic Options for 2P Dots 

  

This set of properties appears on the "Dots" tab in the dialog used for editing a 2P graph. 
You can view and edit these properties by double-clicking a plot or by right-clicking and 
choosing "Edit Graphics". 
  

Enable  

Check this option to display dots and other graphics from this tab.  

Auto Size 

Enable this option to allow the program to determine the best dot size, based on the current 
size of the plot and other factors. 

Dot Size 

This field displays the current size of dots in points; a point is 1/72 inches. To set a specific 
size for the dots, uncheck the Auto Dot Size option and enter a value between 0.0 and 10.0 
for Dot Size. 

Show All Dots 

Enable this option to display dots for all events. If this option is unchecked, the system will 
use the value in Desired Dot Number. 

Number 

If Show All Dots is unchecked, the system will use the value in Desired Dot Number to 
determine the number of dots to display in the plot. 

Maximum Number 

This field sets a limit on the number of dots that will be drawn. 

Auto Zoom 

When enabled, the each axis is zoomed to eliminate empty channels on the low and high 
ends of the plot. 

Surface Outliers 

This value controls how dots are included for display in the plot. Enter 1.0 to include all dots. 
Enter 0.05 to include only the outermost 5% of dots.  
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Heat Map 

When enabled, dots are colored to form a heat map of intensity. 

  

Other Populations 

Cell Types 

This option allows dots from other cell types to be display in the plot. 

Unclassified 

Enable this option to display dots for unclassified events. 
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Graphic Options for 2P Vectors 

  

This set of properties appears on the "State Vectors" tab in the dialog used for editing a 2P 
Graph. You can view and edit these properties by double-clicking a plot or by right-clicking 
and choosing "Edit Graphics". 

State Vector arrows allow you to track the progression information in the context of two, 
correlated measurements. Each arrow represents the same number of states in the 
progression, so the length of arrows give an impression of the relative speed of transitions. 
Longer arrows indicate more rapid state transitions; shorter arrows suggest that there is not 
much change occurring. 
  

Enable 

Check this option to display arrows showing the state progression in the 2P histogram. 

Number 

Enter the number of state vectors to display. 

Source 

Choose "Mean Data" to position the state vectors based on the mean of the classified events. 
Choose "Model Data" to position the vectors based on the model positions. 

Mode 

Arrows can be drawn based on number of events or by stage boundaries. 

Outline Color 

Choose the color for the border of the vectors. 

Line Width 

Enter the line width to use for the perimeter of the arrow. 

Head Height 

Enter the height of the arrow head. 

Shaft Height 

Enter the width of the arrow. 

Head Proportion 



GemStone User Guide 

255 

Enter the proportion of the arrow head height to head width. Values greater than 1.0 
produce elongated arrow heads. 

Angle Indent 

This value controls the angle for the base of the arrow head. Enter 0.0 for a square base. 

Other Populations 

This value determines whether vectors from other cell types will be drawn on this plot. 
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2P Animation 

  

This set of properties appears on the Animation tab in the dialog used for editing 2P Graphs. 
You can view and edit these properties by double-clicking a plot or by right-clicking and 
choosing "Edit Graphics". 

When Animation is enabled for the cell type and for this 2P plot, the State Vector arrows will 
also animate. 
  

Enable 

Check this option to enable animation for this 2P histogram. When this option is enabled 
animation is turned on, this 2P histogram will display animation vectors. 

  

Cell Type Animation 

Animation Data Source 

Choose "Mean Data" to position the state vectors based on the mean of the classified events. 
Choose "Model Data" to position the vectors based on the model positions. 

Color 

Choose the fill color for the vectors. 

Outline Color 

Choose the color for the border of the vectors. 

Line Width 

Enter the line width to use for the perimeter of the arrow. 

Head Height 

Enter the height of the arrow head. 

Shaft Width 

Enter the width of the arrow. 

Head Proportion 
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Enter the proportion of the arrow head height to head width. Values greater than 1.0 
produce elongated arrow heads. 

Angle Indent 

This value controls the angle for the base of the arrow head. Enter 0.0 for a square base. 

  

Region Animations 

Dot Size 

Sets the size of dots during region animation. 

Number 

Sets the maximum number of dots during region animation 
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Edit Frame 

  

This command edits properties of the object's frame. 

  

 

  

Save Image  

Flag to Save 

Check to flag this object for saving its image when the file is analyzed.  

Subfolder 

Type in the subfolder name to store its image. Must be created in the canvas image folder. 

  

Position and Size  

X Position 

Enter the x position in inches. 
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Y Position 

Enter the y position in inches. 

X Size 

Enter the x size in inches. 

Y Size 

Enter the y size in inches.  

  

Other 

Show Title 

Show the title of the object. 

Title Font 

Font of the title 

Outline Color 

Color of the object's border 

Outline Width 

Line with of the object's border(-1 to 20). A value of -1 turns off the border. 

Cell Type 

For objects that are associated with a specific cell type, this property shows the cell type. 

Name 

This is the internal name of the object that cannot be edited.  It is used to uniquely identify 
the object. 

  

Actions 

OK 

Click this button to accept the changes and close the dialog box. 
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Cancel 

Click this button to discard any changes and close the dialog box. 

Reset 

Click this button to reset the object's properties to default values. 
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2P Graphics toolbar 

  

The 2P Graphics toolbar is located on the right side of each 2P histogram object and is 
displayed when the mouse moves over the object. It provides tools useful for working with 
the object. 
  

 

Selection Use this tool to select, move, and size objects in the object. 

 

Zoom Use this tool to define the portion of the object to zoom-in on. 
Click and drag to surround the area that you want to zoom. 

 

Cancel 
zoom 

Click this tool to cancel out of zoom and return to normal viewing. 

 

Edit 
Graphics 

Edits the graphics settings for this object. 

 

Swap 
axes 

Click this tool to reverse the measurements on the X- and Y- axes. 

 

Polygon 
Region 

Use this tool to define a free-hand region on the histogram. The 
region can be used for gating or to color unclassified events. 
After selecting this tool, click and drag on the histogram to define 
the region. 

 

Rectangle 
Region 

Use this tool to define a rectangular region on the histogram. The 
region can be used for gating or to color unclassified events. 
After selecting this tool, click and drag on the histogram to define 
the region. 

 

Ellipse 
Region 

Use this tool to define an elliptical region on the histogram. The 
region can be used for gating or to color unclassified events. 
After selecting this tool, click and drag on the histogram to define 
the region. 

 

Extruded 
circle 
Region 

Use this tool to define a bike-chain region on the histogram. The 
shape of this region resembles the chain of a bicycle, with one end 
larger and the other smaller. The region can be used for gating or 
to color unclassified events. 
After selecting this tool, click and drag on the histogram to define 
the region. 

 

 

Flag to 
Save 
Graphic 

Check this option to save the graphic after analysis. 

 

View in 
dialog 

Click this tool to view the object in a dialog window.  
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Expression Profile Plot 

Expression Profile Plot 

  

 

  

This tool allows you to create an expression profile plot on the report or cell types.  It is 
found on the Insert tab of the ribbon, as well as the toolbar for the report and cell type. 

Once the tool is selected, click and drag on the report or cell type to create the 
object.  Double-click the object to edit its properties. 

Expression profile plots are also contained in the Cell Type Widget and have additional 
properties in that case. The Cell Type Widget is only visible in Develop mode.  

  

 

  

The X-axis of the plot shows state or progression of a selected measurement, and the Y-axis 
shows the intensity.  

Click the axis label to select a different measurement; a menu of choices will be displayed. 

Tools to manipulate the plot appear on the right edge of the plot window when the mouse is 
over the plot. See Expression Profile toolbar for a description of each tool. 

  

Context menu 

The context menu can be displayed by right-clicking on the object. 

  

Edit Graphics 
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Displays the Edit Graphic Options dialog. 

  

Edit Frame 

Displays the Edit Frame dialog. 

  

Show Unclassified 

Toggles showing/not showing the unclassified events in the plot. 

  

Copy 

Copies the object to the clipboard. 

  

Save 

Displays the standard Save dialog to save the graphic object to disk. 
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Expression Profile Plot 

  

 

  

This tool allows you to create an expression profile plot on the report or cell types.  It is 
found on the Insert tab of the ribbon, as well as the toolbar for the report and cell type. 

Once the tool is selected, click and drag on the report or cell type to create the 
object.  Double-click the object to edit its properties. 

Expression profile plots are also contained in the Cell Type Widget and have additional 
properties in that case. The Cell Type Widget is only visible in Develop mode.  

  

 

  

The X-axis of the plot shows state or progression of a selected measurement, and the Y-axis 
shows the intensity.  

Click the axis label to select a different measurement; a menu of choices will be displayed. 

Tools to manipulate the plot appear on the right edge of the plot window when the mouse is 
over the plot. See Expression Profile toolbar for a description of each tool. 

  

Context menu 

The context menu can be displayed by right-clicking on the object. 

  

Edit Graphics 

Displays the Edit Graphic Options dialog. 
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Edit Frame 

Displays the Edit Frame dialog. 

  

Show Unclassified 

Toggles showing/not showing the unclassified events in the plot. 

  

Copy 

Copies the object to the clipboard. 

  

Save 

Displays the standard Save dialog to save the graphic object to disk. 
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Graphic Options for EP Plots 

  

General tab 

Background, Grids, and Colors 

Background Color 

Choose a color for the background of the plot. 

X Grid Lines 

Enable this option to show grids for the X-axis. Grid lines will appear for each major tic on 
the axis. 

Y Grid Lines 

Enable this option to show grids for the Y-axis. Grid lines will appear for each major tic on 
the axis. 

Grid Line Width 

Enter a value for the width of the grid lines. The default, 0, creates the narrowest possible 
line that the screen (or printer) can draw. 

Grid Line Style 

Choose a line style for grid lines. 

Grid Color 

Choose a color for grid lines. 

Grids On Top 

Enable this option to draw grids on top of the other graphics in the plot. When the option is 
unchecked, grids are drawn behind the other graphics. 
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Graphic Options for EP Surface 

  

This tab is part of the Edit Graphic Options for Expression Profiles. It configures the display of 
the Surface plot. 
  

Enable 

Check this option to display the surface graphics. 

Mixing Color 

Choose a color that will be used to for the densest portions of the surface plot (the highest 
probability). The default color is white. 

Surface Mode 

Choose between Smoothed Frequency and Model Probability modes. 
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Graphic Options for EP Dots 

  

This tab is part of the Edit Graphic Options for Expression Profiles. It configures the display of 
dots. 
  

Enable Dots 

Check this option to display dots on the plot. (The plot can display other kinds of graphics, 
which are selected on other tabs in this dialog.) 

Auto Dot Size 

Enable this option to allow the program to determine the best dot size, based on the current 
size of the object and other factors. 

Dot Size 

This field displays the current size of dots in points; a point is 1/72 inches. To set a specific 
size for the dots, uncheck the Auto Dot Size option and enter a value between 0.0 and 5.0 
for Dot Size. 

Show All Dots 

Enable this option to display dots for all events. If this option is unchecked, the system will 
use the value in Desired Dot Number. 

Number 

If Show All Dots is unchecked, the system will use the value in Desired Dot Number to 
determine the number of dots to display in the plot. 

Maximum Dot Number 

This field sets a limit on the number of dots that will be drawn. 

Auto Zoom 

When enabled, the each axis is zoomed to eliminate empty channels on the low and high 
ends of the plot. 

Surface Outliers 

This value controls how dots are included for display in the plot. Enter 1.0 to include all dots. 
Enter 0.05 to include only the outermost 5% of dots.  
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Heat Map 

When enabled, dots are colored as a probability heat map. 

  

Other Dots 

Cell Types 

This option allows dots from one or all other cell types to be display in the plot. 

Unclassified  

Enable this option to display dots for unclassified events. 
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Graphic Options for EP Means 

  

This tab is part of the Edit Graphic Options for Parameter Profiles. It configures the display of 
means of the classified events. 
  

Enable 

Check this option to display a line plotting the mean of classified events in the Parameter 
Profile. 

Data Source 

Choose the source of the data for drawing.  Choices include Mean Data, Median Data, Peak 
Data, or Peak or Mean.  

Line Width 

This option controls the thickness of the line used to plot the mean. Enter a value from 0 to 
10 inclusive. 

Line Style 

Choose a line style for the mean line. 

Show Peaks 

Shows the filtered peaks as triangles on the right edge of the plot. 

Show All Peaks 

Shows all peaks, including filtered peaks, on the right edge of the plot. 
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Graphic Options for EP Confidence Limits 

  

This tab is part of the Edit Graphic Options for Expression Profiles. It configures the display of 
confidence limits for the classified events. 
  

Enable 

Check this option to display confidence limit lines on the Parameter Profile plot. 

Mode 

Choose a method for visualizing line spread. 
  

Mode Options   

Model SD Bars Displays the standard deviation bars at each Control Point. 

 

Model SD Envelope Displays the standard deviation of the model as an envelope. 

 

Observed SD 
Envelope 

Similar to Model SD Envelope, except that the standard 
deviation of the actual data values is used. 

 

SD Bars and 
Observed Envelope 

Displays the Model SD bars and the Observed Envelope. 

 
  

Number of SDs 

This option controls the number of standard deviations (SDs) used for the display. The 
default value is 1.96, equivalent to 95% confidence limits. 

Line Width 

This option controls the thickness of the line. Enter a value from 0 to 10 inclusive. 

Line Style 
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Choose a line style for the line. 

Color 

Choose a color for the line. 

Peak Tracks 

Shows detected peaks as rectangles. 

Low, Normal, High Regions 

Shows all low, normal, and high regions in the data 

Peak Search Range 

Shows peak search range for the expression profile measurement. 
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Graphic Options for EP Model 

  

This tab is part of the Edit Graphic Options for Expression Profiles. It configures the display of 
a line that connects each Control Point in the selected Expression Profile. 

Enable 

Check this option to display the model line on the Parameter Profile plot. 

Color 

Choose a color for the model drawing. 

CDPs 

Enable this option to show the control definition points of the related Expression Profile plot 
in the Cell Type widget. 

Stage Labels 

Enable this option to display stage labels at the top of the plot area. 

Stage Label Font 

Choose a font for the stage labels. 

Line Width 

This option controls the thickness of the line. Enter a value from 0 to 10 inclusive. 

Line Style 

Choose a line style for the line. 
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EP Animation Options 

  

This tab is part of the Edit Graphic Options for Expression Profiles.  

The Expression Profile plot can display additional information when animation is enabled in 
the Cell Type Properties panel. When Cell Type animation is enabled, the plot will display two 
vertical cursors that move along the progression axis. 
  

Enable 

Check this option to enable animation for the Parameter Profile plot. 

Line Width 

This option controls the thickness of the line. Enter a value from 0 to 10 inclusive. 

Line Style 

Choose a line style for the line. 

Color 

Choose a color for the line. 

Animation Source 

When Animation is enabled, it can position its cursors based on either Mean Data or Model 
Data. Mean Data uses the mean for the classified events at each state index. Model Data 
uses the model position based on Control Points at each state index. 

  

Region  

Dot Size 

Sets the size of dots during region animation. 

Number 

Sets the maximum number of dots during region animation 
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Edit Frame 

  

This command edits properties of the object's frame. 

  

 

  

Save Image  

Flag to Save 

Check to flag this object for saving its image when the file is analyzed.  

Subfolder 

Type in the subfolder name to store its image. Must be created in the canvas image folder. 

  

Position and Size  

X Position 

Enter the x position in inches. 
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Y Position 

Enter the y position in inches. 

X Size 

Enter the x size in inches. 

Y Size 

Enter the y size in inches.  

  

Other 

Show Title 

Show the title of the object. 

Title Font 

Font of the title 

Outline Color 

Color of the object's border 

Outline Width 

Line with of the object's border(-1 to 20). A value of -1 turns off the border. 

Cell Type 

For objects that are associated with a specific cell type, this property shows the cell type. 

Name 

This is the internal name of the object that cannot be edited.  It is used to uniquely identify 
the object. 

  

Actions 

OK 

Click this button to accept the changes and close the dialog box. 
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Cancel 

Click this button to discard any changes and close the dialog box. 

Reset 

Click this button to reset the object's properties to default values. 
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Expression Profile Plot Toolbar 

  

The Expression Profile Plot toolbar is located on the right side of an Expression Profile Plot on 
the report and is displayed when the mouse moves over the object.  
  

 

Selection Use this tool to select, move, and size objects in the 
object. 

 

Zoom Use this tool to define a portion of the object to zoom-in 
on. 
Click and drag to surround the area that you want to 
zoom. 

 

Cancel zoom Click this tool to cancel out of zoom and return to normal 
viewing. 

 

Edit Graphics Edits the graphics settings for this object. 

 

Polygon Region Use this tool to define a free-hand region on the plot. The 
region can be used for gating or to color unclassified 
events. 
After selecting this tool, click and drag on the histogram to 
define the region. 

 

Rectangle 
Region 

Use this tool to define a rectangular region on the plot. 
The region can be used for gating or to color unclassified 
events. 
After selecting this tool, click and drag on the histogram to 
define the region. 

 

Ellipse Region Use this tool to define an elliptical region on the plot. The 
region can be used for gating or to color unclassified 
events. 
After selecting this tool, click and drag on the histogram to 
define the region. 

 

 

Flag to Save 
Graphic 

Check this option to save the graphic after analysis. 

 

View in dialog Click this tool to view the object in a dialog window.  
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Overlay Plot 

Overlay Plot 

  

 

  

This tool allows you to create an overlay plot on the report or cell types.  It is found on the 
Insert tab of the ribbon, as well as the toolbar for the report and cell type. 

Once the tool is selected, click and drag on the report or cell type to create the 
object.  Double-click the object to edit its properties. 

  

The Overlay plot displays the modeled progression for all measurements in a cell type 
simultaneously. 
  

 
  

The X-axis of the plot shows state or progression of a selected measurement, and the Y-axis 
shows relative intensity of the measurements in the plot.  

If stages have been defined, they are displayed along the top edge of the ribbon display 
area. 

Each measurement appears as a "ribbon" in the plot, with text labels identifying the 
measurement name. The color for each ribbon is determined by the Color property in the 
Expression Profile Properties panel. 
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Tools to manipulate the plot appear on the right edge of the plot window when the mouse is 
over the plot.  

  

Context menu 

The context menu can be displayed by right-clicking on the object. 

  

Edit Graphics 

Displays the Graphic Options for Overlays Plot dialog. 

  

Edit Frame 

Displays the Edit Frame dialog. 

  

Copy 

Copies the object to the clipboard. 

  

Save 

Displays the standard Save dialog to save the graphic object to disk. 

  

Modeled Measurements Only 

Enable this option to show only the modeled measurements - those with expression profiles - 
in the overlay plot. 

  

Separate EPs 

The command separates the expression profile ribbons to maximize the space on the overlay 
plot. 

  

Reset EP separation 

The command resets the separation performed with the Separate EPs command. 
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Overlay Plot 

  

 

  

This tool allows you to create an overlay plot on the report or cell types.  It is found on the 
Insert tab of the ribbon, as well as the toolbar for the report and cell type. 

Once the tool is selected, click and drag on the report or cell type to create the 
object.  Double-click the object to edit its properties. 

  

The Overlay plot displays the modeled progression for all measurements in a cell type 
simultaneously. 
  

 
  

The X-axis of the plot shows state or progression of a selected measurement, and the Y-axis 
shows relative intensity of the measurements in the plot.  

If stages have been defined, they are displayed along the top edge of the ribbon display 
area. 

Each measurement appears as a "ribbon" in the plot, with text labels identifying the 
measurement name. The color for each ribbon is determined by the Color property in the 
Expression Profile Properties panel. 
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Tools to manipulate the plot appear on the right edge of the plot window when the mouse is 
over the plot.  

  

Context menu 

The context menu can be displayed by right-clicking on the object. 

  

Edit Graphics 

Displays the Graphic Options for Overlays Plot dialog. 

  

Edit Frame 

Displays the Edit Frame dialog. 

  

Copy 

Copies the object to the clipboard. 

  

Save 

Displays the standard Save dialog to save the graphic object to disk. 

  

Modeled Measurements Only 

Enable this option to show only the modeled measurements - those with expression profiles - 
in the overlay plot. 

  

Separate EPs 

The command separates the expression profile ribbons to maximize the space on the overlay 
plot. 

  

Reset EP separation 

The command resets the separation performed with the Separate EPs command. 
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Graphic Options for Overlays Plot 

  

Background, Grids, and Colors 

Background Color 

Choose a color for the background of the Overlay plot. 

X Grid Lines 

Enable this option to show grids for the X-axis. Grid lines will appear for each major tic on 
the axis. 

Y Grid Lines 

Enable this option to show grids for the Y-axis. Grid lines will appear for each major tic on 
the axis. 

Grid Line Width 

Enter a value for the width of the grid lines. The default, 0, creates the narrowest possible 
line that the screen (or printer) can draw. 

Grid Line Style 

Choose a line style for grid lines. 

Grid Color 

Choose a color for grid lines. 

Grids On Top 

Enable this option to draw grids on top of the profile ribbons. When the option is unchecked, 
grids are drawn behind the ribbons. 

  

Measurements 

Choose Measurements 

Displays a dialog to select which measurements to include on the overlay plot. 
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Labeling 

Type 

Choose an option for labeling the parameter ribbons on the overlay plot. 

Option Description 

Wire Labeling Labels follow the ribbon. 

Stage Labeling One label appears for each 
ribbon in each stage. 

Default Width Factor 

This value controls the width of the profile ribbons in the overlay plot. The value represents 
the number of standard deviations from center of the ribbon. The default value is 0.10 SDs. 

Font 

Choose a font to use for the labels on the parameter profile ribbons. 

  
  

Ribbons 

Data Type 

Option Description 

Model +/- SD The parameter ribbon is based on the model's Y-axis position at 
each state in the progression. This value approximately matches 
the Control Point locations for the Parameter Profile of each 
parameter, with interpolation between control points. 

The width of the ribbon is controlled by the Number of SDs 
property. 

Mean +/- SD The parameter ribbon is based on the mean intensity of the data 
at each state in the progression. 

The width of the ribbon is controlled by the Number of SDs 
property. 

  

Modeled Measurements Only 

Enable this option to show only the modeled measurements - those with expression profiles - 
in the overlay plot. 
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Transparency 

Enter a value between 0.0 and 100.0 to control the transparency of the parameter profile 
ribbons. Higher values make the ribbons more transparent. 

Drop Shadow 

Enable this option to display a drop shadow under each parameter profile ribbon in the 
overlay plot. 

Show Stages 

Enable this option to display stages at the top of the overlay plot. 

Show Stage Boundaries 

Enable this option to display "grid lines" for the stage boundaries. Note, "Show Stages" must 
be enabled for this option to function. 

Auto Zoom 

Enable this option zoom to eliminate unused space at the top and bottom of the plot. 

  

Statistics 

Show Stage Percents 

Choose an option for showing percentages of stages on the overlay. 

Decimals for Percents 

Set the number of decimal places for percentages. 

  

Animation 

The Overlay Plot can animate the process of drawing the parameter profile ribbons. The 
settings below control that animation. 

Seconds 

This option controls the number of seconds each parameter profile ribbon is displayed when 
animation is enabled in the overlay plot. Animation is turned on and off using tools in the 
Overlay Graphics toolbar. 

One at a Time 
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With this option enabled, each parameter ribbon is displayed by itself during animation. If 
this option is unchecked, each ribbon remains on the plot until all ribbons have been drawn. 
Then the plot is cleared and drawing starts again. 
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Graphic Options for Measurements 

  

Each measurement in an Overlay Plot has graphic options that determine how it appears. 
One tab is displayed for each measurement in the cell type. 
  

Show  

Enable this option to include the measurement in the Overlay Plot. This does not affect 
whether or not the parameter is included in the modeling process. 

Line Style 

Select a style for the line that borders the parameter ribbon in the Overlay Plot. 

Fill Style 

Select a style for the fill used for drawing the parameter ribbon in the Overlay Plot. 

Width Factor 

Choose the width factor to apply to the ribbon.  0: Use default. >0 Override default. 1.0 
normally is the 95% confidence limits.  

Color 

This property determines the color used for this parameter.  

Plot Offset 

Sets an offset for the ribbon.  
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Edit Frame 

  

This command edits properties of the object's frame. 

  

 

  

Save Image  

Flag to Save 

Check to flag this object for saving its image when the file is analyzed.  

Subfolder 

Type in the subfolder name to store its image. Must be created in the canvas image folder. 

  

Position and Size  

X Position 

Enter the x position in inches. 
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Y Position 

Enter the y position in inches. 

X Size 

Enter the x size in inches. 

Y Size 

Enter the y size in inches.  

  

Other 

Show Title 

Show the title of the object. 

Title Font 

Font of the title 

Outline Color 

Color of the object's border 

Outline Width 

Line with of the object's border(-1 to 20). A value of -1 turns off the border. 

Cell Type 

For objects that are associated with a specific cell type, this property shows the cell type. 

Name 

This is the internal name of the object that cannot be edited.  It is used to uniquely identify 
the object. 

  

Actions 

OK 

Click this button to accept the changes and close the dialog box. 
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Cancel 

Click this button to discard any changes and close the dialog box. 

Reset 

Click this button to reset the object's properties to default values. 
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Overlay Plot toolbar 

  

The Overlay Plot toolbar is located on the right side of each parameter overlay object and is 
displayed when the mouse moves over the object. It provides tools useful for working with 
the object. 
  

 

Selection Use this tool to select, move, and size objects in the object. 

 

Zoom Use this tool to define the portion of the object to zoom-in 
on. 
Click and drag to surround the area that you want to zoom. 

 

Cancel 
zoom 

Click this tool to cancel out of zoom and return to normal 
viewing. 

 

Edit 
Graphics 

Edits the graphics settings for this object. 

 
Start 
  

 
Stop 

Animation Use this tool to turn animation on or off for the overlay 
graph. 
When animation is started, a parameter "ribbon" is shown 
for several seconds, and then it is hidden and the next is 
shown. This continues for each parameter, and the process 
repeats starting with the first parameter again. 
When animation is stopped, all parameter ribbons are 
shown at the same time. 

 
Pause 
  

 
Continue 

Pause or 
Continue 
Animation 

This tool only has an effect when Animation is on for the 
overlay graph. 
When the graph is animating, click the Pause button to 
pause an animation. 
When the graph is paused, click the Continue button to 
resume the animation. 

 

Text Click and drag to define an area for the text. 
A dialog will be displayed to input the text. 

 

Line Click and drag to define the end points of the line. 

 

Arrow Click and drag to define the end points of the arrow. 

 

Rectangle Click and drag to define the outline of the rectangle. 

 

Ellipse Click and drag to define the bounding rectangle for the 
ellipse. 

 

 

Flag to Save 
Graphic 

Check this option to save the graphic after analysis. 

 

View in 
dialog 

Click this tool to view the object in a dialog window.  
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Table 

Table 

  

 

  

Use this tool to create a table on the report or cell types.  It is found on the Insert tab of the 
ribbon, as well as the toolbar for the report and cell type. 

Once the tool is selected, click and drag on the report or cell type to create the object.   

  

Double-click the top of the object to edit its properties. 

  

The Table object is used to display analysis results and keywords on the report.  
  

 
  
A table has a user-defined number of rows and columns, which can be edited in the Edit 
Properties for Information Table dialog. 
The cells in a table can contain text and keywords. Keywords must be surrounded with 
square brackets to be interpreted as keywords and evaluated. 
  

Adding Text 

Text can be typed directly into a cell in the table. Simply click the mouse in a cell and type 
the text. Typical text editing keys can be used to delete, copy, and paste text. 
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Adding Keywords 

The easiest way to add keywords to the table is to select keywords from the list of available 
information. This is done by clicking the cell to enter Edit mode, and then right-clicking to 
display a menu of categories. Within the category sub-menus you will find all of the available 
keywords that can be included. 
  
  

 
  
The columns in the table will automatically size to fit the content.  You can also set the 
column width manually with the mouse. 
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Context menu 

There are 2 context menus for tables: the frame's context menu and the cell context menu. 

  

Frame Context menu:  

The context menu is displayed by right-clicking on the blank space above the table cells. 

  
Copy Copies the table to the clipboard. 
Save Image Saves the table as a graphic to disk. 
Edit Frame Edits the properties of the table. 
Bring to Front Brings the object to the front of other objects. 
Send to Back Sends the object behind other objects. 
Copy to page Copies the object to another page. 
Move to page Moves the object to another page. 
Delete Deletes the object. 
Flag to Save Check this option to save the image after auto analysis. 
Export Table Exports the table in tab-delimited format. 
Copy Formulas Copies the table's formulas to the clipboard. 

  

Cell Context menu:  

This menu is displayed when you right-click in a cell of the table. 

  
Insert Row Inserts a row above the cell's row. 
Insert Column Inserts a column to the left of the cell's column. 
Delete Row Deletes the row the cell is in. 
Delete Column Deletes the column the cell is in. 
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Table 

  

 

  

Use this tool to create a table on the report or cell types.  It is found on the Insert tab of the 
ribbon, as well as the toolbar for the report and cell type. 

Once the tool is selected, click and drag on the report or cell type to create the object.   

  

Double-click the top of the object to edit its properties. 

  

The Table object is used to display analysis results and keywords on the report.  
  

 
  
A table has a user-defined number of rows and columns, which can be edited in the Edit 
Properties for Information Table dialog. 
The cells in a table can contain text and keywords. Keywords must be surrounded with 
square brackets to be interpreted as keywords and evaluated. 
  

Adding Text 

Text can be typed directly into a cell in the table. Simply click the mouse in a cell and type 
the text. Typical text editing keys can be used to delete, copy, and paste text. 
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Adding Keywords 

The easiest way to add keywords to the table is to select keywords from the list of available 
information. This is done by clicking the cell to enter Edit mode, and then right-clicking to 
display a menu of categories. Within the category sub-menus you will find all of the available 
keywords that can be included. 
  
  

 
  
The columns in the table will automatically size to fit the content.  You can also set the 
column width manually with the mouse. 
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Context menu 

There are 2 context menus for tables: the frame's context menu and the cell context menu. 

  

Frame Context menu:  

The context menu is displayed by right-clicking on the blank space above the table cells. 

  
Copy Copies the table to the clipboard. 
Save Image Saves the table as a graphic to disk. 
Edit Frame Edits the properties of the table. 
Bring to Front Brings the object to the front of other objects. 
Send to Back Sends the object behind other objects. 
Copy to page Copies the object to another page. 
Move to page Moves the object to another page. 
Delete Deletes the object. 
Flag to Save Check this option to save the image after auto analysis. 
Export Table Exports the table in tab-delimited format. 
Copy Formulas Copies the table's formulas to the clipboard. 

  

Cell Context menu:  

This menu is displayed when you right-click in a cell of the table. 

  
Insert Row Inserts a row above the cell's row. 
Insert Column Inserts a column to the left of the cell's column. 
Delete Row Deletes the row the cell is in. 
Delete Column Deletes the column the cell is in. 
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Edit Properties for Information Table 

  

This command edits properties of the object's frame. 

  

 

  

Save Image  

Flag to Save 

Check to flag this object for saving its image when the file is analyzed.  

Subfolder 

Type in the subfolder name to store its image. Must be created in the canvas image folder. 
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Position and Size  

X Position 

Enter the x position in inches. 

Y Position 

Enter the y position in inches. 

X Size 

Enter the x size in inches. 

Y Size 

Enter the y size in inches.  

  

Other 

Show Title 

Show the title of the object. 

Title Font 

Font of the title 

Outline Color 

Color of the object's perimeter 

Outline Width 

Line with of the object's perimeter (-1 to 20). A value of -1 turns off the border. 

  

Rows and Columns 

Rows 

Enter the number of rows for this table. 

Columns 

Enter the number of columns for this table. 
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Font 

Font for the table. 

Decimals 

Specify the number of decimal places for numbers in the table. 

  

  

Actions 

OK 

Click this button to accept the changes and close the dialog box. 

Cancel 

Click this button to discard any changes and close the dialog box. 

Reset 

Click this button to reset the object's properties to default values. 
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EP Legend 

  

 

  

This tool allows you to create an expression profile legend on the report or cell types.  It is 
found on the Insert tab of the ribbon, as well as the toolbar for the report and cell type. 

Once the tool is selected, click and drag on the report or cell type to create the 
object.  Double-click the object to edit its properties. 

The expression profile legend is associated with a selected cell type when it is created.  The 
legend shows the color of each measurement used in the cell type, along with other useful 
information about the measurement. 
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Cell Type Legend 

  

 

  

This tool allows you to create a cell type legend on the report or cell types.  It is found on the 
Insert tab of the ribbon, as well as the toolbar for the report and cell type. 

Once the tool is selected, click and drag on the report or cell type to create the 
object.  Double-click the object to edit its properties. 

The cell type legend shows a list of all defined cell types in the model. The color, name, and 
other attributes of the cell type can be displayed. 
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Stage Table 

  

 

  

This tool allows you to create a stage statistics table on the report or cell types.  It is found 
on the Insert tab of the ribbon, as well as the toolbar for the report and cell type. 

Once the tool is selected, click and drag on the report or cell type to create the 
object.  Double-click the object to edit its properties. 

The stage table is associated with a selected cell type when it is created.  The table shows 
the name, color, and other useful information about the stages for the selected cell type. 

  

 
  
The Active column can be used to turn stages on and off quickly. When a stage is active, 
statistics are computed and stage-coloring is applied to dots. When inactive, a stage is 
ignored by the analysis routines. 
The Color for the stage is displayed and can be edited by clicking the color swatch. 

Several statistics are displayed for each stage: 

  

Percent The percentage of events relative to this cell type that are contained by the stage. 

%Total The percentage of events relative to all cell types that are contained by the stage. 

Events The number of events contained by the stage. 

Mean When statistics are turned on, this shows the mean intensity value of the stage 

SD When statistics are turned on, this shows the standard deviation of the stage. 
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TriCOM 

TriCOM 

  

This tool allows you to create a TriCOM on the report or cell types.  It is found on the Insert 
tab of the ribbon, as well as the toolbar for the report and cell type. 

 

  

Once the tool is selected, click and drag on the report or cell type to create the object. The 
TriCOM will be created with default properties and a default set of markers.  Double-click the 
object to edit its properties and select which markers to use with the TriCOM. 

Tools to manipulate the plot appear on the right edge of the plot window when the mouse is 
over the plot. 

  

 

  

The bottom of the TriCOM shows a legend of the markers that are being used.  In the 
example above, the markers are HLADR and CD38. A letter is assigned to each marker. A 
capital letter is shown with a solid color and represents the above-normal expression of the 
marker. A lower-case letter is shown with a hatched color and represents below-normal 
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expression of the marker.  In the example above, the letter A is assigned to HLADR and B is 
assigned to CD38.  

If the TriCOM is created for a cell type that has stages defined, the TriCOM will have a 
column for each stage.  In the example, there are 4 stages defined: T4nv, T4cm, T4em, and 
T4te.   

The rows of a TriCOM contain pie charts of expression.  The lowest row shows expression 
where only one of the markers is positive. The next row up shows 2 positive markers, and so 
on. In the example with two markers, there are two rows of expression pie charts: the first 
showing single-positive expression, and the second showing double-positives. 

See the tutorial Working with TriCOM for additional explanation and examples. 

  

Context menu 

There are 2 context menus for TriCOM objects: the frame's context menu and the TriCOM 
plot context menu.  

  

Frame context menu:  

The context menu is displayed by right-clicking on the title area. 

Copy 

Copies the object to the clipboard. 

Save Image 

Saves the object as a graphic to disk. 

Edit Frame 

Displays the Edit Frame dialog. 

Bring to Front 

Brings the object to the front of other objects. 

Send to Back 

Sends the object behind other objects. 

Delete 

Deletes the object. 



Reference 

308 

Flag to Save 

Check this option to save the graphic after auto analysis. 

  

  

TriCOM plot context menu:  

The context menu is displayed by right-clicking on the title area. 

Edit Graphics 

This command displays the Graphic Options for TriCOM dialog, used to select measurements 
for the TriCOM and adjust its display properties. 

Edit Segment 

This command allows you to edit the properties of the segment of the selected pie chart.   

Many properties are locked so that they cannot be edited.  You can, however, edit the Alias, 
Animation, and several other properties of the segment with this dialog.  
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Edit All Segments 

Edits all segments in all stages in the TriCOM. See the tutorial Working with TriCOM for 
additional explanation 

Turn Off All Animations 

Stops animations on all objects. 
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TriCOM 

  

This tool allows you to create a TriCOM on the report or cell types.  It is found on the Insert 
tab of the ribbon, as well as the toolbar for the report and cell type. 

 

  

Once the tool is selected, click and drag on the report or cell type to create the object. The 
TriCOM will be created with default properties and a default set of markers.  Double-click the 
object to edit its properties and select which markers to use with the TriCOM. 

Tools to manipulate the plot appear on the right edge of the plot window when the mouse is 
over the plot. 

  

 

  

The bottom of the TriCOM shows a legend of the markers that are being used.  In the 
example above, the markers are HLADR and CD38. A letter is assigned to each marker. A 
capital letter is shown with a solid color and represents the above-normal expression of the 
marker. A lower-case letter is shown with a hatched color and represents below-normal 
expression of the marker.  In the example above, the letter A is assigned to HLADR and B is 
assigned to CD38.  
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If the TriCOM is created for a cell type that has stages defined, the TriCOM will have a 
column for each stage.  In the example, there are 4 stages defined: T4nv, T4cm, T4em, and 
T4te.   

The rows of a TriCOM contain pie charts of expression.  The lowest row shows expression 
where only one of the markers is positive. The next row up shows 2 positive markers, and so 
on. In the example with two markers, there are two rows of expression pie charts: the first 
showing single-positive expression, and the second showing double-positives. 

See the tutorial Working with TriCOM for additional explanation and examples. 

  

Context menu 

There are 2 context menus for TriCOM objects: the frame's context menu and the TriCOM 
plot context menu.  

  

Frame context menu:  

The context menu is displayed by right-clicking on the title area. 

Copy 

Copies the object to the clipboard. 

Save Image 

Saves the object as a graphic to disk. 

Edit Frame 

Displays the Edit Frame dialog. 

Bring to Front 

Brings the object to the front of other objects. 

Send to Back 

Sends the object behind other objects. 

Delete 

Deletes the object. 

Flag to Save 
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Check this option to save the graphic after auto analysis. 

  

  

TriCOM plot context menu:  

The context menu is displayed by right-clicking on the title area. 

Edit Graphics 

This command displays the Graphic Options for TriCOM dialog, used to select measurements 
for the TriCOM and adjust its display properties. 

Edit Segment 

This command allows you to edit the properties of the segment of the selected pie chart.   

Many properties are locked so that they cannot be edited.  You can, however, edit the Alias, 
Animation, and several other properties of the segment with this dialog.  
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Edit All Segments 

Edits all segments in all stages in the TriCOM. See the tutorial Working with TriCOM for 
additional explanation 

Turn Off All Animations 

Stops animations on all objects. 
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Graphic Options for TriCOM 

  

General Options tab 

Background, Grids, and Colors 

Background Color 

Choose a color for the background of the plot. 

Show X Grid Lines 

Enable this option to show grids for the X-axis. Grid lines will appear for each major tic on 
the axis. 

Show Y Grid Lines 

Enable this option to show grids for the Y-axis. Grid lines will appear for each major tic on 
the axis. 

Grid Line Width 

Enter a value for the width of the grid lines. The default, 0, creates the narrowest possible 
line that the screen (or printer) can draw. 

Grid Line Style 

Choose a line style for grid lines. 

Grid Color 

Choose a color for grid lines. 

Grids On Top 

Enable this option to draw grids on top of the other graphics in the plot. When the option is 
unchecked, grids are drawn behind the other graphics. 

  

Quick Enable/Disable 

Choose Measurements 

Displays a dialog to select which measurements to include on the TriCOM. 
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Labeling 

Show Stage Labels 

Enable this option to show stage labels at the top of the TriCOM. 

Show Key Labels 

This option determines the number of labels to show on each pie chart segment. 

Show Stage Boundaries 

This option determines whether stage boundaries are drawn on the plot. 

Stage Label Font 

Choose a font to use for the labels. 

Show Key 

Displays a key of enabled EPs on the TriCOM. 

Show Key Strings 

Displays a key of additional information about the TriCOM. 

Key Label Font 

Choose a font to use for the keys. 

Percent Precision 

Choose the number of decimal places to show. 

Percent Type 

Choose the type of percentage computed. 

  

Additional Properties 

Default TriCOM Mode 

Select the mode for measurements in this TriCOM.  Choose from High and Low, High Only, 
and Low Only. 

Show Significant Combinations 
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When checked, pie chart segments are only shown for combinations that are statistically 
significant. 

Probability Threshold 

When checked, the TriCOM will only include events with a probability of being defined by this 
cell type of less than or equal to this value A value of 0.0 turns the feature off. A value of 
0.01 shows only rare events. 

TriCOM Count P Value 

P value to use to determine whether a combination count is significant or not. (0.000 to 
1.000) 

Normal Adjustment 

Check to automatically subtract the contributions from the normal events that happen to be 
outside of the normal boundaries. 

Sort Percents 

Check to sort the pie percents in descending order. 

Scale to Counts 

Check if you want to scale the pie areas to be proportional to their counts; otherwise, make 
pie charts the same size. 

Maximum Scale Percent 

Redefines the maximum scale percent if the graph is not zoomed and Scale To Counts is 
true. (0.00000 to 100.00000) 

Show All Normals 

Check to see all combinations, including those that are classified as "normal". 
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Graphic Options for Measurements 

Each parameter in a TriCOM Plot has a set of graphic options that determine how it appears 
in the graphics. You can view and edit these properties by double-clicking a TriCOM plot, or 
right-clicking a TriCOM plot and choosing Edit Graphics. 

  

Include Parameter 

Check to include the parameter in the TriCOM analysis.  

TriCOM Mode Override  

Choose mode of the analysis. Overrides the main TriCOM editor mode.  

Parameter Color  

Show the parameter color. Defaults to the parameter profile color.  

Filter  

Choose which type of events to include in the TriCOM.  
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Edit Frame 

  

This command edits properties of the object's frame. 

  

 

  

Save Image  

Flag to Save 

Check to flag this object for saving its image when the file is analyzed.  

Subfolder 

Type in the subfolder name to store its image. Must be created in the canvas image folder. 

  

Position and Size  

X Position 

Enter the x position in inches. 
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Y Position 

Enter the y position in inches. 

X Size 

Enter the x size in inches. 

Y Size 

Enter the y size in inches.  

  

Other 

Show Title 

Show the title of the object. 

Title Font 

Font of the title 

Outline Color 

Color of the object's border 

Outline Width 

Line with of the object's border(-1 to 20). A value of -1 turns off the border. 

Cell Type 

For objects that are associated with a specific cell type, this property shows the cell type. 

Name 

This is the internal name of the object that cannot be edited.  It is used to uniquely identify 
the object. 

  

Actions 

OK 

Click this button to accept the changes and close the dialog box. 
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Cancel 

Click this button to discard any changes and close the dialog box. 

Reset 

Click this button to reset the object's properties to default values. 
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TriCOM toolbar 

  

The TriCOM toolbar is located on the right side of each TriCOM object and is displayed when 
the mouse moves over the object. It provides tools useful for working with the object. 
  

 

Selection Use this tool to select, move, and size objects in the object. 

 

Zoom Use this tool to define the portion of the object to zoom-in 
on. 
Click and drag to surround the area that you want to zoom. 

 

Cancel zoom Click this tool to cancel out of zoom and return to normal 
viewing. 

 

Edit 
Graphics 

Edits the graphics settings for this object. 

 

 

Flag to Save 
Graphic 

Check this option to save the graphic after analysis. 

 

View in 
dialog 

Click this tool to view the object in a dialog window.  
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Design object 

  

This tool allows you to create a Design object on the report or cell types.  It is found on the 
Insert tab of the ribbon. 

 

  

The Design object displays a schematic diagram of the measurement expression profiles used 
in a cell type.  It is a great way to document how the cell type is designed.   

 

  

It works best when it is used on a report page that has nothing else on it, because it requires 
a log of space for its layout.  The layout automatically adjusted to make best us of the space 
to show all of the profiles for the cell type. 
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Once the tool is selected, click and drag on the report create the object. The Design object 
will be created with default properties.  Double-click the object to edit its properties. 

 

  

Context menu 

The context menu is displayed by right-clicking on the object. 

  

Copy 

Copies the object to the clipboard. 

Save Image 

Saves the object as a graphic to disk. 

Edit 

Displays the Edit Properties dialog shown above. 

Bring to Front 

Brings the object to the front of other objects. 

Send to Back 
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Sends the object behind other objects. 

Delete 

Deletes the object. 
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Cen-se' 

Cen-se 

  

This tool allows you to create a Cen-se' plot on the report or cell types.  It is found on the 
Insert tab of the ribbon, as well as the toolbar for the report and cell type. 

 

  

Once the tool is selected, click and drag on the report or cell type to create the 
object.  Double-click the object to edit its properties. The Cen-se' toolbar is displayed to the 
right of the object when the mouse moves over the plot. 

  

 

Context menu 
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There are 2 context menus for Cen-se' objects: the frame's context menu and the Cen-se 
plot context menu.  

  

Frame context menu:  

The context menu is displayed by right-clicking on the title area. 

Copy 

Copies the object to the clipboard. 

Save Image 

Saves the object as a graphic to disk. 

Edit Frame 

Displays the Edit Frame dialog. 

Bring to Front 

Brings the object to the front of other objects. 

Send to Back 

Sends the object behind other objects. 

Copy to Page 

Makes a copy of this object on another page. 

Move to Page 

Moves this object to another page. 

Delete 

Deletes the object. 

Flag to Save 

Check this option to save the graphic after auto analysis. 

  

  



GemStone User Guide 

327 

Cen-se' context menu:  

The context menu is displayed by right-clicking on the title area. 

Edit Graphics 

This command displays the Graphic Options for Cen-se dialog, used to select cell types and 
measurements for the Cen-se' and adjust its display properties. 

Edit Frame 

Displays the Edit Frame dialog. 

Rebuild Cen-se for All Events 

Rebuild the Cen-se plot. 
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Cen-se 

  

This tool allows you to create a Cen-se' plot on the report or cell types.  It is found on the 
Insert tab of the ribbon, as well as the toolbar for the report and cell type. 

 

  

Once the tool is selected, click and drag on the report or cell type to create the 
object.  Double-click the object to edit its properties. The Cen-se' toolbar is displayed to the 
right of the object when the mouse moves over the plot. 

  

 

Context menu 

There are 2 context menus for Cen-se' objects: the frame's context menu and the Cen-se 
plot context menu.  
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Frame context menu:  

The context menu is displayed by right-clicking on the title area. 

Copy 

Copies the object to the clipboard. 

Save Image 

Saves the object as a graphic to disk. 

Edit Frame 

Displays the Edit Frame dialog. 

Bring to Front 

Brings the object to the front of other objects. 

Send to Back 

Sends the object behind other objects. 

Copy to Page 

Makes a copy of this object on another page. 

Move to Page 

Moves this object to another page. 

Delete 

Deletes the object. 

Flag to Save 

Check this option to save the graphic after auto analysis. 

  

  

Cen-se' context menu:  

The context menu is displayed by right-clicking on the title area. 

Edit Graphics 



Reference 

330 

This command displays the Graphic Options for Cen-se dialog, used to select cell types and 
measurements for the Cen-se' and adjust its display properties. 

Edit Frame 

Displays the Edit Frame dialog. 

Rebuild Cen-se for All Events 

Rebuild the Cen-se plot. 
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Graphic Options for Cen-se' 

  

Graphics 

Background Color 

Choose a color for the background of the plot. 

X Grid Lines 

Enable this option to show grids for the X-axis. Grid lines will appear for each major tic on 
the axis. 

Y Grid Lines 

Enable this option to show grids for the Y-axis. Grid lines will appear for each major tic on 
the axis. 

Grid Line Width 

Enter a value for the width of the grid lines. The default, 0, creates the narrowest possible 
line that the screen (or printer) can draw. 

Grid Line Style 

Choose a line style for grid lines. 

Grid Color 

Choose a color for grid lines. 

Grids On Top 

Enable this option to draw grids on top of the other graphics in the plot. When the option is 
unchecked, grids are drawn behind the other graphics. 

Margin 

Margin as a percentage of the size. 

Legend 

Enable this option to show the legend on the plot. 

Initial Scaling Size 
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Set the initial axis scaling for the Cen-se plot.  This is recomputed as the plot is rebuilt. 

Labels 

Show or hide labels. 

Label Font 

Choose a font for the labels. 

  

Measurements and Cell Types 

Measurements 

Displays a dialog to select which measurements to include on the Cen-se. 

Cell Types 

Displays a dialog to select which cell types to include on the Cen-se. 

Rebuild Measurements List 

Rebuilds the list of measurements. 

Rebuild Cell Type List 

Rebuilds the list of cell types. 

  

Cen-se Options 

Maximum Events 

Maximum number of events to allow in the Cen-se when not in Template mode. 

Percent Neighborhood Size 

Relative size of the neighborhood used for each event, as a percentage of Maximum Events. 

Neighborhood Size 

Computed size of the neighborhood. 

Density Normalization 
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Creates better-resolved plots.  When unchecked, additional structure is shown within 
populations. 

  

Cen-se Results 

Info Loss 

A measure of information loss from dimensionality reduction. The unit is nats. 

%Information Lost 

Information loss expressed as a percentage. 

P Q R-Squared 

Quantifies the degree of correlation between Q and P nearest neighbor matrices. 

Total Time 

Total time to build the Cen-se plot. 

Interpolation Time 

Interpolation time for Template mode. 

Clustering Index 

Index based on the Dunn index. Higher values indicate better clustering. 

Beta Clustering Index 

Index based on the SSMD beta index. Lower values indicate better clustering. 
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Cen-se Options 

  

This tab is part of the Edit Graphic Options for Cen-se dialog and contains additional display 
options. 
  

Dots 

Auto Size 

Enable this option to allow the program to determine the best dot size, based on the current 
size of the object and other factors. 

Dot Size 

This field displays the current size of dots in points; a point is 1/72 inches. To set a specific 
size for the dots, uncheck the Auto Dot Size option and enter a value between 0.0 and 10.0 
for Dot Size. 

Show All Dots 

Enable this option to display dots for all events. If this option is unchecked, the system will 
use the value in Desired Dot Number. 

Number 

If Show All Dots is unchecked, the system will use this value to determine the number of dots 
to display in the plot. 

  

Coloring  

Color Scheme 

Choose the desired color scheme for Cen-se dots. 
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Summary 
Map 
Colors 

Colors are based on cell type and staging colors.  
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Alternativ
e Color 

All events are drawn with the Alternative Color selected.  
   

 
Intensity 
Heatmap 

Heatmap colors are based on intensity of events for the selected 
measurement.  
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Frequency 
Heatmap 

Heatmap colors are based on frequency of events.  
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Cell Type 
Colors 

Colors are based on cell type colors.  
   

 

  

Heatmap Measurement 

Click to choose a measurement for the Intensity Heatmap.  

Next Measurement 

Selects the next measurement for Intensity Heatmap coloring. 

Preceding Measurement 

Selects the previous measurement for Intensity Heatmap coloring. 

Alternative Color 

This property defines the color used for Alternative Color coloring scheme. 
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Options  

Population Selection Mode 

If checked, only populations selected in the Summary Map are drawn. 
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Edit Frame 

  

This command edits properties of the object's frame. 

  

 

  

Save Image  

Flag to Save 

Check to flag this object for saving its image when the file is analyzed.  

Subfolder 

Type in the subfolder name to store its image. Must be created in the canvas image folder. 

  

Position and Size  

X Position 

Enter the x position in inches. 
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Y Position 

Enter the y position in inches. 

X Size 

Enter the x size in inches. 

Y Size 

Enter the y size in inches.  

  

Other 

Show Title 

Show the title of the object. 

Title Font 

Font of the title 

Outline Color 

Color of the object's border 

Outline Width 

Line with of the object's border(-1 to 20). A value of -1 turns off the border. 

Cell Type 

For objects that are associated with a specific cell type, this property shows the cell type. 

Name 

This is the internal name of the object that cannot be edited.  It is used to uniquely identify 
the object. 

  

Actions 

OK 

Click this button to accept the changes and close the dialog box. 
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Cancel 

Click this button to discard any changes and close the dialog box. 

Reset 

Click this button to reset the object's properties to default values. 
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Cen-se' Toolbar 

  

The Cen-se' toolbar is located on the right side of a Cen-se' plot on the report and is 
displayed when the mouse moves over the object.  
  

 

Selection Use this tool to select, move, and size objects in the 
object. 

 

Zoom Use this tool to define a portion of the object to zoom-in 
on. 
Click and drag to surround the area that you want to 
zoom. 

 

Cancel zoom Click this tool to cancel out of zoom and return to normal 
viewing. 

 

Edit Graphics Edits the graphics settings for this object. 

 

Build Cen-se' Click this button to rebuild the Cen-se plot. 

 

Polygon Region Use this tool to define a free-hand region on the plot. The 
region can be used to color events. 
After selecting this tool, click and drag on the plot to define 
the region. 

 

Rectangle 
Region 

Use this tool to define a rectangular region on the plot. 
The region can be used to color events. 
After selecting this tool, click and drag on the plot to define 
the region. 

 

Ellipse Region Use this tool to define an elliptical region on the plot. The 
region can be used to color events. 
After selecting this tool, click and drag on the plot to define 
the region. 

 

 

Flag to Save 
Graphic 

Check this option to save the graphic after analysis. 
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Options tab 

Options Tab 

  

 

  
Database FCS Export Settings 
Information Keyword Export Logging 

Fields Save FCS Colors 

Export   Preferences  

    Manage Settings 

  

* Note, the Options tab is only displayed when the program is in Develop mode.  Develop 
mode is enabled from the Home tab. 
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Information 

  

This command displays a dialog that contains all information that is available to the database 
and reporting. The dialog information is read-only. 
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Edit Fields 

  

This dialog is used to select the columns that are displayed in the Batch List, the database of 
analysis results. 
  

 
  

The tree on the left of the dialog contains all of the information available, including analysis 
results, FCS keywords, and other useful fields. The list on the right of the dialog shows the 
fields that have been selected either for display in the batch list, inclusion in the database, or 
both. 
  

If you want to...   

Add columns or fields Select one or more items in the information tree on the left and 
then click the Insert or Add button. 

Remove fields Select one or more items from the list on the right and then click 
Delete. 

Change the order of 
columns 

Select an item in the list and use the Up or Down button. 

Change the name of a 
field 

Edit the text in the Field Name column. 

Show or hide a 
column 

Add the field to the list and check or uncheck the Display option. 
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Export Database 

  

Use this command to export the analysis information in the batch database to a tab-delimited 
text file. The command will display the standard Export Database dialog. Enter a file name for 
the database and navigate to the location where you want to store it. Then click the Save 
button to complete the export. 
  

Tab-delimited text is one of the most universally accessible file formats available. It can be 
easily read and interpreted by database and spreadsheet applications, as well as most lab 
information systems. 
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Keyword to Export 

  

This command is used to set up keywords to export when the program creates FCS files with 
the Save FCS command or during batch processing.  The keywords selected are saved in the 
model template, so when keywords are added or removed, the model template should be re-
saved. 

  

 

  

Add keywords from the information tree on the left side of the dialog.  Once added, the 
Keyword Name can be edited to be concise and informative.  Keywords selected will be 
added to any FCS files saved by that model template. 

  

  

If you want to...   

Add keywords Select one or more items in the information tree on the left 
and then click the Insert or Add button. 

Remove keywords Select one or more items from the list on the right and then 
click Delete. 

Change the order of 
keywords 

Select an item in the list and use the Up or Down button. 
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Synthesize from Analysis 

  

This command is used to generate data based on the current model  and the FCS file that is 
currently analyzed with the model. See also the Synthesize from Model command. 

Before choosing this command, construct or open a model to be used as a basis for the 
synthesized data and analyze an FCS file with the model. 

A dialog is displayed to allow you to choose the number of events to synthesize. Enter the 
value and click OK to synthesize the data. 

The model and the FCS file determine the characteristics of the synthesis process. The same 
probabilistic processes that are used for classifying real data with a model are put to use to 
synthesize events. The synthesized events will have a very realistic distribution, as the 
system takes into account the actual distributions in the FCS file data. 

After synthesis, the generated data appears in the Expression Profile plots and other 
graphics. Statistics and stages are computed for the synthesized data. 

The synthesized data can be exported to an FCS file using the Save FCS command. 
  

Before After 
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See also: 

Synthesize from Model 

Save FCS 
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Synthesize from Model 

  

This command is used to generate data based on the current model. See also the Synthesize 
from Analysis command. 

Before choosing this command, construct or open a model to be used as a basis for the 
synthesized data. 

A dialog is displayed to allow you to choose the number of events to synthesize. Enter the 
value and click OK to synthesize the data. 

The model itself determines the characteristics of the synthesis process. The same 
probabilistic processes that are used for classifying real data with a model are put to use to 
synthesize events. If the model contains multiple cell types, the synthesis routines will 
apportion events accordingly. The better your model describes the real world process, the 
more realistic the synthesized data will appear. 

After synthesis, the generated data appears in the Expression Profile plots and other 
graphics. Statistics and stages are computed for the synthesized data. 

The synthesized data can be exported to an FCS file using the Save FCS command. 
  

Before After 
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See also: 

Synthesize from Analysis 

Save FCS 
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Save FCS 

  

This command creates a new FCS file based on the modeled data.   

The standard File Save dialog is displayed, allowing you to navigate to a location and enter a 
file name for the export. Files are stored in FCS file format. 
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Edit Logging 

  

This command displays a dialog to view the application log and to edit properties of the 
logging system. 

When the logging system is enabled, GemStone records log entries for the operations that it 
performs. It is most often used to trouble-shoot a problem, but it can also provide a record of 
user interactions with the program. 
  

If you want to...   

Enable logging Click the Properties button to display the Edit Properties dialog. 

Clear the log Click the Delete All button. 
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Properties for Logging System 

  

This dialog is used to configure the logging system. It is accessed from the Edit Logging 
System dialog. 
  

Active 

Check this option to enable the logging system. When the logging system is enabled, 
GemStone records log entries for the operations that it performs. It is most often used to 
trouble-shoot a problem, but it can also provide a record of user interactions with the 
program. 

Log File 

This read-only field shows the full path name for the logging file. This is useful if you need to 
send the log file to Verity Software House for technical support. 

Logging Level 

This field determines how much detail the log contains. With Basic, the system stores log 
entries for most user actions. Detailed stores additional lines, and Comprehensive store 
entries for many low-level functions in the program. Normally, Basic is an appropriate level. 
Technical Support may instruct you to use another level to help trouble-shoot a problem. 

Maximum Log Size 

This field displays the maximum for the log file before a new log file is created. 

Full Error report 

If the program crashes, it normally creates a basic error report to help trouble shoot the 
crash.  Enable this option to create a comprehensive error report with more information in 
the event of a crash. 
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Edit Colors 

  

This dialog is used to edit the colors that are used for measurement and stage coloring. You 
can define the number of colors in the palette, and select the colors and color names you 
want to use. The colors in the palette are used when initially creating objects. In most cases, 
you can choose any color you want for an object after you have created it. 

The list contains the colors that have been already defined in the palette. Colors and color 
names can be directly edited in the list. Simply click the color wheel next to a color to select a 
new color. Click on a color name to edit the text. 
  

OK 

Click OK to accept the changes and close the dialog. 

Open 

Use this command to open a color palette file from disk, previously saved using the Save 
command. The standard File Open dialog is displayed, allowing you to select the file you 
want to open. 

Save 

Use this command to save the color palette file to disk, so that it can be shared with others 
or re-opened at another time. The standard File Save dialog is displayed, allowing you to 
navigate to the appropriate location and to enter a name for the file. 
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Properties for Color Palette 

  

This dialog allows properties of the color palette to be edited. The palette contains a set of 
colors for parameter and stage coloring. 
  

Number of Colors 

This field determines the number of colors initially created in the palette. 

Create Project 

The field determines the method used to create the color palette: Cube Root, Rainbow, or 
High Contrast. 

Background Color 

Select the color for background.  This is used as background for reports and cell types. 
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Preferences 

Edit Preferences 

  

This command displays a dialog that allows preferences for the program to be edited. 
  

Select an item in the tree on the left side of the dialog to display the properties for that 
object in the pane on the right. Preferences are automatically saved as defaults for new 
objects, and they are remembered after the program quits. 
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Edit Preferences 

  

This command displays a dialog that allows preferences for the program to be edited. 
  

Select an item in the tree on the left side of the dialog to display the properties for that 
object in the pane on the right. Preferences are automatically saved as defaults for new 
objects, and they are remembered after the program quits. 
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File System Preferences 

  

Packet Size 

Enter the number of events from the FCS file to keep in memory. 

Apply Dither 

If enabled, a random dither is applied to the FCS data.  

Auto Compensate 

When enabled, GemStone will automatically decode compensation keywords in FCS files and 
apply the compensation described in the keywords. If an FCS file does not contain 
compensation information, this setting will have no effect. 

Default Measurement Name 

Choose how you want measurements to be named based on FCS keywords. The default is 
Long Name ($PnS), which typically is the antibody name. Other options include Short 
Name ($PnN) and Short and Long Name ($PnN_$PnS). 

Read All Keywords 

Enable this option to read keywords from all datasets. 

Desired Dataset 

If the FCS files you work with contain more than one dataset, this value allows you to select 
which dataset to read. If you want the program to prompt you to select a dataset when there 
is more than one, set Desired Dataset to 0. To automatically select a specific dataset, enter 
the 1-based dataset index. For example, to read the 2nd dataset in a file, enter the value 2. 

Range for Text Conversion 

Enter the default range ($PnR) to use when converting delimited text to FCS. (... to ...) 

Dataset Descriptive Keywords 

Enter keywords that you want the program to read and present to you from each data source 
to help select the one you want to open. Use commas between keywords. 

Enhanced File Selection 

Use an enhanced file selection dialog.  



Reference 

362 
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General Preferences 

  

Precision 

This property determines the number of decimal places that will be displayed for numbers in 
tables. 

Specimen Keyword 

This keyword is used on the Cell Type widget and other objects to identify the data file that is 
currently opened. 

Export Classification 

If true, export the classification information in Save FCS. 

Synthesis Threshold 

The number of TriCOM events required in order for it to be used in the Synthesize from Data 
command. 

Parallel Processing 

Select the number of threads to use for computation. Auto Determine Thread will use the 
processor's characteristics to determine the number of threads. 
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Graphics Preferences 

  

These preferences are common to the graphic objects on the canvas and reporting areas. 

PDF Output Quality 

Sets the resolution for PDF output. 

Cell Type Page Width 

The width of the cell type page, in inches. 

Cell Type Page Height 

The height of the cell type page, in inches. 

Unclassified Color 

Color for the unclassified events. 

Grid Snap 

Enables grid snapping for object movement and sizing. 

Grid Size 

Sets the size of the snap grid. 

Angle Snap 

Enables angle snapping for object rotation. 

Angle Snap Degrees 

Sets the size of the snap grid for object rotation. 

Copy/Save DPI 

Sets the resolution for images that are copied to the clipboard or saved as images to disk. 

Image Format 

Sets the file format for images that are saved to disk. 

Title Font 
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Choose the title font for objects. 

Outline Color 

Choose the color of the perimeter for objects. 

Outline Width 

Choose the width in pixels of the perimeter for objects.  

Background Color 

Set color for the background of all plots 

X Grid Lines 

Check to show the X grid lines. 

Y Grid Lines 

Check to show the Y grid lines. 

Grid Line Width 

Grid line width in points.  

Grid Line Style 

Grid line style. 

Grid Color 

Set the color of the grids 
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Expression Profile Preferences 

  

This dialog allows editing of Expression Profiles properties.  

  

Auto-expand 

This setting determines how Cell Type expression profiles are expanded during auto analysis. 

Maximum Transition 

Maximum transition allowed for the expression profile.  

Auto Dot Size  

Check to have the system try to find the best size of the dots.  

Dot Size  

Choose the appropriate dot size. (0.00 to 10.00)  

Number  

Enter the specific number of dots for this cell type to display. (0 to ...)  

Unclassified  

Check to show the unclassified events.  

Auto Zoom  

Check to automatically zoom in an area with data.  

  

Actions  

OK  

Click this button to accept the changes and close the dialog box.  

Cancel  

Click this button to discard any changes and close the dialog box.  
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Reset  

Click this button to reset the object's properties to default values.  
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1P Histograms Preferences 

  

Default Width 

Choose the default x size in inches. 

Default Height 

Choose the default y size in inches. 

Resolution 

Choose the number of channels to use for 1P plots. 

Peak Triangles 

Enable this option to show peak location triangles on 1P plots. 

Fill Style 

Choose the style for filling 1P plots. 

Transparency 

Enter a value between 0.0 and 100.0 for the amount of transparency for populations in a 1P 
plot. 

X Auto Zoom 

Enable this option to automatically zoom the X-axis to exclude channels with 0 events in 
them.. 
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2P Plots Preferences 

  

Default Width 

Choose the default x size in inches. 

Default Height 

Choose the default y size in inches. 

Auto Size 

Check to enable auto-sizing of dots. 

Dot Size 

Choose the appropriate dot size in points. 

Number 

Enter the specific number of this cell type's dots to display. 

Unclassified 

Check to show the unclassified events. 

Auto Zoom 

Check to automatically zoom in an area with data. 
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Overlay Preferences 

  

Default Width 

Choose the default x size in inches. 

Default Height 

Choose the default y size in inches. 

X Grid Lines 

Check to show the X grid lines. 

Auto Zoom 

Check to show auto zoom the overlay. 
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Axis Preferences 

  

This dialog allows axis preferences for the program to be edited.  

  

Major Ticks  

Enter the number of major ticks for all the axes.  

Pen Weight  

Enter the pen weight in pixels for the axes. (0 to 10)  

Pen Color  

Click to choose the color for the axis pen color.  

Number Font  

Click to choose the font for axis numbers.  

Number Color  

Click to choose the color for the axis numbers.  

Label Font  

Click to choose the font for the axis label.  

Label Color  

Click to choose the color for the axis label.  

Show Ticks  

Show or hide the axis ticks.  

Show Numbers  

Show or hide the axis numbers.  

Show Label  

Show or hide the axis label.  
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Actions  

OK  

Click this button to accept the changes and close the dialog box.  

Cancel  

Click this button to discard any changes and close the dialog box.  

Reset  

Click this button to reset the object's properties to default values.  
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Peak Finder Preferences 

  

Auto Smoothing 

Finds the optimal bandwidth to smooth the data prior to finding peaks. 

Smoothing 

Applies more or less smoothing to the data. (3 to 15) 

Merge Peaks Below 

Peaks below this negative threshold will be merged into one (default=1). (0 to 30) 

Peak Separation 

If abs(mean1-mean2)/(sd1+sd2) is greater than this threshold, then the peaks are different. 
(0.10 to 1.00) 

Fit Distance 

Filters detected peaks where the fitted mean is too far from the peak's location. (1.00 to 
4.00)  

Peak Fitting Method 

Choose peak fitting method to find peak location and standard deviation. Dimmer and 
brighter side use robust statistics instead of fitting for SD estimation. 

Minimum Peak Height 

Minimum peak height threshold in counts for a peak to be acceptable. (0.01 to 1000.00) 

Minimum State Peak Height 

Minimum state peak height threshold in counts for a peak to be acceptable. (0.01 to 
1000.00) 

Peak Deflection Threshold 

Minimum peak deflection (vertical deflection*100/sd) for a peak to be acceptable. (0.10 to 
50.00) 
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Region Preferences 

  

This dialog allows editing of Regions properties.  

Line Width  

Line width in pixels (0 to 10) 

Line Color  

Line color for new regions. 

Actions  

OK  

Click this button to accept the changes and close the dialog box.  

Cancel  

Click this button to discard any changes and close the dialog box.  

Reset  

Click this button to reset the object's properties to default values.  
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Information Table Preferences 

  

This dialog allows all preferences for the program to be edited. The current section allows 
editing of Information Tables properties.  

  

Number of Rows 

Choose the number of rows in the table. (1 to 200) 

Number of Columns 

Choose the number of columns in the table. (1 to 200) 

Information Table Font 

Font to use for the information table 

Number of Decimals 

Number of decimals to show in the information table (0 to 6) 
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Transformation Preferences 

  

This dialog allows all preferences for the program to be edited. The current section allows 
editing of Transformations properties.  

  

Transform 

Choose the desired transform as a default if possible. 

Calculate Decades 

Enable this option to compute the number of decades for a measurement based on its 
resolution. 

Auto B 

Check to automatically calculate B. 

Min Linear Option 

Select the option for computing the minimum value on the axis.  Choice include Percent of 
Max Linear, Percent of Area and User Defined. 

Percent of Area 

If Min Linear Option is Percent of Area, this value determines the percentage to use for the 
computation. 

Percent of Max Linear 

If Min Linear Option is Percent of Max Linear, this value determines the percentage to use for 
the computation. 

Negative Axis Fraction 

This value determines the fraction of the axis that is devoted to values less than zero (0.0 - 
1.0). The default value of 0.20 allows up to 20% of the axis to be devoted to negative 
channels and 80% to positive channels. 
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Manage Settings 

  

Export Settings 

This command displays the standard Save dialog box.  Navigate to the location where you 
want to save the settings and enter a file name.  The settings will be stored as a zip file. 

Import Settings 

This command displays the standard Open dialog box.  Navigate to a previously-saved 
settings zip, select it, and the program will read the settings.  You will be prompted that the 
program should restart. 

Reset Settings 

A confirmation dialog is displayed to confirm that you want to reset the settings. Click OK to 
continue to reset the settings files, or Cancel to escape. 

After resetting, the program will need to restart. 
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Develop tab 

Develop Tab 

  

 

  
Project Template Data Model Analysis 
Save New Read FCS Measurement Wizard Classify 

  Reset   Cell Type Wizard Classify File 

  Open   Stages Auto Analyze 

  Save   Equations CT Auto Analyze 

  Save As   Properties Step Analysis 

  

* Note, the Develop tab is only displayed when the program is in Develop mode.  Develop 
mode is enabled from the Home tab. 
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Save Project 

  

 

  

The Save Project command re-saves the current Project.  The command appears in the File 
menu and on the Develop tab. 

Use this command when you have changed the batch scripts, database format, or model 
template used in the Project. 

  

The Save Project As command (Develop mode) displays a dialog that allows you to type a 
new name and location for the Project. All content from the original Project is copied to the 
new Project name and location.   

  

See also: 

What is a Project? 
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New Template 

  

 
  

When selected, GemStone will create a new, empty model template. 

A model template contains the cell type definitions, expression profiles, report design, and 
objects on the Cell Type canvas. 
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Reset Template 

  

 

  

Use this command to put Expression Profile control definition points (CDPs) back to the 
positions they were in when the model template or analysis document was opened. 

The command is typically used when creating new templates or modifying existing 
templates.  Use the command before saving changes to the template if you want to use the 
CDP positions that were saved in the model. 
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Open Template 

  

 

  

This command will display the standard File Open dialog to allow the user to select a 
previously saved GemStone model template file. GemStone will open the selected file and 
display the Cell Types, expression profiles, report, and other objects contained in the 
document. 
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Save Template 

  

 

  

If the template has been saved previously, this command will resave it without displaying a 
dialog. The previous version of the document will be overwritten. 

If the template has not been saved, this command performs identically to the Save 
Document As command. 
  

  



Reference 

384 

Save Template As 

  

 

  

When selected, this command will display the standard File Save dialog to allow the user to 
save the current GemStone model template to a file on disk. GemStone will save the Cell 
Types, expression profiles, report, and other objects contained in the document. 
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Read File 

  

 

  

This command performs two actions:  

1. It sets the Start At file to the file that is currently selected in the list. 

2. It reads the FCS file into the current model template. 

  

The command does not trigger the batch script processing that normally happens when an 
FCS file is loaded using the batch buttons.  This allows a developer to read an FCS file 
without having the batch processing fire off. 
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Measurement Wizard 

Measurement Wizard 

  

The measurement wizard is used to set up names and transformations for new 
measurements, as well as to edit existing measurements.  It is available in Develop mode 
only. 

  

 

  

The wizard starts with the selection page for choosing the measurements you want to edit. 
The wizard then displays the measurement properties page for each measurement 
selected.  It then allows the user to choose cell types that they want to add the 
measurement to.  It concludes with a summary page. 
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Measurement Wizard 

  

The measurement wizard is used to set up names and transformations for new 
measurements, as well as to edit existing measurements.  It is available in Develop mode 
only. 

  

 

  

The wizard starts with the selection page for choosing the measurements you want to edit. 
The wizard then displays the measurement properties page for each measurement 
selected.  It then allows the user to choose cell types that they want to add the 
measurement to.  It concludes with a summary page. 
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Measurement Wizard Matching Page 

  

This page of the Measurement Wizard is displayed when there are measurements in the 
model that are not matched by measurements in the FCS file. 

  

 

  

The list on the left displays measurements in the FCS file. You can choose to Show 
Unmatched or to Show All measurements. 

The list on the right shows measurements that are used in the Model. 

Both lists have a column that indicates what the measurement is Matched To in the other 
list. 

  

To match an FCS measurement to a model measurement, select the items that you want to 
match in each list and then click Match.  You can also Unmatch measurements if they are 
incorrectly associated. 
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Click Next to move to the next page of the wizard, the Measurement Wizard Selection Page. 
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Measurement Wizard Selection Page 

  

This page of the measurement wizard is used to select measurements that you want to 
edit.  By default, any new measurements that are not known to the model template will be 
selected.   

  

 

  

Select measurements by checking the checkbox next to the measurement name.  The All and 
None button will set or clear all check boxes. 

  

Click Next to move to the next page of the wizard, the Measurement Wizard Measurement 
Properties Page. 

Click Previous to move to the Measurement Wizard Matching Page. 
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Measurement Wizard Measurement Properties Page 

  

This page of the measurement wizard is used to adjust the properties of a measurement. It 
is shown for each measurement selected on the selection page of the wizard.  

  

 

  

Properties for the measurement are shown on the left, and a preview of  the measurement 
using those properties appears on the right. 

Use the wizard's Next and Previous buttons to navigate through the selected measurements. 
When all selected measurements have been edited, the Next button at the bottom of the 
wizard will enable to allow the wizard to move to the Summary page. 

  

  

  

Measurement properties 

Measurement 
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Enter the name to use for this measurement. 

Abbreviation 

Enter an abbreviated form for the name. 

Color 

Select a color for the measure.  This will be used in overlay plots. 

  

Transformation Properties 

Transform 

Select a transform to use for the measurement. 

Calculated Decades 

When enabled, the program will compute the number of decades in the data.  When 
disabled, the value in the Decades box is used. 

Decades 

When Calculated Decades is unchecked, this value can be adjusted to the desired number of 
decades. The program will scale data to the specified number decades. 

VLog Beta 

The Beta value for the VLog transform.  Typically, this is 10.0. 

  

Maximum 

Max Linear Option 

Choose Automatic to set the Max Linear value based on the resolution of the measurement. 
Choose User Defined to set a constant maximum value from file to file. 

Max Linear 

When Max Linear Option is set to User Defined, this value sets the maximum linear value for 
the measurement. When Max Linear Option is set to Automatic, this value is read-only, and 
shows the value being used as the maximum. 
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Maximum 

Min Linear Option 

This option determines how the the lowest value for the measurement is 
determined.  Choose Percent of Max Linear to base the minimum value on the maximum 
value.  Choose Percent of Area to based the value on a percentage of the area of the 
histogram.  Or choose User Defined to set the Min Linear value directly. 

Percent of Max Linear 

Enter the percentage of the Max Linear value to use for the Min Linear value.  Typically, this 
is 0.10%.  

Percent of Area 

Enter the percentage of the area of the histogram to use to determine the value that will be 
used for the Min Linear. 

Min Linear 

The minimum linear value for the measurement.  This is dynamically computed if Min Linear 
Options is set to Percent of Max Linear or Percent of Area. 
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Transforms 

  

GemStone offers a number of transforms for displaying FCS data in plots.   

  
Transform Display Description 

Linear 

 

This is essentially 
"untransformed". Bins are 
evenly sized. 

Log 

 

Log compresses data as 
the intensity increases. It 
allows visualization of a 
wide dynamic range.  Any 
event values less than 0 
are set to be 0.  

HyperLog 

 

HyperLog is log-like, but it 
allows values less than 
0.  Decades may vary in 
width.  
The B coefficient is used to 
adjust the number of 
channels that are in the 
linear portion of the axis 
on either side of 0.  In the 
example, B=10. 

Hyperbolic 
Sine 

 

Hyperbolic Sine is log-like, 
but it allows values <= 
0.  Decades are the same 
width.  
The B coefficient is used to 
adjust the number of 
channels that are in the 
linear portion of the axis 
on either side of 0.  In the 
example, B=10. 
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VLog 

 

VLog is log-like. It allows 
values <=0, and optimizes 
for consistent standard 
deviation across the 
dynamic range.  
The VLog transform 
stabilizes measurement 
variance arising from 
coefficient of variation or 
cv and background noise. 
The VLog Alpha 
coefficient adjusts for both 
cv and counting error, and 
the VLog Beta coefficient 
adjusts for cv and 
background. The VLog 
Alpha value is typically 
1.0. The VLog Beta value 
is typically 10.0. It can be 
set to the approximate 
background intensity for 
the measurement. For 
mass cytometry data, the 
default value of 10 is 
recommended. 
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Measurement Wizard Summary page 

  

This page of the measurement wizard summarizes the measurements that were edited.   

  

 

  

Enable the Launch the Cell Type Wizard to initiate that wizard when this wizard finishes.   

Click the Finish button to complete the wizard and close the dialog. Click Cancel to close 
the dialog without saving any of the changes. 
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Select Measurements 

  

 
  

This dialog is displayed to select the parameters that are included in a cell type for analysis 
or display. 

The list on the left side of the dialog displays all of the parameters that exist in the file, as 
well as other parameters that GemStone has seen in other files. The parameters in the 
current file display "On" in the "Live" column. 

The list on the right shows the parameters that have been selected for analysis or display. 
  

If you want to...   

Add or insert a new 
measurement 

Select the measurement in the list on the left of the 
dialog, and then click Add or Insert. 

Remove a measurement 
from the cell type 

Select the measurement in the list on the right, and 
then click Delete. 

Remove all measurements 
in the cell type 

Click the Delete All button. 
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Calculated Measurements 

  

 

This dialog is used to create and edit calculated measurements, including ratios and other 
computed expressions.  The resulting calculated measurements can be used just like any 
other measurement, in plots and expression profiles. They will be included if you use the 
Save FCS command or the batch Export FCS option to create a new FCS file.  

  

 

  

The list on the left contains all measurements in the FCS file, prefixed with the abbreviation 
that can be used in the calculated expression (e.g. "L1"). 

The center list contains example expressions that can be used as a starting point for a new 
calculated measurement.  

The list on the right contains all calculated measurements that have been created.   

  

If you want to...   

Create a new, calculated 
measurement 

Select an example from the middle list and click 
Add.  Edit the Name and Equation for your new 
measurement. 

Remove a calculated 
measurement  

Select the calculated measurement in the list on the 
right and click Delete. 
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Edit the Name field to be a simple but informative string.  This field is concatenated with the 
ID field for the name of the measurement in lists. 

Edit the Equation field to be the expression for your new, calculated measurement.  Use the 
Measurement list on the left as a reference for the abbreviations to use for each 
measurement. 
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Cell Type Wizard 

Cell Type Wizard 

  

This wizard is used to simplify the process of creating a new cell type.  It provides a guided 
approach to building the key aspects of a new cell type.  It can also be used to edit an 
existing cell type.  The feature is only available in Develop mode. 

  

 

  

The wizard initially displays a Welcome page to with a choice of tasks you can perform. The 
next page defines the properties of the cell type.  Next you select the selection markers, 
staging markers, and functional markers that you want to analyze for this cell type.  Once 
you have made these choices, the wizard guides you through the process of creating an 
expression profile for each marker.  Finally, a summary page is displayed. 
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Cell Type Wizard 

  

This wizard is used to simplify the process of creating a new cell type.  It provides a guided 
approach to building the key aspects of a new cell type.  It can also be used to edit an 
existing cell type.  The feature is only available in Develop mode. 

  

 

  

The wizard initially displays a Welcome page to with a choice of tasks you can perform. The 
next page defines the properties of the cell type.  Next you select the selection markers, 
staging markers, and functional markers that you want to analyze for this cell type.  Once 
you have made these choices, the wizard guides you through the process of creating an 
expression profile for each marker.  Finally, a summary page is displayed. 
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Cell Type Wizard Welcome 

  

This page of the Cell Type Wizard is used to select the task you want to perform. 

  

 

  

Choose the task: 

• Create a new cell type 
• Duplicate a cell type * 

You can duplicate existing cell types and then edit the new cell type.  
• Edit a cell type * 

You can edit an existing cell type with this option. 

* Note, some cell types that have been customized outside of the wizard may not be editable 
in the wizard. 

  

Disable other cell types 
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With this option enabled, the other cell types in the model will be disabled while the wizard is 
running.  This allows you to build the new cell type as if it is the only cell type in the model.   

With the option unchecked, the other cell types will be enabled while building the new cell 
type.  This can be useful for cell types that have fewer events. 

Create a report page 

Enable this option to create a new report page for the cell type you are creating or 
editing.  The wizard will create a page with plots and tables based on the choices made to 
create the cell type. The page can be edited and enhanced by the user after the wizard 
completes. 

Insert before 

Select where you want to insert the new cell type in the model. By default, a new cell type is 
appended to the list of cell types (i.e. Insert before "None"). 
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Cell Type Wizard Properties 

  

This page of the Cell Type Wizard is used to define several properties of the cell type. 

  

 

  

Cell Type Name 

Enter a name for the cell type.  The name should be as concise as possible. 

Description 

Enter a helpful description of the cell type. 

Enable 

The cell type has to be enabled to be included in the modelling process.   
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Color 

The color to use for this cell type.  It is used in numerous graphic objects. 

Classification Type 

Choose the type of cell type that you want this to be: 

Type Description 

Competitive 

This is the most common type of cell type.  The cell type will "compete" with 
other competitive cell types for events.  Any given event can only belong to 
one of the competitive cell types.  
Use this for most cases. 

Selective 

This special cell type can be used as the first cell type in a model template, 
and there should be no more than one of them. The selective cell type 
selects events that will then be considered by the competitive cell types.  It 
acts much like an initial gate to select cells of interest.  
This is not a commonly used type. 

Non-
competitive 

A non-competitive cell type is typically the last cell type in a model 
template.  It is designed to capture all of the events that are not assigned to 
any of the competitive cell types.    
It is useful for analyzing the unclassified events. 
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Cell Type Wizard Selection 

  

This page of the Cell Type Wizard is used to choose the Selection markers for the cell type.   

Selection markers use constant expression profiles to select a subset of events with a 
particular phenotype.  

  

 

  

To add a marker, find the marker in the Available Markers list and click it.  The marker will 
be moved into the right-hand list of Cell Type Markers. 

To remove a marker, find the marker in the Cell Type Markers list and click it.  The marker 
will be removed from the list and put back into the Available Markers list. 
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Cell Type Wizard Staging 

  

This page of the Cell Type Wizard is used to choose the Staging markers for the cell type.   

Staging markers use step-up, step-down, or three-level expression profile to define a 
marker's change in expression that occurs within the cell type.  

  

 

  

To add a marker, find the marker in the Available Markers list and click it.  The marker will 
be moved into the right-hand list of Cell Type Markers. 

To remove a marker, find the marker in the Cell Type Markers list and click it.  The marker 
will be removed from the list and put back into the Available Markers list. 
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Cell Type Wizard Functional 

  

This page of the Cell Type Wizard is used to choose the Functional markers for the cell type. 

Functional markers use constant expression profiles or no profile at all.  They may, for 
example, show activation of a marker.  

  

 

  

To add a marker, find the marker in the Available Markers list and click it.  The marker will 
be moved into the right-hand list of Cell Type Markers. 

To remove a marker, find the marker in the Cell Type Markers list and click it.  The marker 
will be removed from the list and put back into the Available Markers list. 
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Cell Type Wizard Profiles 

  

This page is shown for each of the selection, staging, and functional markers selected in 
previous pages of the Cell Type wizard.  It is used to choose and set up the expression 
profile for the marker in the cell type being created or edited. 

When this page is displayed, move the wizard so that you can see the expression profiles in 
the cell type widget.  This allows you to preview your choices. 

When navigating through the profiles, you will use the Next Profile button that appears on 
the right of the dialog and the Previous Profile button that appears on the left.  If one is 
disabled, that indicates you've reached the beginning or end of the list of profiles.  

Moving to previous profile Moving to next profile 

  

  

Selection Profiles 

  

Constant profiles are used for selection markers.   
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The Links button allows this profile to be linked to another profile.  For example, it is 
common to link the CD3+ profile for CD4 cell type to the CD3+ profile of the CD8 cell type. 

The Preview checkbox shows the profile in its unmodelled (unchecked) or modelled 
(checked) state. 

  

The properties for selection profiles are listed below. 

Which Peak? 

Choose which peak in the marker the expression profile should track. 
User 
estimate 

The marker doesn't use a peak. It uses the estimates for Intensity and SD to 
position and size the profile. 

Closest 
Find the closest peak to the starting location of the profile and use its peak 
estimates. 

Dimmest Find the dimmest peak (lowest intensity) and use its peak estimates. 
Brightest Find the brightest peak (highest intensity) and use its peak estimates. 
Smallest Find the smallest peak (lowest number of events) and use its peak estimates. 
Largest Find the largest peak (largest number of events) and use its peak estimates. 

  

Distribution 
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Choose the type of distribution to use for this profile. 
Normal 
Distribution 

The control definition points define the mean of a normal distribution.  

Inverse Normal The profile is the inverse the Normal Distribution. 
Inverse Low 
Pass 

The profile is the inverse of the Low Pass distribution. 

Low Pass 
The control definition points define a probability "edge".  Events below 
the CDPs are included. 

High Pass 
The control definition points define a probability "edge".  Events above 
the CDPs are included. 

Inverse High 
Pass 

The profile is the inverse of the High Pass distribution. 

  

Phenotype 

This field is automatically filled in when possible. Enter a short phenotype description for the 
selection. This is used on report pages. 

Initial Intensity 

This intensity estimate can be edited when the Which Peak value is set to User Estimate or 
Closest. 

Initial Width 

This intensity estimate can be edited when the Which Peak value is set to User Estimate or 
Closest. 

Width from Peak 

If this option is enabled, the program will adjust the profile's width based on the peak 
estimates. 

Add to Report 

If this option is enabled, a graph of the measurement will be included in on the report page. 

  

Staging Profiles 

  

Staging profiles can be StepUp, StepDown, or ThreeLevels.  Choose the one that best 
matches the change in expression for that marker in the cell type being edited. 
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The properties of the staging profile are the same as for Selection, except they are repeated 
for each level of the profile. 

  

Functional Profiles 

  

Function markers use constant profiles or no profile at all. 
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The properties of the functional profile are the same as for Selection, except they are 
repeated for each level of the profile. 
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Cell Type Wizard Summary 

  

The summary page is the final page in the Cell Type wizard, providing a summary of the 
selections made in the wizard. 

  

 

  

Enable Do another cell type to run the wizard again after finishing the current cell type. 

Enable Save template model to save the changes made by the wizard in the current 
template model file. 

  

Enable Update summary map to tell Cen-se' plots and the summary map about the new 
cell type. 

Enable Add to Cen-se' if you have a Cen-se' plot on a report page and want to include this 
cell type in the Cen-se'. 

Enable Add database fields to append statistics for this cell type to the database. 
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Edit Stages 

  

 

  

This dialog allows stages to be added, deleted, and modified. Stages are defined on the 
Progression (State Index) axis and provide statistics and coloring for portions of the 
progression. 

Stages are most often defined using Definition Points in the Expression Profiles for a given 
Cell Type. This allows the boundaries of the stage to adjust automatically as the Definition 
Points are adjusted.  

Each stage has a name and color. The color is used when drawing dots that fall within the 
stage's boundaries and along the top of Overlay plots when stages are displayed. If 
overlapping stages are defined, the color of the last stage containing an event is used to 
color dots for that event. 

A Stage Table object appears on each Cell Type to provide statistics for the stages. The table 
shows the name, color, active state, and statistics for each stage. 

See Edit Properties for Stage for additional details on stage properties. 
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If you want to...   

Add a new stage Click the New button and fill in the Edit Properties for 
Stage dialog. 

Delete a stage Select the stage in the list, and then click Delete. 

Change the order of stages Select a stage, and then use the Up or Down button to 
move it in the list of stages. 
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Edit Properties for Stage 

  

This dialog displays all of the properties for a single stage. Stages are defined on the 
Progression (or State Index) axis and provide statistics and coloring for portions of the 
progression. 
  

Name 

Type a name for the stage. Short names are usually recommended so that they can be read 
when displayed on Overlay plots. 

Active 

Check this option to enable the stage for coloring and analysis. If this option is unchecked, 
GemStone will ignore the stage; dots will not be colored with the stage and statistics will not 
be computed. 

Show in Graphs 

When this option is checked, the stage is displayed in the plots. 

Color 

Choose a color for the stage. The color is applied to expression profile plots, overlays, and 2P 
histograms.  

Intensity Stats 

When this option is enabled, the program computes intensity statistics within the stage for 
each parameter.  
  

Start 

Start CDP 

Select a Control Point to link to for the start of the stage. Each Definition Point in the list is 
named based on the parameter and the position in the profile that owns the point. 

Select "None" if you want to enter a fixed value for the starting location of the stage in the 
Start State Value field. 

State Value 
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If the Start Link field is set to "None", enter a number between 0.0 and 100.0 to define the 
starting location for the stage. The value represents a percentage of the Progression axis for 
the starting location of the stage. 

If a Definition Point is selected for Start Link, this field is disabled. It shows the location of 
the selected point. 

  

End 

End CDP 

Select a Control Point to link to for the end of the stage. Each Definition Point in the list is 
named based on the parameter and the position in the profile that owns the point. 

Select "None" if you want to enter a fixed value for the ending location of the stage in the 
Start State Value field. 

State Value 

If the End Link field is set to "None", enter a number between 0.0 and 100.0 to define the 
ending location for the stage. The value represents a percentage of the Progression axis for 
the ending location of the stage. 

If a Definition Point is selected for End Link, this field is disabled. It shows the location of the 
selected point. 
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Equations 

Equations 

  

 
  

Equations are user-defined expressions that can be evaluated and stored in the information 
database and displayed on reports.  

The equations you write are stored as part of the model template. You can store a set of 
equations using the Save button and then import those equations into another template 
using the Open button. 

A dialog is displayed, showing a set of example equations on the left, and the list of 
equations already defined on the right. 
  

 
  

Anatomy of an Equation 

Each equation has at least two fields that can be edited: Description and Format. In 
addition, the equation will have additional Properties that can be edited if the equation 
contains placeholders for some of its arguments (e.g. "%1"). The placeholders in an equation 
are used to reference keywords and other elements in the information system. 
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For example, let's examine the "Simple Ratio" equation in the example list. It has a 
Description, "Simple Ratio", which can be edited to be anything you want. To edit the 
description, click the mouse in the Description field, and edit the text. 

The Format portion of the equation is where the equation expression is actually defined. 
The format can contain numbers and mathematical operators, but it can also contain special 
functions and placeholders. Function are found in the examples in the tree on the left of the 
dialog and listed in Equation Functions. Placeholders are the parts of the equation format 
that use the percent symbol (%) and a number. 

In the example equation, the Format field uses two placeholders: %1 and %2. As the name 
implies, a placeholder identifies part of the equation that will be replaced by an element that 
GemStone has read from a data file or that it has computed. For example, with our Simple 
Ratio equation, if we want to create a ratio between the number of events in Stage 1 and 
Stage 2, we would tell GemStone to replace %1 with the Stage 1 events and %2 with Stage 
2 events. This is done by selected the equation in the list and then clicking the Edit button. 
  

In the Edit Equation dialog, right click the Information field to display a dialog of choices 
available to fill-in the placeholder. In our example, you would choose 
CellType1_Stage1_NumberOfEvents for %1 and CellType1_Stage2_NumberOfEvents for %2. 
  
Each placeholder in an equation must be associated with an information field in this manner 
before the equation can be properly evaluated. 
  
Suppose that you want to create a custom equation that multiplies the mean of a parameter 
in Stage1 by 4.56, and then divides by the mean of another parameter in Stage1. The Format 
field would look like this: 

%1*4.56/%2 

After typing the equation into the Format field, you would click the Edit button and select the 
statistics to fill-in for %1 and %2. 
  

Suppose that you wanted to use a function in this equation, to take the square root of the 
result. The format field would look like this: 

FSQRT(%1*4.56/%2) 

For a list of functions, see Equation Functions. 
  
  

If you want to...   

Add a new 
equation 

Select an example equation from the tree on the left and click Insert or 
Add to copy the example to the equation list. Edit the format field to 
define the equation expression. Then use the Edit button to select fields 
that will be evaluated by the equation (see Edit Equation). 

Edit 
placeholders in 
an equation 

Select the equation in the list on the right and click the Edit button. In 
the Edit Equation dialog, right click in the Information column to 
display the choice of items. Select the keyword or statistics you want 
from the choices shown. 
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Remove an 
equation 

Select the equation in the list on the left and click the Delete button. 

Save a set of 
equations 

Click the Save button, navigate to a location on disk, and save the 
equation file. 

Open a set of 
equations 

Click the Open button, navigate to the location where the equation file 
was previously saved on disk, and open the equation file. 

  

See also: 

Edit Equation 

Equation Functions 
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Equations 

  

 
  

Equations are user-defined expressions that can be evaluated and stored in the information 
database and displayed on reports.  

The equations you write are stored as part of the model template. You can store a set of 
equations using the Save button and then import those equations into another template 
using the Open button. 

A dialog is displayed, showing a set of example equations on the left, and the list of 
equations already defined on the right. 
  

 
  

Anatomy of an Equation 

Each equation has at least two fields that can be edited: Description and Format. In 
addition, the equation will have additional Properties that can be edited if the equation 
contains placeholders for some of its arguments (e.g. "%1"). The placeholders in an equation 
are used to reference keywords and other elements in the information system. 



GemStone User Guide 

423 

For example, let's examine the "Simple Ratio" equation in the example list. It has a 
Description, "Simple Ratio", which can be edited to be anything you want. To edit the 
description, click the mouse in the Description field, and edit the text. 

The Format portion of the equation is where the equation expression is actually defined. 
The format can contain numbers and mathematical operators, but it can also contain special 
functions and placeholders. Function are found in the examples in the tree on the left of the 
dialog and listed in Equation Functions. Placeholders are the parts of the equation format 
that use the percent symbol (%) and a number. 

In the example equation, the Format field uses two placeholders: %1 and %2. As the name 
implies, a placeholder identifies part of the equation that will be replaced by an element that 
GemStone has read from a data file or that it has computed. For example, with our Simple 
Ratio equation, if we want to create a ratio between the number of events in Stage 1 and 
Stage 2, we would tell GemStone to replace %1 with the Stage 1 events and %2 with Stage 
2 events. This is done by selected the equation in the list and then clicking the Edit button. 
  

In the Edit Equation dialog, right click the Information field to display a dialog of choices 
available to fill-in the placeholder. In our example, you would choose 
CellType1_Stage1_NumberOfEvents for %1 and CellType1_Stage2_NumberOfEvents for %2. 
  
Each placeholder in an equation must be associated with an information field in this manner 
before the equation can be properly evaluated. 
  
Suppose that you want to create a custom equation that multiplies the mean of a parameter 
in Stage1 by 4.56, and then divides by the mean of another parameter in Stage1. The Format 
field would look like this: 

%1*4.56/%2 

After typing the equation into the Format field, you would click the Edit button and select the 
statistics to fill-in for %1 and %2. 
  

Suppose that you wanted to use a function in this equation, to take the square root of the 
result. The format field would look like this: 

FSQRT(%1*4.56/%2) 

For a list of functions, see Equation Functions. 
  
  

If you want to...   

Add a new 
equation 

Select an example equation from the tree on the left and click Insert or 
Add to copy the example to the equation list. Edit the format field to 
define the equation expression. Then use the Edit button to select fields 
that will be evaluated by the equation (see Edit Equation). 

Edit 
placeholders in 
an equation 

Select the equation in the list on the right and click the Edit button. In 
the Edit Equation dialog, right click in the Information column to 
display the choice of items. Select the keyword or statistics you want 
from the choices shown. 
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Remove an 
equation 

Select the equation in the list on the left and click the Delete button. 

Save a set of 
equations 

Click the Save button, navigate to a location on disk, and save the 
equation file. 

Open a set of 
equations 

Click the Open button, navigate to the location where the equation file 
was previously saved on disk, and open the equation file. 

  

See also: 

Edit Equation 

Equation Functions 
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Edit Equation 

  

This dialog is used to edit the placeholders in an equation. Placeholders are the parts of the 
equation format that use the percent symbol (%) and a number. Each placeholder must be 
associated with a piece of information, which is used when the equation is evaluated. 

  

 
  

To select the keyword for a placeholder, right click the Information field.  A dialog of the 
available items in the information system will appear. Choose the category to expand the 
appropriate submenu, then select the specific item from the choices. 
  
Each placeholder in an equation must be associated with an information field in this manner 
before the equation can be properly evaluated. 
  

See also: 

Edit Information Equations 

Equation Functions 
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Equation Functions 

  

These functions can be used when writing equations using the Edit Information Equations 
dialog. 
  

Indexing 

Indexes for FCS parameters start at 1 and represent the parameter order in the FCS file. For 
example, if a file has six parameters, they are referenced as P1 through P6 in equation 
functions. Parameters do not need to be included in the model to be referenced by an 
equation. The best way to determine the parameter index for a specific parameter is to add 
one to the Listmode Parameter field in the Expression Profile properties. 
  

 
  

For example, if the Listmode Parameter is 14, we would add one for an index of 15 when 
using it in equations. 
  

Indexing for gate and regions starts at 1. The expression "G1" refers to the gate for Cell Type 
1, and region R1 is the first region index. 

Indexes for the Cell Types defined in a model also start at 1. However, there is a hidden Cell 
Type that contains all unclassified events. This is referred to as Cell Type 0, and it can be 
referenced in equation functions as "C0". 
  

Parameter Scales 

GemStone keeps track of several different scales for measurements at the same time. The 
table below describes each scale and gives the symbol to use to access the scale in equation 
functions. 

Scale Symbol Description 

Linear L 
Raw, linear data values from the data file for the 
parameter. These values are in the ADC range of the 
instrument. 

Compensated C Compensated values, on the same scale as Linear. 

Transformed P 

Internal floating point scale of 0.0 to 100.0. 

Log or HyperLog transforms have been applied, if the 
parameter is displayed using one of these transforms. If 
compensation is defined for the parameter, the 
Transformed value is in compensated data space. 
Linear value 0.0 maps to Transformed value 0.0. 
Linear max value maps to Transformed 100.0. 
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Functions 

This system is designed to provide a flexible but efficient framework to calculate any kind of 
statistic we want from the data. This ambitious goal is achieved by an extensive syntax. 

Let's begin with the simplest of the summation functions, the gated sum: 
  

GSUM({GIDn{,Cq}}{;IDm{;IDp}) 

where 

{ } indicate an optional argument 

GIDn = Rn or Gn 

n represents a gate or region index, starting with 1 

C = cell type 

q = 0 (unclassified), 1, 2, ..., number of cell types 

ID = L, C, P 

m and p represent a parameter index, starting with 1. 

The number of IDn arguments limited to two. 

The IDm and IDp are optional. 

  

With no arguments, GSUM becomes a simple count. 

The first optional argument to the GSUM function, GIDn, identifies a region or gate. If a gate 
or region ID is specified, only the events in that gate or region are considered. If the gate or 
region ID is omitted, then all events are considered in the sum. 

For example: 

GSUM() 

returns the number of events 

GSUM(G1) 

returns the number of events in gate G1 

GSUM(R1) 
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returns the number of events in region R1 

  

A semi-colon (;) is required between the optional gate and the next argument. 

The GSUM function can have up to two ID arguments that identify a parameter of interest. 
There are 3 scales for parameter data: L for linear, C for compensated, and P for 
transformed. These are described in the Parameter Scales section above. For example, L1, 
C1, and P1 all related to parameter 1 in the data file. The scaling is different for each of 
these representations of parameter 1. 
  

GSUM(;L1) 

returns the sum of linear intensity values for parameter 1 

GSUM(;C1) 

returns the sum of compensated intensity values for parameter 1 

GSUM(;P1) 

returns the sum of transformed intensity values for parameter 1 

  

If two parameter ID arguments are specified in the GSUM function, the result is the products 
of the event values for the specified parameters. For example, 
  

GSUM(R3;P3;P3) 

finds the sum of the square of transformed parameter 3 values that are in region R3. 

  

Gated cross products (cc) are computed in this manner: 
  

GSUM(R3;P3;P4) 

returns the correlation coefficient for parameters 3 and 4 events that are in region R3. 

  

A simple linear mean is evaluated as, 
  

GSUM(G3;L1)/GSUM(G3) 
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returns the linear mean for parameter 1 events that are in gate G3. 

  

Other types of intensity related summation functions compute the mode and median: 
  

GMOD(;P2) 

computes the mode for parameter 2 in transformed space. 

GMED(G3;P2) 

computes the median for parameter 2 events that are in gate G3. The result is in 
transformed space. 

  

Quadrant statistics include 
  

GQ1(G3;P2) 

returns the location at which 25% of parameter 2 events gated on G3 fall below and 
75% fall above. 

GQ3(G3;P2) 

returns the location at which 75% of parameter 2 events gated on G3 fall below and 
25% fall above. 

  

Percentage calculations are trivial. For example, would be given by 
  

GSUM(G3)*100/GSUM() 

returns G3 events as a percent of total events 

GSUM(R3)*100/GSUM(G2) 

returns R3 events as a percentage of G2 events. 

  

Any expression can be transformed between linear units and transformed units: 
  

FLToT(Pn,<Exp>) 
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converts a value on the Linear scale to a value on the Transformed scale for the 
specified parameter n. 

FTToL(Pn,<Exp>) (Transformed to linear) 

converts a value on the Transformed scale to a value on the Linear scale for the 
specified parameter n. 

  

For example, suppose P2 is a parameter displayed on a log scale. Then, 
  

FTToL(P2,GSUM(G3;P2)/GSUM(G3)) 

finds the geometric mean for parameter 2 gated on G3. The result is expressed in linear 
units that relate to the log axis displayed for the parameter. 

  

Some of the more commonly used functions are also included. 
  

GeoMean(G3;P2) 

is a convenient short-hand for FTToL(P2,GSUM(G3;P2)/GSUM(G3)) 

LinMean(G3;P2) 

is equivalent to GeoMean(G3;P2) 

LinMedian(G3;P2) 

is short-hand for FTToL(P2,GMED(G3;P2)) 

LinMode(G3;P2) 

Is short-hand for FTToL(P2,GMOD(G3,P2)) 

  

VAR(G3;L3;L3) 

computes the variance of parameter 3 in linear space. 

VAR(G3;L3;L4) 

computes the covariance of parameters 3 and 4 in linear space. 
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SD(G3;L3) 

computes the standard deviation for parameter 3 events in gate G3 in linear space. 

QSD(G3;P2) 

computes the quadrant variance for parameter 2 events in gate G3 in transformed 
space. 

  

CV(G3;L3) 

computes the coefficient of variation for parameter 3 gated on G3 in linear space. 

  
  

Additional Examples   

GSUM() Total number of events 

GSUM(G1) Number of events in gate G1 

GSUM(R1) Number of events in region R1 

GSUM(C1) Number of events in CellType 1 

GSUM(C0) 
Number of unclassified events (Cell Type 0 is the 
Unclassified Cell Type). 

GSUM(C0,R2) Number of unclassified events in region R2 

GSUM(;L1) Sum of linear intensity values for parameter 1 

GSUM(G1;L1) 
Sum of linear intensity values for parameter 1 
that are in gate G1 

GSUM(G1)/GSUM(R1) Ratio of the sum of gate G1 events to R1 events 

MEAN(G1;P1) Mean of parameter 1 events that are in gate G1 

GMOD(G1;P1) Mode of parameter 1 events that are in gate G1 

GMED(G1;P0) 
Median of parameter 1 events that are in gate 
G1 

VAR(G1;P1) 
Variance of parameter 1 events that are in gate 
G1 

SD(G1;P1) SD of parameter 1 events that are in gate G1 

CV(G1;P1) CV of parameter 1 events that are in gate G1 

GQ1(G1,P1) 
First quartile of parameter 1 events that are in 
gate G1 
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GQ3(G1,P1) 
First quartile of parameter 1 events that are in 
gate G1 

CC(G1;P1,P2) 
Correlation Coefficient of P1 vs. P2 events that 
are in gate G1 

FLtoT(parameter, value) 
Converts linear value 100 into transformed units 
for parameter 1 

FLtoT(P1,100) 
Converts linear value 100 into transformed units 
for parameter 1 

FTtoL(P1,GSUM(G1;P1)/GSUM(G1)) 
Geometric mean for parameter 1 events that are 
in gate G1 

GeoMean(G1;P1) 
Simple form geometric mean for parameter 1 
events in gate G1 

FLOG(10) Natural log of 10 

FL10(1) Log base 10 of 1 

FEXP(3) Exponent of 3 

FE10(3) Exponent base 10 of 3 

FSQR(4) Square of 4 

FCUB(3) Cube of 3 

FBND(arg,lower,upper) 

Evaluates the first argument to see if it is 
between lower and upper. Returns the first 
argument if it is between the others, returns 
lower if arg is less then lower, or returns upper if 
arg is greater than upper. 

FPWR(10,3) Returns 10 raised to the 3rd power. 

FSQRT(5) Returns the square root of 5. 
  
  

See also: 

Edit Information Equations 

Edit Equation 
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Model Properties 

  

This panel contains properties that apply to all cell types in the current model. It is located on 
the left side of a cell type tab. 
  

Names and Paths 

Document Name 

The name of the GemStone document currently opened. 

Template Model 

The name of the template model that was used. 

Version stamp 

The version of the template model that was used. 

  

Stats 

Total Events In File 

The number of events in the FCS file. 

Total Analyzed Events 

The number of events in the FCS file analyzed by the model. 

Total Cell Type Events 

The number of events in the Cell Type. 

Total Unclassified 

The number of unclassified events. 

Percent Unclassified 

The percentage of events that were not classified by the model. 

  

Author 
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Model Author 

Optional, the name of the creator of the model. 

Lock Model 

When enabled, the program will prompt for a password from the author, and then lock the 
model from user edits.  To edit the model, the Lock Model option must be unchecked and the 
correct password entered. 

  

Auto Analysis 

Auto Analysis Mode 

Choose one of the options.   

Sequential mode enables the cell types as they are auto-analyzed, and each cell type 
remains enabled as other cell types are analyzed. 

Independent mode enables one cell type, perform auto-analysis on that cell type, then 
disables that cell type before moving to the next. 

  

Model Performance 

Model Performance Table 

Typically, this is set not to show a performance table, also known as a contingency table. 

Select Show Table after an analysis to display the table for the current analysis. 
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When the model is working well, the elements on the diagonal will be close to 1.0. When 
values are less than 1.0 on the diagonal, the other values in the same column will indicate 
other cell types that are "overlapping" in some way with the primary cell type for that 
row.  For example in the table above, the element on the GDs row-column shows a value of 
0.9822.  This indicates that the events in the GDs cell type have a 98% probability of being 
GDs. Some of the GDs are being captured by the MAITs_NK cell type (0.0031) and CD8 cell 
type (0.0003). 
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Classify Data 

  

 

Use the Classify Data command to initiate the model's classification routines on the data in 
memory. This command is typically used when opening a new FCS file into a model template 
to apply the model to the new FCS data. A related command, Classify File, performs the 
same functions but on the entire FCS file. 
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Classify File 

  

 

  

Use the Classify File command to model the all of the data in the file with the Probability 
State Model. A related command, Classify Data, performs the same functions but only on the 
data in memory. 
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Auto Analyze 

  

 

  

Auto Analysis automatically adjusts the positions of control points to the data. It affects all 
expression profiles in all cell types. 
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Auto Analyze Cell Type 

  

 

  

Auto Analysis Cell Type (or CT Auto Analyze)  automatically adjusts the positions of control 
points to the data for the current cell type only.  It is a handy tool when building new cell 
types, allowing you to test the auto analysis of just the cell type you are working on. 

  



Reference 

440 

Optimize Model 

  

 

  

Use the Optimize Model command to adjust the positions and line-spreads of Control Points 
based on the FCS data that is currently displayed. This is a useful for making small 
adjustments to the model due to slight intensity shifts from one file to another. 

The process makes adjustments to all Parameter Profiles in all Cell Types. GemStone uses 
peak-finding routines to determine the best intensity positions for the Control Points. It 
performs statistical fits on peaks to determine line-spread adjustments. 

Optimize Model can be time-consuming. A progress meter is displayed on the status bar to 
let you see how the optimization is proceeding. You can halt the process by pressing the Esc 
key on the keyboard. 
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Step 

  

 

  

Step is a toggle state command. When enabled, the auto analysis process is performed one 
step at a time to allow review of each step. A dialog appears after each step, allowing you to 
review the step before moving on to the next.  You can also stop the auto analysis process 
by clicking Escape. 
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Enrich 

  

 
  

This command is typically used during the model-building process to select events from a 
data file that match the model. Before using the command, you should make sure that the 
only parameters with Match Status enabled are those that use "Constant" profiles. Constant 
profiles are sometimes referred to as "selection" profiles, because they are used to select 
subsets of events from the data file. They are the most useful for the Enrich Data because 
they are so simple and robust. 

The Auto Analyze command uses this command as part of its analysis process. 
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Profiles On and Off 

  

These commands are useful when trouble-shooting or building models.  They allow you to 
turn on or off all Expression Profiles in the model or in the current cell type. 

  

 

  

All Profiles On 

Turn ON all expression profiles in all cell types in the model. 

All Profiles Off 

Turn OFF all expression profiles in all cell types in the model. 

CT Profiles On 

Turn ON all expression profiles in the current cell type. 

CT Profiles Off 

Turn OFF all expression profiles in the current cell type. 
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Model Stats 

Model Stats 

  

One way to improve the performance of a model template is to adjust its Expression Profiles 
(EPs) to the average intensity and width of the peaks for a training set of files.  By moving 
the starting location for an EP to the average intensity, the EP is more likely to find the right 
peak.  Similarly, setting the initial width to the average width based on files in the training 
set, the EP is in its best starting condition. 

GemStone has a built-in feature that makes this a very simple process.  The Track command 
is used to initiate the process of tracking statistics for files in the training set.  Once the files 
have all been analyzed, the Apply command is used to update the model template with the 
average intensities and SDs for the files. 

The easiest way to understand the process is with an example.  Suppose that you have a 
model template that is initially set up with intensities and widths using whole numbers. The 
model has CD3 set with 34,000 for the intensity and a width of 5, and it is set to adjust the 
width based on the peak. Similarly, SSC is set for 360,000 initial intensity, a width of 5, and it 
is not adjusting the width based on the peak. 

  

  CD3 Expression Profile SSC Expression Profile 

Before 
Track 
Stats 

 

 

  

Turn on the Model Stats system by clicking the Track command in the Model Stats group on 
the Develop tab. 

 

  

Use the batch processing Auto Advance tool to analyze all files in the training set. 
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When the process is finished, use the Apply command to apply the average statistics to the 
model template. 

 

  

A confirmation dialog is displayed to confirm that you want to apply the stats and save the 
updated model template. 

 

  

After applying the statistics, the initial intensity and width for CD3 have been adjusted to the 
average intensity and width of the files in the training set.  SSC's initial intensity has been 
adjusted, but not the initial width.  This is because Width from Peak is not checked for SSC, 
so its initial estimate will not be changed. 

  

  CD3 Expression Profile SSC Expression Profile 

After 
Apply 
Stats 

 

 

  

Use this system to polish a well-developed model that is close to production use. 

  

See also: 

Track Stats 

Reset Stats 

Apply Stats 
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Track Stats 

  

 

  

This command is part of the Model Stats system, used for finding average intensities and 
widths for Expression Profiles.  The command turns the system on and accumulates intensity 
and peak width information for a set of training files.   

See Model Stats for a detailed explanation. 

  

See also: 

Model Stats 

Reset Stats 

Apply Stats 
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Reset Stats 

  

 

  

This command is part of the Model Stats system, used for finding average intensities and 
widths for Expression Profiles. This command is used to reset the accumulated statistics that 
have been gathered since the Track Stats command was initiated. 

See Model Stats for a detailed explanation. 

  

See also: 

Model Stats 

Track Stats 

Apply Stats 
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Apply Stats 

  

 

  

This command is part of the Model Stats system, used for finding average intensities and 
widths for Expression Profiles. This command is used to apply the average intensity and peak 
width values to the Expression Profiles in the model template. 

When the command is applied, a dialog is displayed to confirm that you want to apply the 
stats and save the updated model template. 

 

  

See Model Stats for a detailed explanation. 

  

See also: 

Model Stats 

Reset Stats 

Apply Stats 
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Help tab 

Help Tab 

  

 

  
Online Learn 
Updates App Info 
Website User Guide 

Contact About 

Support   
Make a Suggestions   
Report a Problem   

  

https://www.vsh.com/
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Updates 

  
This command launches the VSH Updater application, which can check for program updates. 
In order to function correctly, the updater needs access to the Verity Software House web 
site (www.vsh.com) and administrative rights to some areas on your hard drive. You may 
need to provide authorization credentials for it to run. 
Follow instructions provided by the updater to perform the check and update your software. 
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Support 

  

This command interacts with your email application to create a new message to Verity 
Software House Tech Support. A new message is created with the appropriate "To" email 
address and some information about your application in the body of the email. 

Fill in the email message with your contact information and the question(s) you want to ask. 
A member of the Tech Support team will respond to your question as quickly as possible. 
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Make a Suggestion 

  

This command interacts with your email application to create a new message to Verity 
Software House Tech Support. A new message is created with the appropriate "To" email 
address and some information about your application in the body of the email. 

We value your suggestion very highly, and make every attempt to incorporate changes into 
the software that address suggestions from our clients. 

Fill in the email message with your contact information and your suggestion for the program. 
A member of the Tech Support team will respond to your email as quickly as possible. 
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Report a Problem 

  

This command interacts with your email application to create a new message to Verity 
Software House Tech Support. A new message is created with the appropriate "To" email 
address and some information about your application in the body of the email. 

When reporting a problem, please try to include as much detail as possible about the 
conditions that caused the problem. If at all possible, please try to reproduce the problem 
and list the steps that will cause it to occur. While it is sometimes possible to correct 
problems that are not reproducible, it is much more likely that we can fix a problem that we 
can reproduce. 

A member of the Tech Support team will respond to your email as quickly as possible. 
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User Guide 

  

This option displays this User Guide in your browser. The User Guide is fully indexed and 
searchable, and contains tutorials and reference sections to provide a comprehensive 
explanation of features and functions. 



Reference 

456 

About 

  

This command displays the application banner dialog box. The dialog contains information 
about the application. It also provides access to the Registration or Battery system, 
depending on the type of installation you have. 

The phone number for Verity Software House is shown, as are hyperlinks to www.vsh.com 
and the general email account. 
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Batch Commands 

Batch Commands 

  

This panel determines the actions that are performed when an FCS file is read into the 
program for analysis. There is a tab for each "level" in the batch, so that you can set up 
different actions for different kinds of files. 

  

 
  

Select a tab to view or edit the actions for the associated batch level. 
  

Commands that appear on each tab 

Enable 

Enable the actions defined on this tab. 

Level Name 

A name for this level 

Description 

A description for this level 

  

Initialize and Open 

Template 
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Open a specific GemStone model template. 

Open Template Options 

Set options for opening the template, including the file name and path. See Properties for File 
Open and Save for additional details. 

Compact File 

For FCS files from Fluidigm instruments, this option will re-write the FCS file eliminating 
extraneous segments from the file.  It will have no effect on other FCS file types. 

Read File 

Read the FCS file associated with this batch item. 

Panel Tube Options 

Select the option that describes the files on this level of the batch: 

Options   

One Tube This file represents the only tube in the panel. 

First Tube This is represents the first tube in a multi-tube panel. 

Subsequent Tube This is represents the second or greater tube in a multi-tube panel. 

  

Analysis 

Auto Analyze Data 

Initiate the Auto Analysis command after the file is read. 

Enrich Data 

Initiate the Enrich Data command after the file is read. 

Classify File 

Initiate the Classify File command after the file is read. 

Update Cen-se' 

This command updates the Summary map and the Cen-se' plot to display named populations 
and cell types. 
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Finish Up 

Pause 

Enable this option to pause batch processing before printing, saving, and continuing to the 
next file. When this command is triggered, a dialog is displayed indicating that processing is 
paused. The dialog shows a count-down timer and will automatically close and continue after 
the timer runs out. If the user clicks away during the pause, the timer is shut off and the 
program will wait until the user clicks the Continue button before it advances. 

Print Report 

Print the report. 

Save Document 

Save the analysis document after the analysis. 

Save Document Options 

Set options for saving the document, including the file name and path. See Properties for File 
Open and Save for additional details. 

Save PDFs 

Save PDFs for reports. 

Save PDF Options 

Set options for saving PDFs, including the file name and path. See Properties for File Open 
and Save for additional details. 

Save Graphics 

Save graphics for objects that have been selected. 

Save Graphic Options 

Set options for saving graphics, including the file name and path. See Properties for File 
Open and Save for additional details. 

Save Database 

Save the database after each analysis. 

Save Database Options 
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Set options for saving the database, including the file name and path. See Properties for File 
Open and Save for additional details. 

  

Synthesize Data 

Synthesize Data 

If enabled, new data values will be synthesized based on the selected options. This option is 
typically used along with the Export FCS options to create and export synthetic data for 
experimentation. 

Synthesize Data Options 

This command displays the Properties for Synthesize Data dialog.  This dialog is used to set 
how much to vary the intensities of populations when synthesizing data.  The range of 
intensities is defined by Low Intensity Factor and High Intensity Factor.   A value 
between these two factors is randomly selected for each synthesis. 

  

Export and Merge FCS 

Export FCS 

If enabled, an FCS file representing the result of the analysis is exported.  

Export FCS Options 

Set options for exporting FCS files, including the file name and path.  

Merge FCS Option 

Choose an option for file merging. File merging allows a set of related files (e.g. a panel of 
tubes) to be merged into one file containing the union of all parameters in the set. The 
program synthesizes data for missing parameters. 

Merge 
Options 

  

Don't merge Disables file merging. 

Start merge Creates a new file to start merging data. 

Add to 
merge 

Adds to a merge file. This option is only valid after a "Start merge" 
action and before a "Finish merge" action. 

Finish 
merge 

Finishes the file merging and closes the output merge file. 

Advanced Options 
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Stop Auto Advance 

Stop the Auto Advance of the batch processor. 

Use Custom Actions 

Enable Custom Actions mode and the ability to create custom action scripts. 

Custom Actions 

Edit the actions in the script. This is an advanced feature that provides access to additional 
scripting commands. See Edit Actions for more information. 
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Batch List 

  

This panel contains a list of FCS files that have been selected for analysis. The Status column 
on the left indicates the current file with a pointer icon. A check in the Status column 
indicates that the file has been analyzed. The batch outline level for the file is also shown, 
e.g. L1 is level 1. 

Columns can be added to the list to display analysis results. This serves as the database of 
analysis information and can be exported for integration into other applications. 
  

 
  
  
The controls at the bottom relate to files in the batch list:  

• add and remove files 
• indent and outdent files to different levels 
• move files up or down in the batch 
• set the starting file 

The outline level that a file is on determines how it will be processed.  Each level has its own 
script of actions, which are edited and control on the Batch Commands panel that appears 
below the Batch List when in Develop mode. 
  
See also: 
Batch List Context Menu 
Batch Controls toolbar 
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Batch List Context Menu 

  

This context menu appears when the mouse is right-clicked on the File Database panel. On 
computers with a one-button mouse, it can be displayed by holding the Control key and 
clicking the mouse. The menu provides a number of actions that relate to the files in the 
batch. 
  

Start here 

Make the selected item the current batch item. 

Clear flags 

Set all files in the batch to "unanalyzed". 

Remove 

Remove the selected file(s) from the batch list and database. 

Remove all 

Clear all files from the batch list and database. 
  

Edit Fields 

Display the Edit Fields dialog to choose columns for the batch and database. 

Clear Results 

Clears the results for the selected entries in the database. 

Export Database 

Export the database to an ASCII text file. See Export Database for additional information. 
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Batch Commands 

  

This panel determines the actions that are performed when an FCS file is read into the 
program for analysis. There is a tab for each "level" in the batch, so that you can set up 
different actions for different kinds of files. 

  

 
  

Select a tab to view or edit the actions for the associated batch level. 
  

Commands that appear on each tab 

Enable 

Enable the actions defined on this tab. 

Level Name 

A name for this level 

Description 

A description for this level 

  

Initialize and Open 

Template 

Open a specific GemStone model template. 
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Open Template Options 

Set options for opening the template, including the file name and path. See Properties for File 
Open and Save for additional details. 

Compact File 

For FCS files from Fluidigm instruments, this option will re-write the FCS file eliminating 
extraneous segments from the file.  It will have no effect on other FCS file types. 

Read File 

Read the FCS file associated with this batch item. 

Panel Tube Options 

Select the option that describes the files on this level of the batch: 

Options   

One Tube This file represents the only tube in the panel. 

First Tube This is represents the first tube in a multi-tube panel. 

Subsequent Tube This is represents the second or greater tube in a multi-tube panel. 

  

Analysis 

Auto Analyze Data 

Initiate the Auto Analysis command after the file is read. 

Enrich Data 

Initiate the Enrich Data command after the file is read. 

Classify File 

Initiate the Classify File command after the file is read. 

Update Cen-se' 

This command updates the Summary map and the Cen-se' plot to display named populations 
and cell types. 

  

Finish Up 
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Pause 

Enable this option to pause batch processing before printing, saving, and continuing to the 
next file. When this command is triggered, a dialog is displayed indicating that processing is 
paused. The dialog shows a count-down timer and will automatically close and continue after 
the timer runs out. If the user clicks away during the pause, the timer is shut off and the 
program will wait until the user clicks the Continue button before it advances. 

Print Report 

Print the report. 

Save Document 

Save the analysis document after the analysis. 

Save Document Options 

Set options for saving the document, including the file name and path. See Properties for File 
Open and Save for additional details. 

Save PDFs 

Save PDFs for reports. 

Save PDF Options 

Set options for saving PDFs, including the file name and path. See Properties for File Open 
and Save for additional details. 

Save Graphics 

Save graphics for objects that have been selected. 

Save Graphic Options 

Set options for saving graphics, including the file name and path. See Properties for File 
Open and Save for additional details. 

Save Database 

Save the database after each analysis. 

Save Database Options 

Set options for saving the database, including the file name and path. See Properties for File 
Open and Save for additional details. 
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Synthesize Data 

Synthesize Data 

If enabled, new data values will be synthesized based on the selected options. This option is 
typically used along with the Export FCS options to create and export synthetic data for 
experimentation. 

Synthesize Data Options 

This command displays the Properties for Synthesize Data dialog.  This dialog is used to set 
how much to vary the intensities of populations when synthesizing data.  The range of 
intensities is defined by Low Intensity Factor and High Intensity Factor.   A value 
between these two factors is randomly selected for each synthesis. 

  

Export and Merge FCS 

Export FCS 

If enabled, an FCS file representing the result of the analysis is exported.  

Export FCS Options 

Set options for exporting FCS files, including the file name and path.  

Merge FCS Option 

Choose an option for file merging. File merging allows a set of related files (e.g. a panel of 
tubes) to be merged into one file containing the union of all parameters in the set. The 
program synthesizes data for missing parameters. 

Merge 
Options 

  

Don't merge Disables file merging. 

Start merge Creates a new file to start merging data. 

Add to 
merge 

Adds to a merge file. This option is only valid after a "Start merge" 
action and before a "Finish merge" action. 

Finish 
merge 

Finishes the file merging and closes the output merge file. 

Advanced Options 

Stop Auto Advance 



Reference 

468 

Stop the Auto Advance of the batch processor. 

Use Custom Actions 

Enable Custom Actions mode and the ability to create custom action scripts. 

Custom Actions 

Edit the actions in the script. This is an advanced feature that provides access to additional 
scripting commands. See Edit Actions for more information. 
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Batch Controls toolbar 

  

The batch toolbar contains a set of buttons to navigate through the selected batch of files. 
The toolbar appears in the lower left of the GemStone workspace. 
  

 

Choose a file in the batch. 

 

Go to the first batch file. 

 

Go to the previous batch file. 

 

Run the analysis script on the current batch file. 

 

Go to the next batch file and analyze. 

 

Go to the last batch file. 

 

Auto-advance and analyze through the batch. 

 

Stop auto-advancing. 
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Properties for File Open and Save 

  

These dialogs are displayed from the Batch Options panel to set options for opening and 
saving GemStone documents and other file-based actions. The dialogs are very similar; the 
Save dialog has one additional property. 
  

Options 

Location Option 

Choose the naming option to use for the open or save operation. 

Options   

Use the data file name and path With this option selected, the GemStone 
document name and location are based on the 
name of the FCS data file that is currently 
opened. For example, if the FCS file is 
"C:\Data\Experiment123.fcs", the document 
that the program attempts to open will be 
"C:\Data\Experiment123.gs". 

Use the data file name and the 
Target Path 

With this option selected, the GemStone 
document name is based on the name of the 
FCS data file that is currently opened, but the 
location of the document is defined by the 
Target Path property below. 

Use the specified Target File With this option selected, the GemStone 
document name and location are defined by the 
Target File property below. 

  

Confirm Selection 

When this option is enabled, the File Open or Save dialog will be displayed so that the file 
name and location can be verified or changed by the user. 

Replace Existing File (Save Document dialog only) 

Check this option to overwrite a file of the same name without prompting for confirmation. 
  

Names and Paths 

Target Path 
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When "Use the data file name and the Target Path" is selected as the Location Option, this 
field sets the path that is used. For other Location Options, this field is ignored. 

Target File 

When "Use the specified Target File" is selected as the Location Option, this field sets the 
path and file name that is used. For other Location Options, this field is ignored. 
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Cell Type tabs 

Cell Type Tabs 

  

In Develop mode, the program shows a Cell Types tab at the bottom of the main window. 
This is where you will find many of the tools for developing a model. This tab contains a set 
of tabs, one for each Cell Type that has been defined in the model.  Each Cell Type tab has a 
Cell Type Widget that includes all of the Expression Profiles used for that Cell Type.  The tab 
can also include other graphics and tables added by the user. 

On the left side of the tab area, a collapsible section includes Cell Type Properties and 
Expression Profile Properties. 
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Cell Type Tabs 

  

In Develop mode, the program shows a Cell Types tab at the bottom of the main window. 
This is where you will find many of the tools for developing a model. This tab contains a set 
of tabs, one for each Cell Type that has been defined in the model.  Each Cell Type tab has a 
Cell Type Widget that includes all of the Expression Profiles used for that Cell Type.  The tab 
can also include other graphics and tables added by the user. 

On the left side of the tab area, a collapsible section includes Cell Type Properties and 
Expression Profile Properties. 
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Cell Type Widget 

  

The Cell Type widget contains the stack of Expression Profile plots that define a cell type in 
the model.  

  

 
  

You can expand and collapse expression profiles within the widget for better visualization of 
the data. To collapse a profile that is showing, click the "shrink" icon next to the 
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measurement name on the left edge. To expand a profile that is hidden, click the "expand" 
icon next to the measurement name. 

Click to 
Shrink 

 

Click to 
Expand 

 

  

When you click on an expression profile, the profile becomes the active profile. You can edit 
its properties in the Expression Profile Properties panel, or by right-clicking and choosing Edit 
Expression Profile to edit the most common properties. 
  

The Frequency Plot provides information about how well the model is working. The Y-axis 
shows frequency of events, and the X-axis shows the Progression axis. A bold red horizontal 
line shows the optimal frequency across the progression axis. The optimal frequency is 
computed by dividing the number of events by the number of states on the Progression axis. 
In other words, the ideal model would put the same number of events into each state of the 
progression. 

The jagged black line shows the actual number of events that have been assigned to each 
state for this cell type. For a model that matches the data well, the black line will follow the 
red line, bouncing slightly over and under the red line. In places where the black line is 
significantly above the red line, there are too many events being assigned to those states. 
Conversely, where the black line falls well below the red line, there are not enough events 
assigned. This relationship helps identify which Expression Profiles need to be adjusted. In 
general, when there are too many or too few events in a portion of the Frequency Plot, 
review the Expression Profiles with control points and transitions in those states. Examine 
those profiles to be sure the control points are properly positioned. 

The Frequency Plot also shows the Reduced Chi Square (RCS) of the model and the stages 
that have been defined. 
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Cell Type toolbar 

  

This toolbar appears on the left edge of the Cell Type tab. 
  

 

Selection Use this tool to select, move, and size objects in the canvas. 

 

Zoom Use this tool to define a portion of the canvas to zoom-in on. 
Click and drag to surround the area that you want to zoom. 

 

Cancel zoom Click this tool to cancel out of zoom and return to normal 
viewing. 

 

Text Click and drag to define an area for the text. A dialog will be 
displayed to input the text. 

 

Line Click and drag to define the end points of the line. 

 

Arrow Click and drag to define the end points of the arrow. 

 

Rectangle Click and drag to define the outline of the rectangle. 

 

Ellipse Click and drag to define the bounding rectangle for the ellipse. 

 

1P Histogram Click and drag to define the bounding rectangle for the 1P 
histogram. 

 

2P Histogram Click and drag to define the bounding rectangle for the 2P 
histogram. 

 

Parameter 
Graph 

Click and drag to define the bounding rectangle for a parameter 
graph. 

 

Overlay plot Click and drag to define the bounding rectangle for the overlay 
plot. 

 

Table Click and drag to create a table object. 

 

Legend Click and drag to define the bounding rectangle for the legend. 

 

Cell Type 
Legend 

Click and drag to define the bounding rectangle for the Cell Type 
legend. 

 

Stage Table Click and drag to define the bounding rectangle for the Stage 
Table. 
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Heat Map 
plot 

Click and drag to define the bounding rectangle for the heat map 
plot. 

 

TriCOM Click and drag to define the bounding rectangle for the TriCOM 
plot. 

 

Choose 
Parameter 

Use this tool to select a parameter to include in the current Cell 
Type. 
Once a parameter is selected, it appears in the Cell Type widget 
for the Cell Type. It can also be displayed in 1P and 2P 
histograms. 
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Cell Type Properties panel 

  

This panel contains properties that relate to the current Cell Type tab.  It is located on the 
left side of a cell type tab. 
  

Identification 

Cell Type Name 

Enter a name for the Cell Type. 

Description 

Enter a description for the Cell Type. 

Enable 

Enable or disable classification of events for this Cell Type. 

Color 

Choose the color for this Cell Type. 

Classification Type 

Select the type of classification to use for this cell type. 
Competitive The cell type will compete with other cell types to capture events  

Selective 
The cell type will be used to select events for all cell types that follow it in 
the model.   

Non 
Competitive 

The cell type includes events that have not been classified by other cell 
types. 

  

Enable Cell Type Enriching 

This checkbox determines whether the Cell Type will be enriched by the Enrich command.  

Exclusion Probability 

The value determines the fraction of events that will be excluded from the Cell Type after 
initially being selected into it.  A value of 0.001 will exclude one tenth of a percent of the 
events that would have been selected. 

State Resolution 
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Select the resolution to use for the cell type. Smaller values improve analysis speed and can 
be used when transitions are distinct and dramatic. Larger values take more time to process, 
but may be useful for gradual or complex transitions in the progression. The default is 
Normal Progression (100 states). 

Unique Name 

Enter the number states to define for the progression of events in this Cell Type.  

  

Statistics 

Cell Type Events 

The number of events classified by this Cell Type. 

Reduced Chi-Square (RCS) 

The goodness-of-fit for events classified into this Cell Type. Well-defined models produce RCS 
values between 0.0 and 3.0. Values between 3.0 and 5.0 are acceptable for many models. 
Complex models with fine distinctions between states may produce even higher RCS values. 
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Expression Profile Properties Panel 

  

This panel is used to define the expression profile. It is located on the left side of a cell type 
tab. 
  

Measurement 

Enter a short name to use for the profile. 

Phenotype 

Enter a short phenotype description to use for the profile. 

Expression Profile 

Choose the type of profile to use for modeling this measurement. See Expression Profile 
Descriptions for a list of profile types.  

Distribution Type 

Choose the type of distribution to use for this profile. See Expression Profile Distribution 
Types for details. 

Normal 
Distribution 

The control definition points define the mean of a normal distribution.  

Inverse Normal The profile is the inverse the Normal Distribution. 

Inverse Low 
Pass 

The profile is the inverse of the Low Pass distribution. 

Low Pass The control definition points define a probability "edge".  Events below 
the CDPs are included. 

High Pass The control definition points define a probability "edge".  Events above 
the CDPs are included. 

Inverse High 
Pass 

The profile is the inverse of the High Pass distribution. 

  

Use for Classifying 

Check this option to include this profile in the modeling process. 

Use for Enriching 

Check this option to include this profile when using the Enrich command. 
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Exclude from Model 

Enable this option to exclude the profile from the modeling process.  This is a convenient way 
to temporarily disable a profile without removing it. 

Required 

If this option is enabled, the measurement must be included in the FCS file.  If it is missing, 
the modeling process will terminate and the file will not be analyzed. 

Estimation Range 

This value restricts the estimation routine that adjusts Control Points on the parameter 
intensity (Y-axis) scale. The value is normalized to a 0 to 100 scale, so a value of 10 means 
that the estimation routine will consider moving a Control Point as much as 10% up or down 
if it finds a peak within that range. 

Normal Range 

This value is the number of Standard Deviations that define the normal range when used 
with inverse profiles and TriCOMs. 

Maximum Transition 

This value sets a limit on the amount of transition in a staging profile like a StepUp or 
StepDown. 

Fit Projection 

If this option is checked, the modeling process with attempt to fit the projections in order to 
optimize the fit. 

Color 

Select a color for this measurement. This color is used in Tri-COMs and overlay plots. 

  

Peak Detection 

Peak Fitting Method 

Choose the method to use for fitting peaks for this measurement. The default, Both Sides, 
uses the full peak to estimate position and SD.  Steeper side, Dimmer side, and Brighter side 
use only one side of the peak for the estimates. 

Auto Smoothing 
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Enable this option to automatically determine the best smoothing bandwidth. 

Smoothing 

Enter a smoothing value.  Lower numbers result in less smoothing. Default value is 7. 

Minimum Peak Height 

The lowest height that is considered a peak. 

Minimum State Peak Height 

When Fit Projection is enabled, the lowest height that is considered a peak. 

Peak Deflection Threshold 

The minimum change between a low and high value to consider the segment a peak.. 

Merge Peaks Below 

Peaks below this value will be into one peak. 

Peak Separation 

If abs(mean1-mean2)/(sd1+sd2) is greater than this threshold, then the peaks are different. 
(0.10 to 1.00) 

Fit Distance 

Filters detected peaks where the fitted mean is too far from the peak's location. (1.00 to 
4.00)  
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Edit Expression Profile dialog 

  

This dialog edits the most common properties for an expression profile. See Edit Profile 
Properties Panel for the full set of properties and descriptions. 
  

 
  

Measurement 

Enter a short name to use for the profile. 

Expression Profile 

Choose the type of profile to use for modeling this measurement. See Expression Profile 
Descriptions for a list of profile types.  

Distribution Type 

Choose the type of distribution to use for this profile. See Expression Profile Distribution 
Types for details. 

Color 

Select a color for this measurement. This color is used in Tri-COMs and overlay plots. 

Use for Classifying 
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Check this option to include this profile in the modeling process. 

Use for Enriching 

Check this option to include this profile when using the Enrich command. 

Estimation Range 

This value restricts the estimation routine that adjusts Control Points on the parameter 
intensity (Y-axis) scale. The value is normalized to a 0 to 100 scale, so a value of 10 means 
that the estimation routine will consider moving a Control Point as much as 10% up or down 
if it finds a peak within that range. 

Normal Range 

The number of SDs that define the normal range.  This is used with inverse distribution types 
and TriCOMs. 

Low, Normal, High Regions 

Shows all low, normal, and high regions in the data 

Peak Search Range 

Shows peak search range for the expression profile measurement. 
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Expression Profile toolbar 

  

The Expression Profile toolbar is located on the right side of each Expression Profile in the 
Cell Type widget. It appears when the mouse pointer is moved over the profile plot. 
  

 

Selection Use this tool to select, move, and size objects in the Parameter 
Profile. 

 

Zoom Use this tool to define a portion of the object to zoom-in on. Click 
and drag to surround the area that you want to zoom. 

 

Cancel zoom Click this tool to cancel out of zoom and return to normal viewing. 

 

Edit Graphics Edit the graphics from this profile. 

 

Edit Expression 
Profile 

Edit the properties of the profile 

 

Select Profile Choose a profile for the measurement. 

 

Auto-analyze 
profile 

Analyze this profile in the same way the Auto-Analysis analyzes the 
entire model. 

 

 

Toggle 
Expression 
Profile 

This button toggles the profile on or off. When enabled (on), the 
profile is an active part of the model and becomes part of the 
selection process for events in the cell type. 
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Expression Profile Descriptions 

  

Expression Profiles provide great flexibility for modeling different kinds of measurement 
expressions. This page describes the types available in the software.  See Expression Profile 
Distribution Types for related information about types of distributions. 
  

Constant 

 

This profile has two Control Points that are linked to the same intensity.  
It is used to select events for a cell type. 

  

Step Up 

 

The Step Up profile has four Control Points. The first two points are linked to have the 
same intensity values. The last two points are also linked, and are forced to have a 
higher intensity than the first two.  
It is used for measurements that are up-regulated in the cell type. 

  

Step Down 

 

The Step Up profile has four Control Points. The first two points are linked to have the 
same intensity values. The last two points are also linked, and are forced to have a 
lower intensity than the first two.  
It is used for measurement that are down-regulated in the cell type. 

  

Three Levels 
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This profile defines three levels of intensity. For each level, there are two Control 
Points that are linked to the same intensity for the parameter. Each of the levels has 
no dependencies on the other levels. In other words, the next level can be higher, 
lower, or even the same intensity as its neighboring level. 

N-Levels 

 

This profile has a user-defined number of levels.  Each level has two Control Points, 
one that defines the beginning of the level, and one that defines the end. 
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Expression Profile Distribution Types 

  

Expression Profiles can be set up with a number of different types of distributions. This page 
describes the types available in the software.  See Expression Profile Descriptions for related 
information. 

  

Normal 

 

Normal distributions are typically used when the events of interest are in an intensity band 
that relates to a peak. A normal distribution is also called a Gaussian distribution. 

  

Inverse Normal 
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This is a rarely used distribution type. It selects the events that are not in the normal 
distribution. 

  

Low Pass 

 

This selects events in and below the normal distribution defined by the profile. It is 
commonly used for negative selection markers. 

  

Inverse Low Pass 
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This selects events that are above the normal distribution defined by the profile. It can be 
used, for example, when there is a well-defined low peak that contains events that are not 
of interest. 

  

  

High Pass 

 

This selects events that are in and above the normal distribution defined by the profile. It 
can be used, for example, when a peak defines the lower area of interest, and you want to 
include all events above that. 
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Inverse High Pass 

 

This selects events that are below the normal distribution defined by the profile. It can be 
used, for example, when a peak defines the lower area of interest, and you want to include 
only events below that. 
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Users and Groups 

Research and Compliance Modes 

  

GemStone can be set up to run in either a Research-Use-Only mode or in Compliance mode. 
When the program is in Compliance mode, you have the ability to control which users can do 
different operations.  Here are some differences between RUO and Compliance modes: 

• Compliance mode makes use of your operating system's user groups to control the level 
of access to program features. Research mode allows any user to perform any 
operation. 

• Compliance mode displays a login dialog when the program is starting up to verify the 
user and determine the group to which the user belongs. 

• Compliance mode enables logging so that there is a record of the activities of each user. 
Research mode can be run with logging enabled or disabled. 

• Compliance mode is designed to be part of a compliance plan for the US-FDA's 21 CFR 
Part 11 regulations. Research mode does not provide compliance with 21 CFR Part 11. 

• Both modes use the same intuitive interface and analysis engine. 

The program displays the mode of operation in the upper right corner of the ribbon: 

 or   

  

Set Up Research Use Only Mode 

After initial installation, GemStone will automatically be in Research (RUO) mode. No further 
configuration is required. 

To revert to Research mode after setting up Compliance mode, the user groups that were 
created for Compliance mode must be removed. Once the user groups are removed, the 
program will revert to Research mode. 

  

Set Up Compliance Mode 

Setting up Compliance mode should be performed by IT personnel. 

While it is not a complicated task, it requires administrative access rights and a clear 
understanding of user groups and permissions. It is therefore something that we strongly 
recommend be performed by the IT team at your institution. The task involves creating 
several GemStone user groups for your computer or domain, and then adding users to those 
groups. Once the groups are defined, the program automatically operates in Compliance 
mode. Click here for details. 

  

21 CFR Part 11 Compliance Matrix 
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This matrix provides a simple summary of how GemStone in Compliance mode helps you 
with 21 CFR Part 11 compliance. Click here for details. 



GemStone User Guide 

495 

Research and Compliance Modes 

  

GemStone can be set up to run in either a Research-Use-Only mode or in Compliance mode. 
When the program is in Compliance mode, you have the ability to control which users can do 
different operations.  Here are some differences between RUO and Compliance modes: 

• Compliance mode makes use of your operating system's user groups to control the level 
of access to program features. Research mode allows any user to perform any 
operation. 

• Compliance mode displays a login dialog when the program is starting up to verify the 
user and determine the group to which the user belongs. 

• Compliance mode enables logging so that there is a record of the activities of each user. 
Research mode can be run with logging enabled or disabled. 

• Compliance mode is designed to be part of a compliance plan for the US-FDA's 21 CFR 
Part 11 regulations. Research mode does not provide compliance with 21 CFR Part 11. 

• Both modes use the same intuitive interface and analysis engine. 

The program displays the mode of operation in the upper right corner of the ribbon: 

 or   

  

Set Up Research Use Only Mode 

After initial installation, GemStone will automatically be in Research (RUO) mode. No further 
configuration is required. 

To revert to Research mode after setting up Compliance mode, the user groups that were 
created for Compliance mode must be removed. Once the user groups are removed, the 
program will revert to Research mode. 

  

Set Up Compliance Mode 

Setting up Compliance mode should be performed by IT personnel. 

While it is not a complicated task, it requires administrative access rights and a clear 
understanding of user groups and permissions. It is therefore something that we strongly 
recommend be performed by the IT team at your institution. The task involves creating 
several GemStone user groups for your computer or domain, and then adding users to those 
groups. Once the groups are defined, the program automatically operates in Compliance 
mode. Click here for details. 

  

21 CFR Part 11 Compliance Matrix 
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This matrix provides a simple summary of how GemStone in Compliance mode helps you 
with 21 CFR Part 11 compliance. Click here for details. 
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Setting Up Compliance Mode 

  

Setting up Compliance mode should be performed by your IT team. It requires 
administrative rights and a clear understanding of your network operating system. 

The task involves creating several GemStone user groups for your computer or domain, and 
then adding users to those groups. Once one or more of the groups are defined, the program 
automatically operates in Compliance mode. 

  

User Groups and Permissions 

There are two (2) user groups for Compliance mode: GemStoneAdmins and 
GemStoneUsers.     

The table below shows the kinds of features that group members can access.   

  

Feature GemStoneUsers GemStoneAdmins RUO 
Mode 

All users 

Edit Preferences No Yes Yes 

Create and Edit Models No Yes Yes 

Develop new analysis 
Projects No Yes Yes 

Project Develop No Yes Yes 

Run Projects Yes Yes Yes 

Select Projects Yes Yes Yes 

Add files to batch Yes Yes Yes 

Run a batch of files Yes Yes Yes 

Log and Preference folder Shared Shared Shared 

  

Creating User Groups 

The program requires at least one of the GemStone user groups to be defined in order to run 
in Compliance mode.  GemStone user groups can be defined for your computer or for your 
entire domain using tools provided by the operating system.  This is typically done by 
information technology personnel because it requires administrative rights.   

The advantage of defining the user groups at the domain (network) level is that the groups 
are defined for all computers on the domain at the same time.  If you define the user groups 
on an individual computer, those groups are available only on that computer. 
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Below we describe how to create user groups on a Windows server or on a Windows 
computer, as examples.  The specific methods you need to use may differ depending on the 
version of the operating system you are working with. 

After you have defined the user groups and added users to them, GemStone will detect the 
groups when it starts up and operate in Compliance mode automatically. 

  

Windows Server User Groups 

Follow these steps to define user groups for an entire network or domain. Note: if you use 
this technique, you do not need to define user groups on each individual 
computer. 

• On a domain server, launch the "Active Directory Users and Computers" administrative 
tool. 

• Right click the "Users" folder in the left panel and choose New>Group.  The New Group 
dialog is displayed. 
 

 
• Type GemStoneAdmins for the group name and click OK. 
• Once the group is created, double-click the group in the list to display the Properties for 

the group. 
• Click the Members tab and click Add to select members for the GemStoneAdmins 

group.  You should have at least one user in the GemStoneAdmins group. Members can 
be added by typing user names, or by using the dialog's search features. 
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• Repeat this process for the GemStoneUsers group. 
• Once the groups are created and users are added to them, the program will 

automatically use Compliance mode when it starts up and is connected to the domain. 
• Any user who is not in a defined user group will be prevented from using the software. 

  

Mac OS X User Groups 

Follow these steps to define user groups for an individual Mac OS computer. 

• On a Mac OS computer, launch System Preferences. Choose "Accounts" or "Users and 
Groups", depending on the version of the OS. 

• Click the lock icon to authenticate to make changes. This will require administrative 
rights. 

• Click the "+" button under the list of users and groups. The "New Account" dialog is 
displayed. 

• Change the New Account type to "Group". 

• Type GemStoneAdmins for the group name and click "Create Group". 
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• Select the users you want to be members of the GemStoneAdmins group. You 
should have at least one user in the GemStoneAdmins group. 

• Repeat this process for the GemStoneUsers group. 

• GemStone will run in Compliance mode the next time it starts. 

See also: 

21 CFR Part 11 Compliance 
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21 CFR Part 11 Compliance 

  

  

GemStone can be part of your lab's compliance strategy for 21 CFR Part 11 when it is setup 
and operated in Compliance mode.  It has been developed under a quality management 
system and validated with a suite of quality assurance tests. The table below summarizes 
how the key elements of Part 11 relate to GemStone and its use in Compliance mode 
settings. 

  
Section Summary of Rule Compliance Strategy 

11.10 
Controls for closed 
systems 

GemStone can be accessed only through the user 
interface; it is a closed system. 

11.10 (a) 
Validation and 
accuracy. 

GemStone uses externally-generated data to validate 
its results and employs proprietary binary format, 
static PDF, and/or CRC methods to ensure valid files. 

11.10 (b) 
Record generation 
and readability 

GemStone generates CRC-checked log files and static 
PDF reports that are human-readable and machine-
readable. 

11.10 (c) 
Record protection 
and retrieval 

Record retention and retrieval plan is managed by the 
laboratory’s file management practices. 

11.10 (d) Authorized access 
GemStone uses the operating system’s user login 
validation, and user group membership determines 
permissions within the software. 

11.10 (e) Audit trails 
GemStone employs a CRC-checked logging system 
with time stamps, and log files are preserved. Log 
files cannot be deleted by ordinary means. 

11.10 (f) 
Operational system 
checks 

GemStone enables and disables portions of the UI to 
enforce permitted sequencing of steps and events. 

11.10 (g) Authority checks 
GemStone uses the operating system user groups and 
login validation to assure authorized access. 

11.10 (h) 
Device checks and 
validity 

GemStone performs validation checks on the FCS data 
files. 

11.10 (i) 
Education, training 
and experience 

GemStone provides a User Guide, technical support, 
and tutorial videos to assist with the proper, intended 
use of the program. Specific on-site training may be 
arranged. 

11.10 (j) Electronic signatures 
This is an individual laboratory requirement beyond 
the scope of use of GemStone. 

11.10 (k) 
Systems 
documentation 

GemStone version releases are accompanied by an 
updated User Guide. Verity employs document control 
procedures. 

11.30 
Controls for open 
systems 

GemStone is designed as a closed system. 

11.50 
Signature 
manifestations 

GemStone does not require or offer electronic 
signatures. 
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11.70 Signature linking 
GemStone does not require or offer electronic 
signatures. 

11.100 (a) 
Unique electronic 
signatures 

Your laboratory must ensure that electronic signatures 
are unique to each user on the network. 

11.100 (b) Identity verification 
Each laboratory must verify its own employment 
records and IDs. 

11.100 (c) 
Signature 
verification 

Each laboratory must verify electronic signature 
eligibility with the FDA. 

11.200 
(a)(1) 

Two-component 
signing 

GemStone does not require or offer electronic 
signatures. 

11.200 
(a)(2,3) 

Authenticity and 
falsification 

GemStone does not require or offer electronic 
signatures. 

11.200 (b) Biometric signatures GemStone does not utilize biometric IDs. 

11.300 (a) 
Controls for 
identification 

GemStone uses the operating system user groups and 
login validation to assure unique user identities. 

11.300 (b) Identification aging 
The individual laboratory IT structure must control 
password checks and aging requirements. 

11.300 (c) 
External ID 
validation 

Not applicable. GemStone does not utilize external 
tokens, cards, RFID, or other physical identity-
confirming devices. 

11.300 (d) Unauthorized use 
The individual laboratory IT structure must control 
login authenticity and manage safeguards to prevent 
unauthorized use. 

11.300 (e) 
External device 
testing 

Not applicable. GemStone does not utilize external 
tokens, cards, RFID, or other physical identity-
confirming devices. 
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Check for Updates 451 
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F 

FCS file 354, 385 

File Tab 192 

Fitted Documents 31 

Frequency Heatmap 334 

Functional Markers 78, 408, 409 

G 

Global Properties panel 433 

Graphic Options for 2P Vectors 254 

Graphic Options for EP Means 270 

Graphic Options for Measurements 289 

Graphic Options for Overlays Plot 285 

H 

Heat Map 252 

Help Tab 450 

Home Tab 209 

I 

Information 346 

Information Table Preferences 375 

Initialize and Start Stats 448 

Insert Tab 225 

Installation and Setup 13 

Installation and Setup of GemStone 13 

Intensity Heatmap 334 
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K 

Keyword Export 349 

L 
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Line 228 

Logging 356 

M 

Manage Settings 377 
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